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Project Build & Deploy

I
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Enterprise Architect has been built from the ground up with
the Project Manager in mind. Organizational repositories are
valuable corporate assets and must be managed and
maintained accordingly. Risk can be modeled and managed
in a variety of locations, and project effort can be
determined with built in support for Metrics and Estimation.
Tasks can be created and assigned to Resources performing
particular roles, and these can be conveniently viewed 1n a
built-in Gantt Chart. There 1s an Audit function that allows
changes to be tracked at a fine-grained level, and a Library
facility and Element Reviews and Discussions that allow
users to work collaboratively on models.

Each element in Enterprise Architect has a number of
default properties that are useful for project management,
such as phase, version, status, author, and creation and
modified dates. Using these, coupled with the reporting
engine, the information can be extracted easily even by a
novice user. The Project Manager and other users have the
ability to create elegant charts that depict the information in
the repository in a compelling visual format. For example, a
pie chart could be created to show the status of stakeholder
requirements for a particular phase of the project.

(c) Sparx Systems 2026 Page 6 of 352



Project Build & Deploy 4 May, 2026

Facilities

Facility Detail

Metrics and | Project estimation 1s working out how
Estimation much time and effort 1s required to build
and deploy a solution.

Enterprise Architect provides the Use
Case metrics facility as a means of:

. Measuring the complexity of a system

. Getting an indication of the effort
required to implement the model

. Getting an indication of the project
timescale

Y ou base these estimates on
carefully-calibrated metrics.

Resource Resources are the people who work on a
Management @ project.

You can assign roles to resources and
allocate tasks on specific model elements,
which enables tracking of effort and
estimation of time to complete.

Project During a project you monitor and manage
Maintenance @ the development and progress of
individual model elements.

(c) Sparx Systems 2026 Page 7 of 352
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You can record problems, changes, issues
and tasks that affect these individual
clements as they arise, and document the
solution and associated details.

Similarly, Enterprise Architect helps you
to manage changes and issues that apply
to the whole system.

Project Tasks = In the course of a project, there are

and Issues various non-technical tasks that are vital
to the successful management and
completion of the project, such as
meetings.

Enterprise Architect helps you to record
and monitor these, and to manage
non-technical project issues as they arise.

(c) Sparx Systems 2026 Page 8 of 352
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Kanban Boards

Background

Kanban, which literally translates as Visual (Kan) Card
(Ban) or billboard, is an operational method used to increase
efficiency. It was originally developed by the industrial
engineer Taiichi Ohno while working at Toyota. Ohno
analyzed the way supermarket shelves are stocked and
applied the lessons learnt to the factory floor, creating
unprecedented efficiency. The visual card (Kanban) was
used to signal the need for more items to upstream suppliers
on the production line. The Kanban method can be applied
to any field, including strategic planning, sales and
marketing, and human skills management, but more recently
Kanban has been applied to the process of developing
software-centric solutions in an attempt to ensure that value
1s delivered to the customer as quickly as possible. The
information technology industry has been plagued since its
beginning with projects running over schedule and over
budget, but more significantly failing to deliver value to
customers in a time frame that enables them to compete and
be successful. These endemic issues have become a critical
element of business in an age dominated by digital
disruption and unprecedented change.

Principles
Kanban 1s fundamentally very simple and relies on a small
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number of principles, the origins of which can be attributed
to the engineers at Toyota:

. Make work visible
Traditional project management methods hide the work
items from the people who carry out the work; Kanban
exposes the work to everyone, allowing any team member
to contribute to the way work items flow through the
board and ultimately deliver value to the customer

Backlog Queue In Progress (4/6) Test/Review

As a Sale Representative |
able to add new orders to want to be able to view want to be able to determine

As an Administrator | want to As a Customer | want to be
be able to have a

maintenance window to

As a Warehouse Manager |

existing ones if they have not historical leads the best product location to

update online web pages and minimize picking errors

content

shipped

UserStory
Defect UserStory

UserStory Jlane Ward

Paulene Dean ] Devel. Yuki Kotabashi
E_—— ] Busin.. S ] TestA..

. Limit work in progress
Project Managers and team leads have traditionally been
under pressure to get products finished or to include more
features, and have responded to this pressure by
burdening the team with more work items; this results in
lots of focus switching and inevitably half-finished items
and reduced efficiency
Paradoxically, Kanban encourages the number of items in
progress to be limited, resulting in greater efficiency and
more finished items; the reduced number of in-progress
items allows team members to concentrate on one thing at
a time without having to switch focus

c) Sparx Systems age 100
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Mame Max ltems Colar Default Unbound

Backlog 0 |:| Default v
Queue 20 |:| Default
{In Progress | |:| Default
Test/Review 3 [ ] Default
Done 20 |:| Default
Deploy 50 |:| Default

. Manage the flow of work
Using traditional project management methods,
bottlenecks or blockers are hard to identify and typically
only surface at the time of a post project review, often
only after the product is delivered late and missing
features
Using Kanban, the visibility of work and the ability to
1dentify stalled processes - whether because of bottlenecks
or lack of work items - allows a flow problem to be
identified and rectified quickly
The next diagram shows the way the Kanban facility in
Enterprise Architect responds when the number of items
in a lane exceeds the number specified in the max items
(Work 1n Progress or WIP limit) value for that lane; the
header is highlighted in a configurable color and the
numbers (number of items/max items) also provide a
visual cue that will prompt the team to respond by
swarming (a number of team members focusing) on the
lane to reduce the number of items

c) Sparx Systems age 11o
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Queue

a4
As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean
1 Busin..

As a Customer | 'want to be
ahle to view the status of my
order

UserStory

Example 1

In Progress (7/6)

dig:
As a Sale Representative |
want to be able to view
historical leads

UserStory

lane Ward
""" Devel.

As a Reviewer | want to be
able to be able to add and edit
rules in the online grammar
checker

UserStory

Pat Taylor
[— | (++Pr..

4 May, 2026

Test/Review

A
As a Warehouse Manager |
want to be able to determine
the best product location to
minimize picking errors

UserStory

Yuki Kotabashi
[—— ] TestA..

L

As a Customer | want to be
ahle to rent an item for a
specified duration

UserStory

Paulene Dean
=" TestA.

A high priority User Story that is at the top of the backlog
could be pulled into the 'In Progress' lane and a developer
could immediately commence work on it. The work might
entail the coding of business rules, the review of detailed
requirements, changes to a database schema or the addition
of an element or attribute to an information schema, and the
creation of a new or updated deployment environment.

In Progress (5/6)

As A Student | want to buy
hooks at Academic Prices

UserStory

Pat Taylor

4 a0

— C+s Pr__
L "

All of these artifacts can be found inside the same repository

(c) Sparx Systems 2026
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without the need to launch other tools or schedule meetings
to locate the needed information. The strategic drivers can
be seen in the context of their business owners, architectural
design and principles can be viewed, Business Rules can be
visualized in relation to the policies they qualify, a live
connection can be made to the databases and their schemas
analyzed and altered, XML schemas can be inspected and
messages constructed, programming code can be written and
deployment targets detailed, and all of this achieved in a
single collaborative platform.

g (.
Provide customers with a
competitive online shopping < - -~~~ ~"~"—"~-~-—-—-—-—-—-—-—-—--- |
experience :
I
I
(from Goals) «trace»
I
I
I
L
Rules Analyzer «business rule» ] «policy» D
Any person studying who is under The bookstore will provide discounts
S the age of 27 with student = |[-—-—-—-—-———--= to students to encourage learning
- identification is considered a student «enforces»
«trace»
Thi
E3 (from Su&ess Rules) (from Palicies)
a; I
I
! wtrace»
! I
wirace» |
y I S —

As A Student | want to buy books REQ117 - The system must provide a ° o]
at Academic Prices || | [ __ = mechanism allowing studentste | -~ |
ace»

Requirement «UserStory» identify themselves «trace» il [f 4:16PM
Name
fromTere G I

Institution

A A United States
[
Stanford
wtraces Harvard

Student Number

|
Student Verification = O ]
This Requirements diagram shows
«column» a User Story thathas beenadded
D: NUMBER(8,2) toa Kanban diagram expressing Register
NSTITUTION NAME: NVARCHAR(50) the relationships to a number of
YEAR: NUMBER(4,2) business and technical elements.
STUDENT NUMBER: VARCHAR2(20) A o] =)
~_

c) Sparx Systems age 130
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Example 2

4 May, 2026

This diagram demonstrates a Backlog diagram in a two or
three stage workflow. The entire diagram 1s used to manage
the backlog and items can be dragged within a lane to define
their order in that lane, or between lanes to define their

importance and position in the backlog.

Backlog

Bz kanban Disgram: "Bakog
Low Medium

1
As a Customer | want to be Prices for some publishers do
able to read peer reviews for not include internal storage
items before purchasing costs

UserStory Defect
Proposed Proposed

i
As a Warehouse Manager |
want to be able to find
unallocated space for future
dates

UserStory
Proposed

Flexibility

High

i

As a Marking Manager | wa
to be have a dashboard that
shows sales by demographics
and regions

UserStory
Proposed

s

-
The default purchase date
order should be reversed in all
Product reports

Change

Critical

As a Customer | want to be
able track my item on a map

As an operation manager |
want to be able find picking
errors caused by system
glitches

UserStory

Enterprise Architect has a flexible and integrated Kanban
facility built into the core product, allowing projects of any
size and vertical market to benefit from the profound
efficiencies that come with this simple, elegant and lean
project management approach. Regardless of the type of
process that is being used, Enterprise Architect’s Kanban
features can be quickly and seamlessly integrated into any
method, creating a compelling visual solution and team
collaboration platform that will result in products, services
and solutions being delivered to customers with efficiency

(c) Sparx Systems 2026
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and in record time - delighting both product owners and
customers alike.

The Kanban features in Enterprise Architect are highly
configurable and can be altered to suit any team and
process, including Agile, iterative and incremental, and even
waterfall projects. There is a very low barrier to adoption
and teams can commence with Kanban immediately. The
most basic Kanban board consists of a diagram divided into
a small number of lanes; a range of work items can be added
to the diagram, including Features, User Stories, Defects,
Changes, Use Cases, Requirements and more. Work Items
can be drawn with a compelling visual style representing a
colored card, and can be dragged anywhere in the diagram
to change order in a given lane, or from lane to lane
progressing from left to right through the board,
representing progress towards value for the customer. The
lanes are typically bound to the values of a 'project
management aware' property such as status or phase, and as
the item 1s dragged from lane to lane the value of the bound
property is automatically changed. This facility can,
however, be switched off for an individual lane by setting
the lane to 'Not-Bound', so that the element property is not
changed when it moves to that lane. You might set the lane
to 'Not-Bound' if, for example, the lane captures elements
that have fallen out of the normal process and need to be
assessed according to the property value when the problem
arose.

Resource Allocation

(c) Sparx Systems 2026 Page 15 of 352
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Any number of resources, performing specified roles, can be
allocated to work items as they flow through the Kanban
board, and the progress can be visualized as one or more
progress bars displayed at the bottom of the card. The
allocation is driven by Enterprise Architect's practical and
simple resource allocation facility, which can be used to
define the relationship between resources (team members)
and work 1tems (cards). Any number of team members can
assign themselves to a work item, indicating the role they
will perform, and the start date, finish date, and the expected
time can be used to record estimates of how long the task
will take.

In Progress (5/6)

As a Sales Representative |
want to be able to view
historical leads

Userstory

Jane Ward

(= ] Devel...
Pat Taylor

Progress can be updated as a percentage of completion,
which can be displayed visually on the card. The Kanban
board (like any diagram) can also be displayed as a Gantt
chart or a list view, supporting alternative project
management representations.

(c) Sparx Systems 2026 Page 16 of 352
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Resource Allocation

BEHEX: o =8 @

Resource Role Resource: Jane Ward - | Start Date:  09-062016 +~  Expected Time: [
EJane Ward Developer Role or Task: | Developer - | End Date: 13062016 = Alocated Time: 8
Pat Taylor C++ Programmer Complete %: 15 : Time Expended: 2

Drescription | History

Configuration

The Kanban cards can be configured to display an extensive
set of properties, with compelling icons, colors and progress
bars to communicate the important aspects of the work item,
resource allocation and work item progress. The properties
include the item name, type, status, version, priority,
stereotype, phase, author and more.

In Progress (2/8)

, dig.
As a Stock Control Manager | want to be
able to list stock levels for a selection of

titles.

UserStory
Version: 1.0

Faulene Dean
R Business 4. .
r,

The names, colors and number of lanes can be configured,
in addition to a range of other properties such as the overfill
limits, defaults and the definition of sub-lanes. The
appearance of the board and the work items can all be
configured, using different colors, fonts and styles including
a hand-drawn mode that might appeal to teams more
accustomed to using a physical board with colored notes. It

(c) Sparx Systems 2026 Page 17 of 352
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is also possible to set the chart appearance to highlight
elements that come from the same hierarchies.

Enterprise Architect has built-in Kanban diagrams, and a
number of workflow Patterns that are pre-built and that can
be used 'As-Is' or configured to suit any project or initiative.
The workflow Patterns define one, two or three stage
workflows; for example, the two stage workflow defines a
Kanban board solely for managing the prioritization of the
backlog, and items from the backlog are then moved from
the backlog Kanban to the first lane of the iteration Kanban.
If necessary, the Product Owner can use Enterprise
Architect's security facility to lock the backlog Kanban,
ensuring that the order of items in the backlog is not
inadvertently changed.

There are a number of commercial tools that allow Kanban
to be used to manage projects visually, but Enterprise
Architect’s Kanban facility is incredibly useful because the
tool 1s also a sophisticated modeling platform for strategic
and business analysis, architecture, design, implementation,
testing and deployment. This means that work items on a
Kanban Board can be linked to strategic decisions, business
rules, policies, requirements, architecture and design
elements, wireframes and UX models, programming code,
database tables, procedures, tests, virtual or physical
deployment nodes, and more. For the first time everyone in
the team can collaborate in the same environment using a
toolbox of facilities purpose built for their discipline, while
at the same time being able to visualize and manage the
value being delivered to the customer in a visually

(c) Sparx Systems 2026 Page 18 of 352
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compelling set of Kanban boards.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that
can be used to create expressive charts and dashboards,
which will provide insights into the Kanban process and
enable Product Owners and other team members to monitor
performance and determine ways of fine tuning how the
team 1s working. There 1s a range of built-in charts including
Bar and Pie Charts, Heat Maps and more, but a team 1s free
to create any number of user-defined charts that can be
incorporated into team processes and reviews.

Completed Tasks Last Week

Ali Evans

Alma Cogan

Billy Bunter
Bob Brown
Brett Chambers
Carlos Wallace
Carmen McRae

David Kelly
W Test

[ Rework
W Review

Donna Campbell | 1)1

Eric Burns

Ethan Ropers W Propaosal

Frank Mclver Investigate

Josh Morgan B Implement

Liam Cross

1
Nigel Moleswaorth _ 2 ‘E_
Pat Taylor |Z| 3 [

Penny Dark 1

Peter Ryan

Philip Marlowe |1

T T T T T 1
0 5 10 15 20 25 30 35

c) Sparx Systems age 190
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Application

The Kanban project management methodology helps you to
develop a dynamic, easy-to-view progress summary of the
stages of development of a project, where the stages are
represented as lanes and sub lanes of a diagram - a Kanban
Board. In Enterprise Architect, you can apply a form of this
methodology to your project administration diagrams to
monitor and manage the flow of work 1n a particular area.

The stages of development can be defined by the value of a
project management property of an element, such as Phase,
Version or Status, or a user-defined Tagged Value. The
clements that represent each task or object of a task are
initially placed in the lanes for the earlier stages of the
project, and work on the task is reflected by moving the
corresponding element to a different lane on the diagram. If
a diagram is linked to a project management property,
dragging an element from one lane to another automatically
changes the value of the property to the value that the lane
represents.

In this illustration, the lanes identify what work is being
performed in each stage of development.

c) Sparx Systems age 200
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Backlog Queue In Progress (4/6) Test/Review Done Deploy

New tasks will usually begin in the left-most lane, and
completed tasks will usually pass through all lanes before
coming to rest in the right-most lane and then being moved
off the diagram. A typical workflow is to choose the next
task that you are going to work on by starting in the
right-most lane and seeing if it has any tasks that you are

able to progress; i1f not, move to the next lane and repeat,
and so on.

c) Sparx Systems age 21o
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Kanban Quickstart

Create a Kanban Diagram

A Kanban diagram 1s a board that allows team members to
visualize work items that are represented as colored cards.
The board 1s divided into a number of lanes and team
members move the cards from left to right as work is
completed towards providing value to the customer.

You can create a Kanban diagram by taking an existing
diagram and setting its Kanban properties, but it is easier to
use one of the diagram types provided by the Kanban
Diagrams UML profile as a starting point and then change
its properties to suit your own project.

Ste Action
p

1 | Inthe Browser window, right-click on the parent
Package and select the 'New Diagram' command.
The 'Model Builder' dialog is displayed, showing the
'Diagram Builder' tab page.

2 On the 'Diagram Builder' tab page, use the = icon to
select the 'Construction > Kanban' perspective.
Select 'Kanban' in the 'Select From' panel then
choose one of the diagram types from the right-hand
pane (Basic, Backlog, Iteration and Complete). Give
the new diagram a name 1n the 'Diagram’ field and

c) Sparx Systems age 220
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click on the button 'Create Diagram'.

Package : [j“

Diagram : | Project Core Auto Create Diagram Help

=
=
=]
o
|
w
3
=
o

Maodel Builde. Diagram Builder

3 | If you cannot find 'Kanban' in the list, you must
enable the Kanban MDG Technology.

Add Elements to a Kanban Diagram

Work items are represented visually on a Kanban diagram
but first must be added to the diagram. They can be
clements that already exist in the repository or new elements
dragged from the Kanban Toolbox pages and dropped onto
the diagram. Any element type can appear on a Kanban
board but the most typical types are Features, User Stories,
Defects and Changes. Use Cases, Scenarios and
Requirements are also sometimes added.

When you drop an element onto a Kanban diagram, the lane
it 1s added to depends on whether the diagram has a property
value defined, and also whether i1t has a default lane. If the

c) Sparx Systems age 230
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Kanban diagram has a property value defined and the new
element's property matches one of the lanes, then i1t will be
added to that lane. Otherwise, it will be moved into the
default lane, or to the right of the last lane 1f no default lane
has been nominated.

You can define the Default lane on the 'Lanes' page of the
'Kanban Options' dialog.

The Kanban Toolbox page will open automatically
whenever you open a Kanban diagram. The Toolbox page
provides a default set of elements that you can use to
represent units of work on your Kanban diagrams, but any
type of element can be added.

Ste Action
p

1 | Open your Kanban diagram. The Diagram Toolbox
should appear with the Kanban page selected
automatically.

. Ifthe Diagram Toolbox doesn't appear, click on
the >> button in the top left corner of your
diagram

. If the Kanban page isn't automatically selected,
click on = to display the 'Find Toolbox Item'
dialog and specify 'Kanban'

2 | Drag elements from the Kanban page onto the
Kanban diagram. The page provides these element

types:

(c) Sparx Systems 2026 Page 24 of 352
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Toolbox v R X
Search 2 ,':' =
Elements
”'H:I Change
Defect
L Feature

User Story

Import a Kanban Workflow Pattern

Each organization or team will typically want to define their
own workflow that is appropriate for the initiatives they
work on, and each might have a number of workflows
defined for different types of initiative. While this can be
done from scratch it 1s much easier to use one of the built-in
Patterns, either 'As-Is' or as a starting point. A workflow can
be made up of any number of Kanban boards linked together
into a single workflow; for example, a three stage workflow
would contain three separate boards. Each board can be
configured with any number of lanes and sub-lanes
representing the stages in that part of the workflow. Team
members can move Work Items between lanes in a single
board and also between the boards that make up the entire
workflow.

Kanban Workflow model Patterns help you to very quickly
set up a one-, two- or three-stage workflow, using and
linking the Backlog, Iteration and Complete Kanban
diagrams.

Ste Action

(c) Sparx Systems 2026 Page 25 of 352
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1 | Inthe Browser window, select the Package under
which to create the Workflow Pattern.

2 | Click on the Browser window header and select the
option 'Model Builder (pattern library)', or press
Ctrl+Shift+M. The Model Builder dialog displays.

3 | Click on the Perspective button and select 'Project
Management > Kanban'. The panel header changes
to 'Kanban Perspective' and the panel shows the
three workflow patterns you can select.

. Kanban One Stage Workflow
. Kanban Two Stage Workflow
. Kanban Three Stage Workflow

When you click on one of the patterns, the right hand
panel displays an example diagram and several
sections of useful information on using the pattern.

(c) Sparx Systems 2026 Page 26 of 352
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®5tan:F‘age @Specification Manager ?EThE Game Model Wizard X 4 F

Model Patterns | Process Guidance Executable Patterns Application Patterns  VEA Examples

Kanban Perspective hd
P Panand Zoom
4 Kanban Workflows The Pan and Zoom facility is one of the tools that can be used to navigate
[E] Kanban One Stage Workflow around a large diagram. Often the resolution of a diagram must be reduced to
[E] Kanban Two Stage Workflow ensure it is wholly visible but by using the Pan and Zoom window you can leave
{ [2] Kanban Three Stage Workflow . the diagram at a readable resolution and pan around to areas of interest
zooming in when necessary. For more details see the Pan and Zoom help

topic.

iagram Legends

The Diagram Legend facility is useful for manually or automatically changing
the appearance of elements and connectors on a diagram. A legend can be
added from the Common Toolbox and configured to codify the fill and line color
and line thickness. This is a powerful way to add meaning and expression to a
diagram and is particularly expressive when applied automatically based on
element or connector properties. It can be used with a number of specialized
diagrams such as roadmaps to create a powerful visualization. For more

details see the Diagram Legends help topic.

Create Pattern(s) Add To:  Kanban for Manage Users | Customize Pattern on import

4  If you have the 'Customize Pattern on import'
checkbox selected, prompts display to select the
Packages to import in the Patterns. Each Pattern
contains one Package, which is automatically
selected. Click on the OK button for each Pattern.

5 | Open each of the new diagrams and consider
whether they fit with your own workflow
preferences. The diagrams provided can be changed
to suit your style of working.

Moving Kanban Items

Work Items flow through Kanban boards typically from left
to right as work 1s performed, moving the item closer to
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delivering business value for the customer. In a one-stage
workflow, work items will be moved through a series of
lanes through a single board, but in workflows that consist
of more than one Kanban board the items will also jump
from one board to the next. For example, in a two stage
workflow there 1s a backlog board and items will be
prioritized in the board based on their priority. The work
items that have the highest priority in the Backlog then need
to be moved to the Iteration Board, where implementers will
pull them into the In-Progress lanes.

Moving Items in a Kanban Diagram

Moving items within a Kanban diagram 1s simple and
intuitive and can be achieved by dragging and dropping a
work item from one location to another. If an item is moved
within the same lane its position 1s simply changed in that
lane. If an 1tem 1s dragged to a different lane and the lanes
are bound to an element property or user defined Tagged
Value the value of the item's property or tag will also be
changed.

Ste Action
p

1 | Select the item in the Kanban diagram.

2 Drag and drop it into a new position either in the
same lane or a different lane.

(c) Sparx Systems 2026 Page 28 of 352
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Notes

When an item 1s moved between lanes and the lanes are
bound to a property or Tagged Value, the value of the
property or Tag will be automatically changed.

Example
Backlog Queue
As a Reviewer | want to be As a Customer | want to be able to delete
able to be able to add words itemns from my order before it is shipped

to the online dictionary
UserStory

UserStory

Stock levels on financial
reports don't include returned
items

20—

Defect

Moving Items between Kanban Diagrams

Items can be moved between Kanban boards by using a drop
zone positioned to the right of the diagram. Each drop zone
has the name of another diagram in the workflow, and
elements on the current board can simply be moved by
dragging and dropping them on the appropriate drop zone.
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To create a drop zone, simply drag the target Kanban board
onto the current Kanban diagram and release the mouse
button. In response to the prompt, select the 'Drop Diagram
as Diagram Reference' option. You can have more than one
drop zone, one for each of the other Kanban boards in the
work flow. If you generate a set of Kanban workflow
diagrams using the Patterns in the Model Builder, the drop
zones are automatically generated on each diagram.

Ste Action
p

1 | Select the item in the Kanban diagram.

2 Drag the item to the right of the Kanban diagram
Lanes.

3 | Drop the item onto the zone with the name of the
diagram you are moving the element(s) to.

4  Select 'Move to' to move the element to the new
diagram or 'Create link on diagram' to create a link
on the second diagram without removing the element
from the current diagram.

Example

In this diagram a work item representing a defect is being
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moved from the critical lane of a Backlog Kanban board to
the Iteration board.

High Critical
roTT T TSt Tt T T T T T T T T T T EW

ilteration
1
I

.

7
As a Marking Manager | want é As a Customer | want to be
to be have a dashboard that able track my item on a map
shows sales by demographics
and regions

RN RN
O M
R

|
As a Customer | want to be L
‘ @ able to add new orders to
As a Warehouse Manager | existing ones if they have not
want to be able to find shipped
unallocated space for future
dates

Paulene Dean
E_—_— 1 Busin..

Search for Kanban Diagrams

A well organized repository will assist in quickly locating
specific Kanban diagrams, but in large and complex
initiatives it is common for some team members to need to
search for Kanban Boards. Enterprise Architect has an
easy-to-use yet sophisticated search facility with a built-in
search to find all Kanban diagrams in the repository. Having
located a diagram the user can continue moving objects
from left to right across the board, contributing to the team's
effort focused on providing value to the customer.

Ste Action
p

1 | Select the 'Construct > Resource Management >
Kanban > Find Kanban Diagram' ribbon option.

The search 1s immediately executed and the located
diagrams are listed in the Find in Project view.
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2 | Double-click on any Kanban diagram that you want
to open.

Layout Filter Panel

A project of any appreciable size will typically have a large
number of in-flight work items, and product owners and
team members will often want to filter the selection of items
based on a set of conditions, such as high priority
requirements or those applying to particular stakeholders or
people. This can be achieved using filters at two levels;
either the expedient ribbon Filter or the more sophisticated
and persistent Diagram Filters facility.

Kanban diagrams with a large number of elements can be
quickly filtered in real time using the Layout ribbon Filter
panel.

1. Access the Filter panel.

2. Select the Filter property and the operator (if appropriate),
and specify a search term.

Mame / Alias

Filter

Elements not matching the specified condition will be
obscured in the filtered diagram.
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Backlog

¥
As a Customer | want to be
able to delete items from my
order before it is shipped

UserStory

Queue

As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean
B Busin
%

As a Customer | want to be
able to view the status of my
order

UserStory

(c) Sparx Systems 2026
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In Progress (3/6) Test/Review

L
As a Customer | want to be
able to rent an item for a
specified duration

UserStory

Faulene Dean
] TestA.
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Enterprise Architect provides a number of options for
generating a new Kanban diagram or for opening an existing
Kanban diagram. Having opened the diagram, you can
define its structure, content and appearance. It is also
possible to configure a diagram of any other type to be a
Kanban diagram, by simply adding Kanban properties to it.
This useful design feature means that a diagram containing,
for example, a set of User Stories could simply be changed
to a Kanban diagram and the team could immediately begin
using this flexible, lean, project management method.

To define the structure, content and appearance of a Kanban

diagram, you use the 'Kanban' dialog.

X

Configuration
Sub-lanes
Appearance
Advanced
Filters

|lze thiz page to bind a K.anban to a property or tagged value [moving elements into a lane will
change the property] and to create the main lanes for the diagram.

Properties

| Enabled

Bind K.anban ta:

Matme
Loy
hdedium
High
Critical

Mew

Element. Priority

Fd odify

rax [termns

Lo S o N o B = ]

Delete

Show Mames in Title Bar

Read-only Bind

Colar Default

l:‘ Default [
|:| Default
|:| Default
l:‘ Default

Swimlane width lacked

Fill frarn binding

Bind to Left  MNot-Bound

Caticel

Help

When you display the 'Kanban' dialog, it defaults to the
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'Configuration' page. You use this page to:

. Set up basic Kanban properties, such as whether Kanban
1s enabled on the diagram, if the names are shown 1n the
title bar of the diagram and if the width of each swimlane
1s locked, and

. Create, modify and delete the primary lanes on a Kanban
diagram; you can:
- Create the lanes manually, or define a property that
the lanes bind to, so that the lanes
are generated automatically from that property when
you click on the Fill from binding button
- Add lanes that are not bound to the property
For each lane you can define:
- The maximum number of elements that can be
placed in the lane before triggering
the 'Overfilled' indicator
- The fill color of the lane
- Whether it 1s the default lane that new elements are
added to

Access

Ribbon Construct > Resource Management >
Kanban > (options to generate and/or
open a Kanban diagram) or

Start > Personal > My Kanban (displays
personal default Kanban diagram)

(c) Sparx Systems 2026 Page 35 of 352



Project Build & Deploy 4 May, 2026

Then

Design > Diagram > Manage > Kanban
(on an open Kanban diagram)

Context In the Browser window, right-click on the
Menu diagram name | Kanban

On a diagram, right-click on the
background | Kanban

Configuration Options

Option Action

Enabled
Select the checkbox to apply any of the
Kanban functionality to the diagram. If
the checkbox 1s not selected, the diagram
will behave as a non-Kanban diagram.

Show Names in Title
Bar

Select this checkbox to display the lane
names (but not the sub-lane names) in the
diagram title bar, above the lanes. These
will be visible once the lanes are defined.

When you have several elements in a
column and scroll down to the lower
ones, the Lane headings disappear from
view, so the names in the Title Bar
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continue to i1dentify the lane names.

Swimlane width locked

Select this checkbox to prevent the lanes
in the diagram from being made narrower

or wider.
Bind Kanban to

Click on the [--] button and select the

property to bind lanes to. This will be one
of:

. Element, or

. Tagged Value (enumeration or string
types only), or

. None (makes all lanes unbound).

If you select 'Element', also select one of
the properties 'Phase’, "Version', 'Priority’
(for Requirement-type elements), 'Status'
or 'Author’.

If you select "Tagged Value', also choose
to either 'Create' a new tag (and simply
type in the name) or 'Select' an existing
one.

In the latter case, the 'Kanban Tagged
Value selection' dialog displays, on which
you click on the appropriate radio button
to select either from a list of 'Global
Tagged Values', or from a list of 'Tagged
Values from a selected element'. Click on
the Select Element button to browse for
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the element anywhere in the model.

The Global Tagged Values or those from
the element are provided to the "Tagged
Value' field. Click on the drop-down
arrow on the right of the field and select

the reference Tagged Value from those
listed. Click on the OK button.

The 'Bind Kanban to' field now displays
either the element property or the Tagged
Value you have selected.

When you move an element between two
'Bound' lanes, a pop-up prompt displays
for you to confirm the move. Click on the
prompt to make the move, or click
elsewhere on the diagram to abort the
move. This prevents users from moving

clements between lanes by accident.
Read-only Bind

Select this checkbox to make the effects
of binding Kanban lanes read-only. This
means a user can move elements between
lanes and make various element
formatting changes, but the bound
property value 1s not updated and the
element position is not captured. If
another user views the diagram, or the
first user closes the diagram and it 1s
subsequently re-opened, the moved
elements are in their original positions.
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Fill from binding

If you have chosen an element property
to bind the Kanban lanes to, click on the
Fill from binding button to fill the lane
list with existing values of that property.
This will delete all old lanes before
creating a new lane for each of the new
values. Once the lanes have been created
in this way, they can be renamed,
reordered and added to.

Name

The name of each lane can be filled
automatically using the Fill from binding
button. You can overtype the names;
these do not have to be unique but they
cannot be blank.

Max Items

You can set the maximum number of
clements that can be placed in each lane.
If someone tries to move an element into
a lane that has reached or exceeded its
maximum number, the heading of the
lane will be displayed in the 'Overfilled'
color you define and enable on the
'Appearance' page. This gives a visual
indication that action might have to be
taken to clear what appears to be a

bottleneck in the workflow process.
Color

Several or all of the lanes can have the
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same fill color, or you can set a different
color for each lane independent of the
other lanes. Either:

. Leave the 'Color' value set to 'Default’
(set on the 'Preferences' dialog,
'Gradients and Background' page), or

. Overtype 'Default’ with the hex code
number for the required color, or

. Click on the drop-down arrow and
select a color from the displayed palette

The actual color is shown in the box at
the left of the field.

Default

You can nominate one of your lanes as
the default; that is, the lane does not
assign a bound property value to the lane
title, and therefore can be filled with
varied elements such as those added to
the chart by a Kanban search. So if you
had three lanes bound on the status values
'In Testing', 'Pass' and 'Fail', for instance,
with the 'In Testing' lane being the default
lane, and you added an element that had
the status of 'Not Run', it would be placed
into the 'In Testing' lane instead of being
placed out on the right hand edge of the
diagram past all the lanes.

You can only select one 'Default’
checkbox; clicking on one checkbox
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Not-Bound
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clears any previously-selected checkbox.

The 'Bind to Left' property essentially
makes a primary lane the same as a
sub-lane. Moving an element into a 'Bind
to Left' lane will set the element's bound
property to the left-most bound lane.
Consider a 'Phase' Kanban diagram with
these lanes, 1n order:

. To Do (Default, Not Bound)
. Implement (Bound)

. To Do (Bind to Left)

. Review (Bound)

. To Do (Bind to Left)

. Deploy (Bound)

Newly added elements will be added to
the left-most "To Do' lane with whatever
priority value they previously had.
Moving them to the Tmplement' lane will
then set the phase to 'Implement'. When
the implementation 1s complete, the
element can be moved to the "To Do' lane
before 'Review' without updating the
element's phase until it is moved into the
'Review' lane.

Select the checkbox to set the property
binding to 'Not Bound' for the lane, so
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New

Modify

Delete
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that the element property 1s not changed
when the element moves into that lane.

Y ou might set the lane to 'Not-Bound' if,
for example, the lane captures elements
that have fallen out of the normal process
and need to be assessed according to the
property value when the problem arose.
The lane has a property value, but it is not
applied to the element.

Click on this button to define a new lane
on the Kanban diagram.

Click on a line in the 'Lanes' list and click
on this button to position the cursor in the
'Name' field in update mode, and to
highlight the lane you are modifying to
make it easier to focus on the fields you
might change.

Click on a line in the 'Lanes' list and click
on this button to delete the lane.

Click on an entry in the 'Lanes' list and
click on this button to move the entry one
line up 1n the list, and one lane to the left
on the diagram.

Click on an entry in the 'Lanes' list and
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click on this button to move the entry one
line down in the list, and one lane to the
right on the diagram.

Notes

. The elements in a Kanban diagram individually represent
work 1n progress; you cannot create connectors between
elements on the diagram

. If you apply a Kanban definition to a current diagram, all
connectors on the diagram are hidden; when you
de-activate the definition, the connectors are shown again

. When you first set up a Kanban diagram, any element on
the diagram that does not have one of the defined property
values 1s moved to the right-hand side of the diagram

. Moving an element into a lane automatically sets the
appropriate property of that element to the value
represented by the lane; for a Tagged Value, if the
element does not have that tag, adding the element to the
lane adds the tag and sets it to the lane value

. Elements on a Kanban diagram are automatically adjusted
to match the width of the lane they are in, both when the
element 1s moved into a lane and when the lane width is
changed

. Certain types of element are automatically excluded from
a Kanban diagram search; these are:
- Constraint
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- Port

- ProvidedInterface
- RequiredInterface
- Boundary

- Hyperlink

- State Node (such as Choice and Junction)
- Text

- Win32

- Wireframing

- Package

- Diagram Frame

- Activity Region

- Sequence Element
- Note

- Standard Chart

- Model View

- Time Series Chart
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Kanban Options - Sub-Lanes

Sub-lanes are a useful device for defining another level in
the workflow; for example, you might want to divide the
'In-Progress' lane into a number of sub-lanes representing
the individual developers, or any lane into 'In-Progress' and
'Complete'. The 'Sub-lanes' page helps you to quickly and
casily create any number of new sub-lanes for a Kanban
diagram.

Use this page to create sub-lanes for the diagram.

Sub-lanes can be added to the parent lanes once created by checking the appropriate
checkbox.

Check all Uncheck all

Name To Do In Progress Review Done

Bruce b

Selina b

New Modify Delete @I @.
Cancel Help
Access
Ribbon Construct > Resource Management >

Kanban > (options to generate and/or
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open a Kanban diagram) or

Start > Personal > My Kanban (displays
personal default Kanban diagram)

Then

Design > Diagram > Manage > Kanban >
Sub-lanes (on an open Kanban diagram)

Context In the Browser window, right-click on the
Menu diagram name | Kanban >Sub-lanes, or

On a Kanban diagram, either:
. Double-click on a lane > Sub-lanes

. Right-click on background | Kanban >
Sub-lanes

Creating Sub-Lanes

You add sub-lanes simply by clicking on the New button
and, in the '"Name' column, typing the sub-lane name.
Alternatively, you can leave the default string
'<anonymous>' to create an un-named sub-lane, which can
be useful for organizing lanes that have lots of elements.
The names of the lanes on the diagram are then
automatically added across the panel.

Once you have created sub-lanes, you apply each one to one
or more parent lanes, by selecting the checkbox under the
name of each lane that is to contain the sub-lane. To assign
every sub-lane to every lane, you can click on the Check all
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button, and to clear this total assignment click on the
Uncheck all button. You can also change the order of the
sub-lanes across all their parent lanes in the Kanban
diagram, by clicking on the sub-lane names and on the
up-hand and down-hand buttons.

Within a specific parent lane column you can apply custom
sorting to the sub-lanes, so that the sub-lanes in that lane are
in a different sequence to the same sub-lanes 1n a different
lane. For a column that has assigned sub-lanes (that 1s, it
contains selected checkboxes) right-click on the header and
select the 'Set lane order' option. A small dialog displays, in
which you click on the sub-lane names and use the up-hand
and down-hand buttons to put them in the required
sequence. Click on the OK button to clear the dialog and
apply the sub-lane. If a sub-lane order has been customized,
you can return it to the 'across-the-board' order by
right-clicking the header again and selecting the 'Reset lane
order' option.

Notes

. Sub-lanes are not backwards compatible with earlier
releases of Enterprise Architect; if you open a Kanban
diagram containing sub-lanes in a release of the system
earlier than Release 12.1, the sub-lanes will be
permanently deleted from the diagram

. Elements on a Kanban diagram are automatically adjusted
to match the width of the sub-lane they are in, both when
the element is moved into a sub-lane and when the
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sub-lane width 1s changed
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Kanban Options - Appearance

Using the 'Appearance' page, you can set the Kanban
diagram appearance options, such as the line and font colors
and use of the Hand Drawn mode.

Configuration
i Line Color: —— 1 ~ Hide Names
- Filters
Font Color: I - A Bold Font
Title Color: O Default - Hand Drawn
Overfilled Color: |0 Default - Enable Overfill Highlight
Underfill Color: O Default - Enable Underfill Highli...
Line Width: 1 - Highlight Hierarc...
Vertical Spacing:  Medium -
+| Use Kanban drawing style Native Element Draw Sty...
™ Type Stereotype
Status FPhase
Version b Author
Priarity Truncate name
Bold name il Icon
MNotes Checkboxes
Capitalize Name Tagged Values
i Shadows
Cancel Help
Objects on a Kanban diagram are, by default, drawn using
the Info View style
yie.
- Hiog I
Location 1 NPC design
Task
Version: 1.0

This style displays an icon on the top right corner of the
element, representing the element type, with a triangular
icon to the left of it representing the priority - red for High
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priority, and yellow for Medium priority. No icon shows for
Low priority. The Priority, as for various other element
properties, 1s also represented by a line of text in the body of
the element. You can specify which properties are shown by
selecting the appropriate checkbox from the list at the
bottom of the 'Appearance' page.

Access

Ribbon Construct > Resource Management >
Kanban > (options to generate and/or
open a Kanban diagram) or

Start > Personal > My Kanban (displays
personal default Kanban diagram)

Then

Design > Diagram > Manage > Kanban >
Appearance (on an open Kanban
diagram)

Context In the Browser window, right-click on the
Menu diagram name | Kanban > Appearance, or

On a Kanban diagram, either:
. Double-click on a lane > Appearance

. Right-click on background | Kanban >
Appearance
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Appearance Options

Option Action

Line Color Click on the drop-down arrow and select
the color in which to display lane
borders. This color does not apply to sub
lane borders, which are automatically set
to a pale or dark color to contrast with the
lane fill color.

If the color you require 1s not shown,
click on the More colors button and either
select from a wider range of standard
colors or define a custom color.

The border style 1s automatically set to
the 'chiseled' effect to give the
appearance of 3D blocks on a
background, the color of the background
being the line color. The effect 1s more
obvious if you set the line to a pale color
and not black.

Font Color Click on the drop-down arrow and select
the color in which to display the text in
the Kanban lane and sub lane headings.

If the color you require 1s not shown,
click on the More Colors button and
either select from a wider range of
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standard colors or define a custom color.

A Click on this button to display the 'Font'
dialog, through which you define the font
and the style, size and effects of the text
in the Kanban lane and sub lane headings.

If you also change the text color here, it

overrides the setting of the 'Font Color’
field.

Title Color Click on the drop-down arrow and select
the color to use across the lane heading
cells (separate from the fill colors you
can apply individually to each of the
lanes themselves).

If the color you require 1s not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

Overtfilled Click on the drop-down arrow and select

Color the color with which to fill a lane heading
cell if the lane contains more than the
maximum number of elements. You set
the maximum number of elements when
you define the lanes to work with, in the
'Lanes' page.
If the color you require is not shown,
click on the More colors button and either
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select from a wider range of standard
colors or define a custom color.

Underfill Click on the drop-down arrow and select

Color the color with which to fill a lane heading
cell 1f the column contains fewer than the
maximum number of elements, in other
words there is available capacity. You set
the maximum number of elements when
you define the lanes to work with, in the
'Lanes' page.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

Line Width Click on the drop-down arrow and select
the line width of the Kanban lane borders
- either 1 (thinnest), 2 or 3 (thickest).

Vertical Set this to 'Small’, 'Medium' or 'Large' to
Spacing define the degree of vertical separation
between elements in a Kanban lane.

Hide Names @ Select this checkbox to hide the lane
names and the column heading cells.

Bold Font Select this checkbox to display the lane
headings in bold (if their font definition
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Overfill
Highlight

Enable
Underfill
Highlight

Highlight
Hierarchies
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does not already set them to bold).

Select this checkbox to display the
Kanban lanes and the elements on the
diagram in 'Hand-drawn' mode.

Select this checkbox to apply the
'overfilled' color to the lane header cell 1f
1t contains more elements than the
defined maximum number (see New).

Select this checkbox to apply the
'underfilled' color to the lane header cell
if the lane contains fewer elements than
the defined maximum number; that is, 1f
it has any spare capacity.

Select this checkbox to highlight
clements on the Kanban diagram that are
part of the same hierarchy, by drawing a
colored rectangle behind each element. If
there are elements from two or more
hierarchies on the same diagram, each
hierarchy is represented by background
rectangles of a different color to the
others. In this illustration, Class 1 and
Class 2 are both in one hierarchy, and
Class 5 and Class 6 are both 1n a second
hierarchy.
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Approved Implemented
- -
Classt Class1
Approved Implemented
(
Class2 Class5
Approved Implemented

Select this option 1f you want to apply the
Kanban style to the elements on this
Kanban diagram. Also, select the
checkbox against each element property
or characteristic to be shown in the
elements:

. Type - displays the element type

. Status - displays the element status

. Version - displays the element version
. Priority - displays the element priority

. Bold name - displays the element name
in bold

. Notes - displays element notes in the
elements on the Kanban diagram

. Capitalize Name - displays element
names in capitals on the Kanban
diagram

. Shadows - displays a shadow on the
right and bottom edges of each element
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on the diagram; this effect is not
affected by the 'Element Shadows On'
option on the 'Preferences' dialog
Stereotype - displays the element
stereotype

. Phase - displays the element phase
. Author - displays the name of the

element's author

Truncate name - cuts off the element
name as it approaches the element
border, instead of allowing it to wrap
around

Icon - selected by default; deselecting
this checkbox hides the Type and
Priority icons in the top right corner of
the element

Checkboxes - when Checklist elements
are displayed on the Kanban diagram,
shows the Checklist checkboxes and
items; Checklist Artifacts can be bound
to Priority on a Kanban diagram, and
this option makes it easy to view any
Checklists organized by Priority

. Tagged Values - shows the Tagged

Values of each element on the diagram,
in an element compartment

The property checkboxes are directly
linked to the 'Use Kanban drawing style'
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option. If you do not select the option, the
clement on the Kanban diagram has a
more basic appearance with no properties
shown other than the author and element
names.

Alfred
Location 1 NPC design

Select this option to render the elements
on the Kanban diagram in their native,
rectangular notation style, displaying any
compartments the elements might have.
The Resources compartment 1s
particularly useful for Kanban elements,
if compartments are to be shown. This
compartment lists allocated resources,
including those that are 100% complete.

Note that the element width 1s limited by
the width of the lane the element is in, so
features in compartments might be shown
truncated.

. All elements added to a Kanban diagram initially have the
same height and spacing, but the height can change as
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displayable information is added to an element

. In a Kanban diagram, the normal element appearance
option 1s not operational; only the Kanban appearance
options take effect
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If you do not want to manually add elements to a Kanban
diagram, you can use the 'Advanced' page to set up either
Package searches or SQL searches to automatically fill the
diagram. It 1s not possible to use both a Package search and
a custom SQL search at the same time; if both are specified,
the Package search is ignored.

Kanban
+ Configuration
Sub-lanes
Appearance
Advanced
.- Filters

Select how you would like to fill this Kanban diagram (leave blank to manually add
elements)

Select Auto fill to automatically fill the diagram when loaded. You can also select
Synch with search to remove elements from the diagram that no longer meet the
search criteria.

Package Custom SOL

Remaove

Synch with search

Auto fill

Run Search

Add

Source Details Include Child Packages

OK Cancel

Help

x

The dialog automatically opens at the 'Package' tab. If you
want to create a SQL Search, click on the 'Custom SQL' tab.

Access

Ribbon

Construct > Resource Management >
Kanban > (options to generate and/or
open a Kanban diagram) or

Start > Personal > My Kanban (displays
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personal default Kanban diagram)
Then

Design > Diagram > Manage > Kanban >
Advanced (on an open Kanban diagram)

Context In the Browser window, click on the
Menu diagram name | Kanban > Advanced, or

On a Kanban diagram, either:
. Double-click on a lane > Advanced

. Right-click on the diagram background
| Kanban > Advanced

Kanban Options - Advanced

To fill a diagram based on a Package, simply click on the
Add button and the 'Add Package' option, then select the
required Package or Packages from the 'Select a Package'
browser.

If you want to include elements from child Packages, select
the 'Include Child Packages' checkbox against each Package
in the list. Click on the Run Search button. This will
automatically add elements, based on the search. The search
1s additive (unless 'Synch with search' is selected) and will
only add elements not currently on the diagram. You can
refine the Package search by creating it on the 'Filters' page
and adding filters (see the Kanban Diagram Options -
Filters Help topic).
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To fill the diagram from the results of a custom SQL search,
click on the 'Custom SQL' tab and type or paste the
appropriate SQL. In order for the diagram to be filled, you
must include in the SQL Select statement:

Object ID as Element ID
For example:

Select Object ID as Element ID From t object Where
Object Type = 'Requirement’

Option Action

Add On the 'Package' tab, if you are using a
search or filter (from the 'Filters' page of
the dialog) you must define a Package or
Packages for the search or filter to work
on. You do this by clicking the Add
button and choosing either 'Add Package
to browse to a selected Package, or
'Search Model' to search or filter from all
clements in the current model.

'

Remove If you want to clear a Package from the
list (or the whole-model selection) click
on the item line and click on this button.

Include Child @ If you have selected a Package with a

Packages child structure, select this checkbox to
also include the elements from the
structure in the Kanban diagram, or clear
the checkbox to include elements from
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Run Search
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the selected Package only.

When you select this option, the search
configured for the Kanban diagram will
automatically run whenever the diagram
1s opened or reloaded.

Selecting this option will synchronize the
diagram with the current search when it is
run. That is:

. New elements that match the search but

are not currently on the diagram will be
added and

. Elements on the diagram that now do
not match the search will be removed

When you have set up either a Package
search or a custom SQL search, click on
the Run Search button to fill the diagram.
All elements found by the SQL search are
added to the diagram.

If you have not applied a filter to a
Package Search, all elements from the
selected Packages are added to the
diagram. If you have used a filter, only

those elements that meet the filter criteria
are added.

A 'Progress' dialog displays during the
search. If the search is taking a long time
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or 1s finding too many elements, click on
the Cancel button; any objects already
added to the diagram are removed.
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Kanban Options - Filters

The 'Filters' page can be used in conjunction with the
Package search defined on the 'Advanced' page, should you
want to apply additional filtering.

¢ Configuration

i Marrow the Kanban results to elements matching these conditions.
- Sub-lanes

- Appearance Element Filter
Advanced

| Import Search Add Filter Edit Filter Remove Filter
- Filters

Search In Condition Look For Required
There are noitems to show in this view.

Element Features

* | Optional Required

It 1s possible to import a Model Search that has already been
created, or to create new filters here exactly as you would
for any other Model Search.

When adding any of these searches or filters, you must also
select at least one Package for the search or filter to work in;
you do this on the 'Advanced' page of the 'Kanban' dialog.

Access

c) Sparx Systems age 640
(c)S S 2026 P 64 of 352



Project Build & Deploy 4 May, 2026

Ribbon Construct > Resource Management >
Kanban > (options to generate and/or
open a Kanban diagram) or

Start > Personal > My Kanban (displays
personal default Kanban diagram)

Then

Design > Diagram > Manage > Kanban >
Filters (on an open Kanban diagram)

Context In the Browser window, right-click on the
Menu diagram name | Kanban > Filters, or

On a Kanban diagram, either:
. Double-click on a lane > Filters

. Right-click on the diagram background
| Kanban > Filters

Filter Options

Option Action

Import Click on this button to import a search

Search from either an external XML file ('"From
File') or from the current model ('From
EA').

Add Filter Click on this button to define the
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properties of elements that you want to be
added automatically to your Kanban
diagram during a search. Note that not all
element types can be added to Kanban
diagrams; the excluded types are listed in
the Notes section.

Edit Filter Click on this button to edit the currently
selected filter in the list.

Optional / Optional - Select this when at least one
Required filter needs to be matched
Required - Select this if all filters need to
be matched
Remove Click on this button to delete the
Filter currently selected filter from the list.
Notes

. These element types are not included in Kanban diagrams
when running a search:
- ActionPin
Boundary
Chart
Constraint
Diagram Legend
ExpansionRegion
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- GUIElement

- Hyperlink

- InterruptibleActivityRegion
- ModelView

- Note

- Package

- Port

- ProvidedInterface
- RequiredInterface
- Screen

- Sequence

- StateNode

- Text

- TimeSeriesChart
- UMLDiagram
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Kanban Patterns

Kanban provides diagram types and patterns that underpin
the creation of diagrams. Whilst it is possible to create
Kanban diagrams from most UML diagram types and design
the workflows on them from scratch, these diagram types
and patterns help you to generate a Kanban that matches
your requirements and then adjust the settings to suit, thus
saving time and effort.

Access

On the 'MDG Technologies' dialog, in the "Technology’
panel, select 'Kanban' then click on the 'Enabled' checkbox
and on the OK button.

Ribbon Specialize > Technologies > Manage
Technology

Kanban Diagram Types

The Kanban Technology has four kinds of pre-defined
Kanban diagram, as described here. To create one of these
diagrams, open the 'New Diagram' dialog, use the 'Select
From' header to select the 'Software Construction > Kanban
Perspective' in the left-hand pane and choose one of the
diagram types from the right-hand pane.
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Description

The Basic Kanban diagram contains these
lanes:

. Backlog

. Queue

. In Progress
. Done

The Basic Kanban diagram doesn't have a
lane binding to any element property.

The Backlog Kanban diagram contains
these lanes:

. Low

. Medium
. High

. Critical

The lanes are bound to the element
Priority, so that moving elements
between lanes will automatically update
their Priority to the name of the lane.

The Iteration Kanban diagram contains
these lanes:

. Queue
. In Progress
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. Test/Review
. Done

The lanes are bound to the element Phase,
so that moving elements between lanes
will automatically update their Phase to
the name of the lane.

Complete The Complete Kanban diagram contains
these lanes:

. Ready for Release
. Staging

. Production

. Done

The lanes are bound to the element Phase,
so that moving elements between lanes
will automatically update their Phase to
the name of the lane.

Kanban Workflow Patterns

Kanban Workflow model Patterns help you to very quickly
set up a one, two or three stage workflow, using and linking
the Backlog, Iteration and Complete Kanban diagrames.

Workflow Description
Pattern
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1-stage The 1-stage Workflow Pattern consists of
Workflow a single Kanban diagram with the
Pattern Backlog, Queue, In Progress,

Test/Review, Done, and Deploy lanes.
These lanes are linked to the Phase
property of elements, so that moving
clements between lanes will
automatically update their Phase to the
name of the lane.

2-stage The 2-stage Workflow Pattern consists of
Workflow two related Kanban diagrams:
Pattern . A Backlog Kanban diagram with Low,

Medium, High and Critical lanes linked
to the Priority property of elements, so
that moving elements between lanes
will automatically update the Priority
to the name of the lane, and

. An Iteration Kanban diagram with
Queue, In Progress, Test/Review, Done
and Deploy lanes linked to the Phase
property of elements, so that moving
clements between lanes will
automatically update their Phase to the
name of the lane

Each diagram also has a drop zone that
helps you to move elements easily
between diagrams. Simply drag the
elements onto the appropriate zone
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(having the name of the diagram to move
clements to) and select either 'Move to' to
move the element to the new diagram, or
'Create link on diagram' to create a link
on the second diagram without removing
it from the current diagram.

The 3-stage Workflow Pattern consists of
three related Kanban diagrams:

. A Backlog Kanban diagram with Low,
Medium, High and Critical lanes linked
to the Priority property of elements, so
that moving elements between lanes
will automatically update the Priority
to the name of the lane

. An Iteration Kanban diagram with
Queue, In Progress, Test/Review, and
Done lanes linked to the Phase property
of elements, so that moving elements
between lanes will automatically
update their Phase to the name of the
lane, and

. A Complete Kanban diagram with
Ready for Release, Staging and
Production lanes linked to the Phase
property of elements, so that moving
clements between lanes will
automatically update their Phase to the
name of the lane
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Each diagram also has a drop zone that
helps you to move elements easily
between diagrams. Simply drag the
elements onto the appropriate zone
(having the name of the diagram to move
clements to) and select either 'Move to' to
move the element to the new diagram, or
'Create link on diagram' to create a link
on the second diagram without removing
it from the current diagram.
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Resources & Work Items

Enterprise Architect not only helps you to define the work
items for a Kanban diagram or workflow but also acts as a
sophisticated platform for the allocation and management of
resources and the flow of items through the board. This
functionality uses both Kanban diagrams and the Resource
Allocation features.

Resources are the people who work on a project; they can be
assigned roles and allocated tasks, and these roles and tasks
can be visualized on a Kanban diagram.

In Progress (5/6) Test/Review
- ﬁ@_\ s L@/"\
As a Sales Representative | As a Warehouse Manager |
want to be able to view want to be able to determine
historical leads the best product location to
minimize picking errors
UserStory
Validated UserStory
Medium Proposed
Low
Adam Goodchild
[— ] Soluti... Yuki Kotabashi
lane Ward Llil TestA_ |
[ ] Devel...
Pat Taylor - L]
— | C++Pr. As aCustomerlwant to be able
- S to rent an item for a specified

This example shows a number of Kanban work items, one
with three resources allocated to it. The tasks performed by
the resources are at varying stages of completion,
represented by the green progress bars that show the
percentage of the work completed.
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When a resource allocation is set to 100% complete, it will
no longer be displayed in the Kanban object. When all tasks
have been set to 100%, 1t might be time to move the task to
the next Kanban lane, changing its status so that the next
resources can be allocated. In this example, that might be
resources with a 'Review' or 'Testing' role.

Resource Allocation

To allocate a resource to a Kanban object, you must first
open the Resource Allocation window ('Construct >
Resource Management > Resources'). You then select the
object on the Kanban diagram or in the Browser window
and click on the 'New' icon in the Resource Allocation
window. Add these details as necessary:

. Resource

. Role or Task

. Start Date

. End Date

. Complete %

. Expected Time

. Allocated Time
. Time Expended
. Description

. History

Click on the Save icon to create the resource allocation - a
progress indicator will instantly appear on the work item in
the Kanban diagram. This 1s an important visual cue to show
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that a resource has been assigned to work on this task or has
chosen it themselves. Other team members will immediately
be able to see the allocation on the Kanban diagram and
make decisions about what work items they will work on.
Therefore, it is important not to allocate resources too early
as this could slow down the workflow.

The resource allocations for the Kanban Work Item in the
previous diagram are shown in this example:

Resource Allocation O x
BEHEX: o BE @

Resource Role Allocated Time Expended Time % Completed Start End

Jane Ward Developer 14 2 15 15-Jun-16 20-Jun-16

Pat Taylor C++ Programmer 7 3 50 16-Jun-1& 22-lun-16
Adam Goodchild Solution Architect 6 3 30 14-Jun-16 16-Jun-16

Completed Tasks

Once you have completed a task, you set its 'Complete %'
value to 100. This has the effect of preventing the task's
progress bar from being drawn in the object in the Kanban
diagram. As well as setting the completion percentage on
the task, you might also want to fill in other information,
such as the end date and time expended. It might also be
time to move the object into the next Kanban lane.

Resource Tracking

The Kanban features in Enterprise Architect can be used
with any project management method. How the features are
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used will depend largely on what works best for individual
teams; the teams might be self organizing without any
formal project management controls and other teams might
work with a more formal structure. Either way Enterprise
Architect provides a number of facilities that will assist with
visualizing resources and their allocations to work items.

Enterprise Architect provides searches to allow you to track
resources. You can get a list of tasks that each resource 1s
working on, overdue tasks, recently completed tasks,
summaries, and more. A team or individual can also write
their own custom searches to retrieve any required
information from the repository.

Access

Ribbon Construct > Resource Management >
Active

Construct > Resource Management >
Completed

Construct > Resource Management >
Summary

Resource Tracking Searches
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«

®5tartl-"age Finu:lin Project X

Resource Tracking = 30 Day Resources =

Drag a column header here to group by that| Re50UTCEs
Tasks Overdue

| ] Object Type Active Tasks Scope
Tasks Completed
Recently Finished Tasks
Tasks Ending Today
Tasks Starting Today
Authors with no Active Tasks
30 Day Task Summary (Simplified)
30 Day Task Summary (Full)
30 Day Resources b
30 Day Roles

Search Description

Active Tasks = Searches the project for elements with
assigned resources, where the end date 1s
in the future and the percentage
completion 1s less than 100.

The output lists all elements with
currently active tasks, and shows the
details of the resource allocation to each
task.

Tasks Ending = Searches the project for elements with
Today assigned resources, where the task end
date is today.

The output lists all elements with tasks
ending today, whether the task is
complete or not, and shows the details of
the resource allocation to each task.
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Starting
Today

Overdue
Tasks
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Searches the project for elements with
assigned resources, where the task start
date is today.

The output lists all elements with tasks
starting today, and shows the details of
the resource allocation to each task.

Searches the project for elements with
assigned resources, where the end date is
in the past and the percentage completion
1s less than 100.

The output lists all elements with overdue
tasks, and shows the details of the
resource allocation to each task.

Searches the project for elements with
assigned resources, where the end date 1s
in the recent past and the percentage
completion is 100. In the 'Search Term'
field, specify the number of days over
which to check back.

The output lists all elements with tasks
completed within the specified period,
and shows the details of the resource
allocation to that task. The output does
not include tasks that have already been
finished in advance of a future
completion date.
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Searches the project for elements with
assigned resources, where the percentage
completion is 100.

The output lists all elements with
completed tasks, and shows the details of
the resource allocation to each task.

Provides a brief summary of the tasks
performed by resources over the previous
month.

The output groups tasks with similar
project role and calculates for each
resource: the count, the sum of expected
time, and the sum of expended time for
all tasks that have started in the last 30
days. To look at or change the master list
of project roles that this search uses for
grouping tasks, select 'Settings >
Reference Data > Model Types > People
> Project Roles'. Grouping by similar
project role means that, for example,
'Review 1' and 'Review 2' would be
grouped together under 'Review' if and
only if the current project's list of project
roles includes one called 'Review'.

Provides a full summary of the tasks
performed by resources over the previous
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(Full) month.

The output groups tasks by project role
and resource, and lists the count, sum of
expected time, and sum of expended time
for all tasks that have started in the last

30 days.
30 Day Searches the project for tasks that have
Resources started 1n the last 30 days where the

resource name matches (fully or partially)
the text in the <Search Term>.

30 Day Roles @ Searches the project for tasks that have
started in the last 30 days where the role
name matches (fully or partially) the text
in the <Search Term>.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that
allows a wide range of charts to be created, through which
you can visualize and analyze repository information. This
1s particularly useful with Kanban diagrams and resource
allocations, and provides an alternative view of the Kanban
cards, allowing a Product Owner, Project Manager or other
team member to get a visual image of things such as the
Number of Active Tasks by developer, the Phases the Work
Items are in by developer, the Number of Work Items at
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each stage of a Kanban Board and much more. The charts
can provide information that will help improve the teams
performance and ultimately result in high value product or
service features being available to customers in the shortest
possible time frame. Any number of charts can be created
from built-in Patterns, but a team 1s also free to create user
defined charts, dashboards and reports.

Example - Active Work Items by Team
Member

This Bar Chart shows the number of active tasks by team
member. The names of the team members are listed on the
vertical axis and the Number of Tasks on the horizontal
axis. A small numerical value indicates the number of active
tasks allocated to each team member.
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dash Active Tasks

Active Tasks

Ali Evans
Anna Howe
Buck Gold

Carlos Wallace

Leon Major
Liam Cross
Penny Dark

Peter Ryan

Example - Completed Work Items by Team
Member

This compelling Bar Chart shows the number of work items
completed by the members of a team in a particular phase of
the process. The team members are represented on the
vertical axis and the number of completed work items on the
horizontal axis. Color has been used to help visualize the
work items completed in a given phase; a Diagram Legend
lists the relationship between color and phase. A small
numeric indicator indicates the number of items completed
in each phase for each team member.
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dash Completed Tashks )

Ali Evans
Alma Cogan
Billy Bunter

Bob Brown

Completed Tasks Last Week

Brett Chambers

Carlos Wallace
Carmen McRae

David Kelly
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W Test
Donma Campbell | 1]: B Rewark
Eric Burns B Review
Ethan Rogers W Proposal
Frank Mclver O Investigate
Josh Margan | ] B implement
Liam Cross |
Nigel Molesworth -E
Pat Taylor _
Penny Dark i 1
Peter Ryan :
Philip Marlowe | 1] 2]
T T T T T T 1
0 5 10 15 20 25 30 35

Example - Weekly Work Item Summary by
Phase

This expressive Bar Chart provides a weekly summary of
the number of Work Items completed by phase. The Phases
are represented on the vertical axis and the Number of Work
Items on the horizontal axis. The Chart can provide
information that will help improve the team's performance.
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dash Task Summary

Task Summary (1 Week)

Implement

Investigate

Proposal

(c) Sparx Systems 2026 Page 85 of 352



Project Build & Deploy 4 May, 2026

Kanban in Context

There 1s a wide range of tools that allow teams to create
Kanban diagrams, but Enterprise Architect stands on its own
as a tool that not only allows a team to use the Kanban
features but 1s also a sophisticated platform for managing
the work products of every discipline working on
Enterprise, Business or Technology initiatives. This means
that instead of having to access other tools or out-of-date
documentation or schedule meetings the information related
to a work items i1s immediately available inside the same
repository. An analyst, developer, tester or other team
member working on a User Story, Feature, or Defect can
locate the related Requirements, Business Rules Policies,
Standard Operating Procedures, Strategies, Drivers, Goals,
Stakeholders Requirements, Architectural designs,
Principles, Programming Code, Database and Information
Schemas, XML definitions, Messages, Test Cases,
Applications, Deployment Targets and Specifications and
more.
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(from Goals) 1
I
L
Rules Analyzer «husiness rule» 1 «policy» D
Any person studying who is under The book will provide di s
o ,>. the age of 27 with student |- —-——-—-———-—-= to students to encourage learning
- identification is considered a student «enforces»
«trace»
This
HEE (from SuAess Rules) (from Policies)
a; |
I
wtrace»
: i
«trace» I
v w L

As A Student | want to buy books REQ117 - The system must provide a . o

at Academic Prices H:| _______ mechanism allowing studentste | _—~ |

Requirement «UserStory» «tracen identify themselves «tracen
Version: 1.0 Phase: In Progress

Name

Institution

/\\ A United States

stanford

Harvard

Student Number

|
st vertnion O 1

This Requirements diagram shows
acolumny» a User Story that has been added

D: NUMBER(8,2) toa Kanban diagram expressing
NSTITUTION NAME: NVARCHAR(50)

the relationships to a number of

Register
YEAR: NUMBER(4,2) business and technical elements.

Relating Model Elements

Enterprise Architect allows a user to create any number of
connections between model elements, using the connectors
that form part of the chosen modeling language. Any item
that appears in a Kanban diagram can be dragged onto any
other diagram and then connections can be added. For
example, a User Story that is coming to the top of a backlog
or is in a Queue lane 1n a Kanban diagram could be added to
a Business or Stakeholder Requirements diagram, and Trace
relationships could be added between the User Story and the
Requirements, indicating which requirements relate to the
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Story.

Finding Related Model Elements

The work items in a Kanban board can be related to any
other elements in the model, allowing a graph to be defined.
While it 1s possible to add your own connections, quite
typically other team members working in related disciplines
and parts of the repository will have already added
relationships to other model elements, which in turn will be
related to still other elements and so on.

These connections can all be visualized in existing
diagrams, but a modeler can create a new diagram and place
the work item 1n the center of the diagram, choosing the
Insert Related Elements feature to insert the graph of related
elements that can be configured to draw an expressive
diagram reaching out to the very corners of the repository.

This diagram shows the result of using the Insert Related
Elements feature to find the important information needed
when working on a User Story.
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Rules Analyzer

This is a customer built rules engine
used to manage configuration items. It
has been extended to allow rules to ke
viewed and updated through a business
web interface.

|
1
«trace»
As A Student | want to buy books
at Academic Prices
Requirement «UserStory»

Version: 1.0 Phase: In Progress
Priority: High

)
I
|
|
wtrace»
1

Student Verification E

acolumn»
ID: NUMBER(8,2})
INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)
STUDENT NUMBER: VARCHAR2(20)

«goal» UD

Provide customers with a
competitive online shopping
experience

(from Goals)

«business rule» 1
Any person studying who is under
the age of 27 with student
identification is considered a student

«trace»
(from SuAess Rules)
I
I
I
I
wtrace»
I
I
I
l
REQ117 - The system must provide a
_______ mechanism allowing students to
«trace»

identify themselves

(from Take Orders)

@)

This Requirements diagram shows
a User Story that has been added
toa Kanban diagram expressing
the relationships to a number of
business and technical elements.
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The Backlog

The Backlog (or Product Backlog, as it is called by some
Agile methods such as Scrum) is an ordered list of items
that will deliver business value to the customer. It can
consist of a heterogeneous list of item types ranging from
Features, User Stories and Requirements (including
Non-functional Requirements) to Defects, Changes and
more. In fact, in Enterprise Architect any element can be
placed onto a Backlog; the ones that are listed and those that
appear in the Toolbox are simply the most common. The
Backlog 1s an ordered list based on the business value, with
the higher value items percolating to the top of the list. The
list 1s owned and managed by the Product Owner or their
equivalent; that is, someone acting as a surrogate for the
customer.

Ordering Items in a Backlog Lane

When working with a one-stage workflow, the Backlog
items will typically be contained in the first lane of the
Kanban and can be dragged to a new location in the lane to
change the order of items in the backlog.

Ste Action
p

1 | Select the Item to be moved in the Backlog diagram.
2 | Drag-and-drop it into a new location in the backlog

(c) Sparx Systems 2026 Page 90 of 352



Project Build & Deploy 4 May, 2026

lane.

Prioritizing a Backlog

Typically, the order of the items in the Backlog is carefully
and thoughtfully determined by the Product Owner and
reflects the business value - the items promising high
business value are located at the top. The prioritization of
the Backlog 1s the Product Owner's responsibility, but it is
not decided in isolation from other team members and the
Product Owner relies on access to important information
from a range of stakeholders, from senior executive level
stakeholders, business and operation managers,
requirements analysts and business analysts, through to
implementation teams.

A range of strategic diagrams and materials provides a
source for many of the prioritization decisions. These
include: Strategy Maps, Business Drivers, Goals and
Objectives, and Roadmap diagrams that describe the
time-based sequencing of packages of work. The example
Roadmap diagram could be used by the Product Owner as
an input to what is of high priority to the Business, or what
has been planned by the Enterprise or Business Architecture
teams. The diagram will prove useful in discussions with
both the business stakeholders and the implementers, who
can gain a business context for the work they are
completing.
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Unit: Quarterly Product Architecture

Q3'16 Q4'l6e Qi'l7 Q217 Q317 Q4'17 Ql1'i18 Q2'18
T T T T T O

Academic Titles

Item Real-Time Tracking

sales and Marketing Dashboards

Warehouse Optimization

Logistics Rationalization

[:] Implementation
[:] Production

Comments provided by Implementers and other
stakeholders will also provide a valuable source of
information and input into the prioritization of the backlog.
Enterprise Architect has a Discuss & Review window,
which is a highly collaborative facility through which any
team member can enter discussion posts against an element
and other users can reply and join the discussion. This can
create a rich and useful tapestry of knowledge that will not
only help the Product Owner in deciding the item's position
in the backlog list but will also assist implementers when
they are ready to implement the item.
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M 4 F M | Element Discussions . Model Chat
As a Stock Manager | want to be able to predict product demand -
= | » ‘_.FI._:||_||Ene Dean 16-Jun-16 4:35 PM

(1] Is this related to peak demand times like the beginning
of the Academic Year or is it more general?

* Greg Michols 16-Jun-16 4:38 PM

It is being driven by the upcoming Academic Titles
launch but it applies more generally as well.

Another critical piece of information that will help the
Product Owner is the item estimates completed by
implementers, who make their best estimation of how long
the item is likely to take. Agile teams using User Stories
tend to use Story Points, but any unit of measure can be
used as long as the team agrees upon a standard. Some
teams will use actual times based on units such as number of
hours, whilst others will use effort-based estimates.
Enterprise Architect has a flexible and integrated resource
allocation facility where team members can add estimates,
allowed time, actual times, completion percentages and
more. This will be invaluable for the Product Owner, who
might have a broad idea of the time required to complete an
item but who would rely heavily on the details supplied by
the team. The time estimate can be entered in the 'Expected
Time' field of the Resource Allocation window.

Resource Allocation

hEHEXS:D BE @

Resource Role Resource: Jane Ward - | Start Date:  09-062016 ~  BExpected Time: [
EJane Ward Developer Role or Task: | Developer + | End Date: 13062016 ~  Allocated Time: 8
Pat Taylor C++ Programmer Complete %: 15 : Time Expended: 2

Drescription | History
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This diagram shows how a backlog can be defined in a
one-stage workflow, allowing items to be dragged and
dropped in a single column to define the order of the items
in the backlog.

Backlog

-

L

A0

AsaCustomerlwant tobe able
to viewthestatusof my order

UserStory
Validated
High

-

-

L

AP
AsaReviewer lwantto beable
to beableto addwords to the
online dictionary

UserStory
Proposed
Medium

.

-

L

L

Prices for some publishers do
not include internal storage
costs

Defect
Proposed
Low

Ordering Items in a Backlog Diagram

When working with two or three stage workflows the
Backlog items are contained in a Kanban board representing
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the entire Backlog, allowing them to be moved between
lanes from low to medium, high or critical or using any user
defined lane names or bound property.

Ste | Action
p

1 | Ensure the Backlog Kanban diagram is open.
2 Select the work item to be prioritized in the diagram.

3 | Drag and drop the item into a new location, either in
the containing lane or in another lane.

Securing a Backlog

The Backlog is a communication tool that insulates the
implementers from the need to decide what they should be
working on. It is owned and managed by the Product
Owner, who ultimately decides what should be on the
Backlog and the order of the items it contains. It therefore
must be secured from inadvertent changes. The
implementation team should have access to the Backlog, but
for the purposes of pulling items from a work queue to the
In-Progress lane, which could be continuous flow-based
(Kanban) or time-boxed (such as a Sprint). The
development team also need to provide time estimates for
the items 1n the Backlog, which will help the Product Owner
decide upon the order of items, particularly when two or
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more items have comparable business value. The item with
the lowest completion estimate will typically be given a
higher position. Developers are also expected and
encouraged to comment on the items in the Backlog so that
the Product Owner can understand any issues or have access
to learning from prior initiatives or insights.

Enterprise Architect's security system can be used to lock
the Backlog while still allowing people to make the
necessary contributions of time estimates and comments in
the form of discussions.

With the Security System enabled and either a group for
Product Owners or individual users who are Product Owners
added, a Backlog diagram can be locked by the individual
Product Owner user or a member of the Product Owner
group. This example shows the Backlog being locked by the
Product Owner group, but for a repository that is accessed
by a number of Product Owners it could be more expedient
to lock the diagram to an individual.

Leck Diagram -

Lock Type

Mo lock, general editing allowed
Full lock. no-one may edi
User lock, locking user may still edit
Q) Group lock:, locking group may still edit

GrouplD: | Product Owners

When the Backlog diagram has been locked by the Product
Owner, other team members will be able to view the
diagram but a small red marker to the left of the diagram

c) Sparx Systems age 960
(c)S S 2026 P 96 of 352



Project Build & Deploy 4 May, 2026

name in the Browser window will indicate that it 1s locked.
The Project Manager will see a blue marker indicating that
they have access to edit the diagram.

Project Browser v B X
O + + =~
Global Context
4 [ 0nline Shop Example i
:E'EEIacklng

5 Online Shop Example
b [£31 Stage Workflow
4 (72 Stage Workflow

1 e Backlog
:E'E Iteration

ElEIacI-;IDg
Flteration

Securing a Backlog Diagram

Secure a Backlog diagram, remembering that it can be
locked at a user or a group level.

Ste Action
p

1 | Locate and select the Backlog diagram in the
Browser window.

2 | Right-click on the diagram name and select the 'Lock

Diagram' option. The 'Lock Diagram' dialog
displays.
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3 | Select the 'User Lock' or 'Group Lock' option from
the 'Lock Type' list.

4 Select the User, or the Group from the 'Group ID'
drop-down list.

5 | Click on the OK button to save the changes.

Notes

. The model must have user security enabled in order to
lock the backlog Kanban diagram

. To secure a Backlog a two or three stage workflow is
required where the Backlog is a separate Kanban diagram
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Elaboration and Grooming

During the process of prioritizing the Backlog, and as work
items move closer to the top of the Backlog or onto the work
Queue, the work items must be prepared for the In-Progress
stages of the workflow - 1n traditional methods, this process
1s termed 'elaboration’, but is known as 'grooming' in Agile
methods. Enterprise Architect has a number of facilities that
can assist with the grooming of work items, so that when
they are pulled onto an In-Progress lane the right
information 1s available for an implementer to immediately
start work.

Enterprise Architect has a form of requirement that is
internal to an element and allows supplementary and more
specific requirements to be added to a Work Item. These
requirements are created in addition to the business,
stakeholder, functional and non functional requirements that
might exist for the work item.
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[&f' UserStory : As A Student | want to buy books at Academic Prices X
=g P.VUPE’tiES Requirement:
- General An item needs to be idertified as an academic title
E| Rules
i - Requirements
i . Constraints
i Scenarios B/ U®#&-|i= éE %, % = Req
=- R_elated Status Proposed
""" Ffles Students should not be permitted to buy any titles that are not D"fﬁc_“h Me‘j?“m
""" lnts marked as academic so a new property must be added to the item Prority Medium
. . . . Stability Moderate
information model and related tables to categorize these titles. h
Type Functional
Last Updated 17-Jun-169:...
New Save Delete
Requirement Type Extemal
An item needs to be identified as an academic title: Functional
Student numbers need to be verfied Functional
The Academic Price discount needs to be configurable at rurtime Functional

Cancel Apphy Help

There 1s also a wide range of information that can be entered
as Change Management Items for a selected Kanban Work
Item. These items include Features, Changes, Documents,
Issues, Defects and Tasks, and add rich additional
information that will assist all team members, including the

Product Owner and the Implementation team.
DEHEXiw BE @

Issue Priarity Name: The database environments are locked down while the Linux upgrades are being done Auto
The percentage for the academic pr.. Medium Raised by: Greg Nichals + | Raised: 15062016 - Status: | New
EThe database enwvironments are loc... High Completed by: -] Completed: [ - Prorty: |Hich
Version / |D: 16065 3CEEISS Copy ID

Description | Histary
(BT UR-IZE| %@

There is a Linux Operating system project in progress for the next couple of
weeks and all non critical database changes have been frozen during this
period. This will mean that the addition of the Student Verification table and
associated stored procedures will have to be delayed. A replica environment
will he huilt on another server to allow develonment to continue.

4 11 .4
;fs’ Defects :g’& Changes ,g,& Events qfs’ Decisions pg*&’lssues

Enterprise Architect also has the 'Details' tab of the
Inspector window, which 1s a convenient tool for viewing all
the related information about an element in a single place.
The 'Details' tab can be kept open 1n the Inspector window
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and items can be selected in a Kanban diagram, List, or
Gantt chart, and the Work Item's specific information will
be displayed.

Inspector

e

20

“per! I:@EI
Dretails

Trace Summary

Az A Student [want to buy books at Scadernic Prices

4 8

&
4 3

Relationships
n"h AbstractionsStudent Verification [Class)]
n"n Abstraction:Rules Analyzer [Component]

q"h AhstractiontREQT1Y - The systern must provide 3 mechanism allowing students to identify themselves [Requirernent]

n"u Motelink: [Mote]

Discussions

B Requirernents

The &cadernic Price discount needs to be configurable at runtime
Student nurbers need to be verified

A itern needs to be identified as an academic title

Constraints

The solution rust use existing stored procedures where applicable
Scenarios

Linked Features

B Files

i EtProjectsiOnline BookStore\RequirermentshList of Academic Institutions.xls
Testing

kdaintenance

PRE Changes

3] [ Mew | &cadernic Institutions need to register for discount

A E] lzsues

5 [ Mew ] The database ervironments are locked down while the Linux upgrades are being done

i [Werified ] The percentage for the acadermic price discount has not been set by the product tearm

4 B Project
4 [ Decisions
@ [Werified ] Mo need ta cite arwalidate a student card
4 B Resources
F| [ 3% ] Pat Taylor: C++ Prograrmrmer
B Integration
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Default Kanban Diagrams

A default Kanban diagram can be set for the entire
repository, and each individual user can also set their own
default Kanban diagram; in both cases there are specific
options to locate and open the diagrams. These defaults help
you to quickly and easily get access to a Kanban board and
immediately start contributing to work items that will
deliver value to the customer.

To track your own work, you can select:
. The 'Start > Personal > My Kanban' ribbon option, or

. The 'Construct > Resource Management > Kanban >
Open My Kanban' ribbon option, or

. The 'User Default Kanban' menu option from the diagram
Caption Bar

To track the team's work, you can select:

. The 'Construct > Resource Management > Kanban >
Open Project Kanban' option or

. The 'Model Default Kanban' menu option from the
diagram Caption Bar

v x| Toolhox > 0
@ Show 5tart Page

User Default Diagram

User Default Kanban

Model Default Diagram

Model Default Kanban

'Eg Backlog
'Eg Specification Manager
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Set the Model Default Kanban

A default model Kanban diagram can help you to visually
track a range of work items and their current stage of
development through an initiative. This feature ensures that
all team members can visualize the important work items in
a consistent way and allows them to track the work items as
they move from an idea in the backlog through to
completion ultimately delivering business value to the
customer.

Ste | Action
p

1 | Ensure the preferred Kanban diagram is open in the
main view.

2 | Select the 'Construct> Resource Management >
Kanban > Model Places - Manage > Set Current as
Default' ribbon option.

Set My Default Kanban

In a shared security-enabled model environment it is
possible to set a user-specific default Kanban diagram. A
personalized Kanban diagram can help each member of a
team to visually keep track of a range of elements of
particular relevance to them, and their current stage of
development.
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Ste Action
p

1 | Ensure your preferred Kanban diagram is open in the
main view.

2 | Select the 'Construct > Resource Management >
Kanban > My Places - Manage > Set Current as
Default' ribbon option.

Notes

. The model must have user security enabled in order to
define a user default Kanban diagram
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Alternative Views

Enterprise Architect 1s a modeling platform that can be used
by any number of stakeholders, ranging from high level
executives to implementation teams, providing a variety of
communication devices suitable for each stakeholder group.
There are four other views of a Kanban diagram that will be
appealing to many stakeholders, particularly project
managers, schedulers, development managers and product
owners; these can be viewed by simply toggling from view
to view:

. Gantt View
This view provides a visualization of the work items and
the assigned resources in a Gantt Chart, which is
particularly useful for people who might be more familiar
with this more traditional representation or who want to
get an overview of the schedule of tasks

. List View
This view 1s a spreadsheet representation, where the work
items are the rows and the properties and Tagged Values
are the columns

. Specification Manager View
This view lists the work 1items with the contents of each
element's Notes field

. Traceability Window
This view helps a team member to quickly review
dependencies and other relationships between work items
to any depth, and to locate the items in other diagrams
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Switching between Views

A Kanban diagram, like all diagrams, can be switched to an
alternative view and, once 1n this view, can be switched to
any other view without affecting the underlying layout of
the diagram.

Ste Action
p

1 | Ensure the diagram is the active tab or has focus.

2 Ribbon: Design > Diagram > Views > <view type>

Context Menu (open diagram): Open Diagram in |
<view type>

List View

The List View provides a spreadsheet-like visualization of
the work items and their properties and Tagged Values. It
allows properties to be viewed and compared across the
entire corpus of work items that make up the diagram and
allows properties such as status to be edited inline using
drop-down lists of values where they apply. It also has a
clever mechanism that allows the list to be grouped by
property down to any number of levels and a filter that is
useful when wanting to restrict the view of work items with
a particular property or name - for example, all work items
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relating to the Warehouse Manager.

Egkartar Diagram: "1 stage workflow"

HEXEE A kB &A@

Priarity =

¥ Mame ~ Priority ~ Phase > Status ~ Type ¥  Modified =7

o o e o o o

~| Priority: Critical
As a Customer | want to be able to add new orders to existing ones if they hav... Critical In Progress Proposed  Defect 17-Jun-16
—| Priority: High
As an Administrator | want to be able to have a maintenance window to updat... High In Progress Validated Requirement 17-Jlun-16 =
As a Customer | want to be able to view the status of my order High Backlog Validated Reguirement 17-Jun-16
As A Student | want to buy books at Academic Prices High [~ InProgress Proposed Requirement 17-lun-16
—| Priority: Medium Ehl
The Online Shop web site country drop down list is missing a number of small ... !_ow Done Proposed Defect 14-Jun-16
Az a Reviewer | want to be able to be able to add and edit rules in the online ... Medium InProgress Proposed Requirement 17-Jun-16
As 3 Sales Representative | want to be able to view historical leads Medium In Progress Proposed  Requirement  17-Jun-16
As a Customer | want to be able to delete items from my order before it is ship... Medium Queue Approved Requirement  17-Jun-16
As a Reviewer | want to be able to be able to add words to the online dictionary Medium Backlog Proposed Requirement 17-Jun-16 -

Access

Ribbon Design > Diagram > Views > List View

Context Right-click on diagram background |
Menu Open Diagram in | List View

Gantt View

The Project Gantt View provides a traditional Gantt Chart in
the form of bar chart representing the scheduling of the
work 1tems including: their start and finish times and the
percentage complete. It is a graph that provides a time
oriented view of the work items and is useful for project
managers and project schedulers or other team members
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who want to view all the work items in a single view.

Access
Ribbon Design > Diagram > Views > Gantt View
Context Right-click on diagram background |
Menu Open Diagram in | Gantt View

Specification Manager View

The Specification Manager is a simple document-based
interface to a selected diagram (or Package) in the model,
providing the means of creating and reviewing elements as
text representations of objects in the model, using a process
that 1s familiar to all users including business professionals
and management, who might not have expertise in model
development.

The Specification Manager is also an interactive reporting
tool for displaying, in icon form, the status of various other
features against each entry and providing access to edit each
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feature.
Access
Ribbon Design > Diagram > Views >
Specification View
Context Right-click on diagram background |
Menu Open Diagram 1n | Specification Manager

Traceability View

The Traceability Window provides an insightful view of
how a work item 1s connected to other elements in the
model including other work items and how these connected
elements are themselves connected down to any level. It is a
general purpose mechanism and so can be used with any
type of element but 1s particularly useful when working with
Kanban boards and for product owners and other team
members who need to understand the dependenies between
work items and to find the related information that will help
with the analysis, grooming, testing and implementation of a
work item.
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Traceability O x

6 B8 | i -

A Az A Student | want to buy books at Academic Prices -~
A -+ needed by

V| Student Verfication
[ --+ dependson
4 2] Rules Analyzer
A -+ depends on
A Any person studying who is under the age of 27 with student identfication is considered a student
4 -+ needed by
[+ REQ117 - The system must provide a mechanism allowing students to identify themselves
[ 2] Rules Analyzer
4 -+ depends on
A The bookstore will provide discounts to students to encourage leaming

4 -+ needed by
Ary person studying who is under the age of 27 with student identification is considered a student

4 -+ depends on
A Provide customers with a competitive online shopping experience
A -+ needed by
[ REGQ014 - Shopping Basket
[ The bookstore will provide discounts to students to encourage leaming
[ REQ012 - Provide Online Sales -

Access

Ensure a Work Item 1s selected in a diagram or other view.

Ribbon Design > Element > Trace
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Other Methods

Kanban 1s not a process in traditional classification but more
of a way of visualizing work items, and a method for
creating efficiencies and ensuring customer value is
delivered as soon as possible. Kanban can be used in
1solation or in combination with any existing processes,
including Scrum, Iterative and Incremental and Waterfall
Processes. Each of these processes has their place and can
be used with Kanban even though much of the literature
about process 1s currently focused on iterative families of
processes such as Agile.

The compelling thing about Kanban is that it provides a
visualization of the flow of Work Items from the i1deas stage
through to delivering demonstrable value to the customer
transparently to every team member.

Scrumban

Scrumban is a hybrid methodology combing aspects of
Scrum and Kanban. Scrum teams can typically work with
the same process they have always used, including Sprints,
Standups, Retrospectives and Demos, but incorporate
Kanban as a way of visualizing the Work Items, allowing
just-in-time planning and benefiting from being able to set
Work-In-Progress (WIP) Limits. The work items that have
been selected for the Sprint or Iteration can be pulled from a
Backlog Kanban board onto the Queue lane of an Iteration
Kanban board.
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Using Scrumban overcomes limitations or issues that some
Scrum teams experience such as: excessive time required in
Sprint planning, a loss of focus due to implementers
working concurrently on too many User Stories, Defects or
other items and information being forgotten over the period
of the Sprint. The built-in one, two or three stage workflows
would all be suitable for Scrumban but a team is free to
define their own workflow, create their own Kanban boards
and define their own lanes and sub-lanes.

In Progress

Pat Taylor Benjamin Hutton Theresa Moranti

@ A Al 4
As a Sales Representative | want to be able The Online Shop web site country drop As a Reviewer | want to be able to be able
to view historical leads down list is missing a number of small to add and edit rules in the online grammar
countries checker

As A Student | want to buy books at
Academic Prices As a Customer | want to be able to delete Stock levels on financial reports don't
items from my order before it is shipped include returned items

Iterative Methods

Iterative and incremental methods have been in use since the
mid nineteen seventies and have been incorporated into a
number of waterfall processes as well as being used in
isolation These processes can all benefit from the use of
Kanban diagrams as a way of visualizing the work items in
an iteration and any number of Kanban diagrams can be
created to manage concurrent iterations.
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Project Browser v 1 x
1O + 3+ =~
Project Browser Context Browser
4 £ Multi Iteration Workflow —
F= Backlog
:E'E Iteration One
:E'E Iteration Two
ElEackIDg
T IIteration One
FlIteration Two
[+ 7 Defects

[+ (£ User Stories

Waterfall

Waterfall or modified methods have been in use since the
mid nineteen-seventies and have been baked into a number
of standards, particularly in industries such as the military,
aviation, travel and finance, where outcomes typically need
to be determined in advance of a development cycle.
Waterfall methods are often used when requirements are
locked down and scope is determined in advance, the
product is stable and the technology platforms are well
known and understood. These processes can all benefit from
the use of Kanban diagrams as a way of visualizing the
work items as they flow from phase to phase.
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Tasks & Resources

In the life cycle of a project, there are various non-technical
tasks that are vital to the successful management and
completion of the project, such as allocation of resources
and allocation of time to the tasks and to meetings.
Enterprise Architect helps you as a project manager or as a
team member to record and monitor such tasks.

Facilities

Enterprise Architect provides a range of project
management facilities as described in this table.

Facility Description

Manage Resources are the people who work on a
Project project. You can assign roles and allocate
Resources tasks to them, which helps you to track

effort and estimate time to complete
tasks. You can also define the effort, risks
and metrics to support resource
management. You add, modify and delete
resources using the Resource Allocation
window.

The Project In Enterprise Architect, you can visualize

Gantt View clements and assigned project resources
easily in a Gantt Chart format, to review
the breakdown of work for a specific
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project and for specific sections of the
project. The Project Gantt View
illustrates a project schedule by showing
the start and finish dates of assigned
resources, so that you as Project Manager
can quickly see the current project status
using the percent-complete bar shading
and the percent-complete, resource name
and status columns. Information can be
filtered, and overdue items can quickly be
highlighted and identified. You can also
access specialized versions of the Project
Gantt View from diagrams, Packages and
the Personal Tasks list.

Project Task = A particular feature of the Project Gantt

Allocation View is the facility to review the
allocation of work to elements in the
project, focusing on either the elements
that require work, or the resources
required to perform the work.

Review Using the Personal Tasks view, each

Personal team member can record, review and

Tasks manage their personal work within the
project.

Project Enterprise Architect provides five

Management = specialized tabs in the Project Tools

(c) Sparx Systems 2026 Page 115 of 352



Project Build & Deploy 4 May, 2026

Windows window to help you to define each of the
management quantities associated with an
clement in the model, namely:

. Decisions - the choice made on a
requirement of the element

. Events - the action taken on a
requirement of the element

. Effort - the effort expended in work on
the element

. Risks - the risks associated with the
element, and

. Metrics - the metrics measured for an
element

Notes

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if User Security is enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation
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Project Resources

Resources are the people who work on a project. They can
be assigned roles and allocated tasks, which enables
tracking of effort and estimation of time to complete. You
also define the effort, risks, metrics, events and decisions to
support resource management.

You can also review and delete listed allocated resources
using the Resource Allocation window.

Access
Ribbon Construct > Resource Management >
Resources
Keyboard Select a Resource item on a diagram or
Shortcuts on the 'Details' tab of the Inspector
window, then press Shift+Enter
Uses
Use to

Allocate a resource to an element.
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Record additional project management information for an
element.

Obtain a report of resource allocation details.

Show Project Management information on elements in a
diagram.

Configure Project Management data and populate the
drop-down lists used on the tabs of the Project Tools
window.

Notes

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if User Security is enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation and to update and manage project
resources, effort, metrics, risks, decisions and events
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Resource Allocation

In developing a model, people (or resources) in a number of
roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements
(including Packages) in the model, planning and monitoring
the work that they do within the timeframe you have
allocated for that work to be completed. You can do this
using the Project Gantt View and/or Construct facilities.

The Resource Allocation window, displays a Gantt chart
that shows all of the resources assigned to a particular model
clement. As you select different model elements, the Gantt
chart updates to show the resources assigned to the selected
element. As you select an individual resource on the Gantt
chart, the Properties window and the Notes window (if
visible) will update to show the details for the selected
resource.

Access

Ribbon Construct > Resource Management >
Resources, or

Start > All Windows > Construct >
Resources > Resource Allocation

Create Resource Allocations
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New resource allocations are made using the 'Assign
Resources' dialog. To access the dialog, first select a model
element for which you wish to create resource allocations
and then, either:

. Click on the © button in the Resource Allocation
window toolbar, or

. Right-click on the Gantt Chart and choose the context
menu option 'Assign Resource...'.

Assign Resources Dialog

The 1nitial details for a resource allocation are entered using
the 'Assign Resources' dialog.

Assigned Resources o

Resource:

Role or Task:

Stat Date: 20211022 - End Date: 20211022 -

Close Help

This table describes the fields appearing on the dialog.
Field Action

Resource

Click on the drop-down arrow and click
on the name of the resource to assign to
work associated with the element.

To assign multiple resources at once,
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click on the browse button, then select the
resources to assign from the 'Select
Resources' dialog.

(You can type the name of the resource
into the 'Resource' field, as long as the
name is one of those defined in the
system; 1f it 1s not, the assignment will
not validate. As you type, the field
auto-fills with names matching the
characters that you have typed.)

Role or Task

Click on the drop-down arrow and click
on the required role of the resource in this
task. You cannot type a role into the field.

The field initially defaults to the first role
in the defined list; in subsequent
assignment entries, the role defaults to
the one posted for the immediately
previous assignment to this or any other

element.
Start Date

This field defaults to today's date.

If you want to assign a different start date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Left or Right
Arrow to select the previous or next
month.

3. Click on the appropriate day of the
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month as the start date.

The field immediately changes to the

selected date.
End Date

This field defaults to today's date.

If you want to assign a different end date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Right Arrow
to select the next month.

3. Click on the appropriate day of the
month as the end date.

The field immediately changes to the

selected date.
Save / Save & Close

To save the resource allocation you have
defined, click on one of the 'Save'
buttons.

If you intend to define further resource
allocations for the same model element,
click the Save button - the dialog will
remain open, ready for you to create
another allocation.

When you have finished creating
allocations for the selected model
element, click 'Save & Close' (or 'Close"),
to close the dialog.
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Modify Existing Resource Allocations

Existing resource allocations can be modified directly on the
Gantt chart, by dragging the start or end dates to a new
position on the time line, or by dragging the entire task to a

new position.

Resource Allocation
X H e

ﬂ“ Greg Nichaols

22
—
0 {—
# Frank Mclver 0 [ I—
(—
{—

# Ken Nielsen

4 »

The percentage completed can also be updated by clicking
on the value and dragging a slider (or using the left and right
arrow keys) to select a new value.

Resource Allocation
HXE a@

# Frank Mclver

|
[—
) [ —
# Greg Nichols 0 [—
[I—

# Ken Nielsen

»

4

If the Properties window is visible, the resource allocation's
properties can be updated there, by simply entering new
values. Similarly, if the Notes window is visible, entries for
Description and History can be updated directly in the Notes

window.
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Alternatively, you can use a dialog designed specifically for
this purpose.

To use the dialog, first select the model element for which to
modify resource allocations; then, in the Resource
Allocation window, double-click the allocation to be
modified, or right-click and choose the menu option 'Modify
Resource'.

Modify Resource Allocations Dialog

The 'Modify Resource Allocations' dialog, 1s used to update
the details of existing Resource Allocations.
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Role or Task: | Use Case Modeller

Allocated Time: 0

Time Expended: 0

Close Help

This table presents a detailed description of each field on the
'Modify Resource Allocations' dialog and how it 1s intended

to be used.
Field

Resource

Role or Task

(c) Sparx Systems 2026

Action

Click on the drop-down arrow and click
on the name of the resource to assign to
work associated with the element.

To assign multiple resources at once,
click on the browse button, then select the
resources to assign from the 'Assign
Resource' dialog.

(You can type the name of the resource
into the 'Resource’, as long as the name is
one of those defined in the system; if it 1s
not, the assignment will not validate. As
you type, the field auto-fills with names
matching the characters that you have

typed.)
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Click on the drop-down arrow and click
on the required role of the resource in this
task. You cannot type a role into the field.

The field initially defaults to the first role
in the defined list; in subsequent
assignment entries, the role defaults to
the one posted for the immediately
previous assignment to this or any other

element.

Description
Type (and, if you prefer, format) a
description of the work being done by the
resources.

History

As the task progresses, you add text to
this tab to record the activities, progress,
problems and outcomes of the task.

Expected Time

Type in the number of time units the task
is expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.
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Allocated Time

Complete %

Time Expended
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Apply the same units as used for the
'Allocated Time' and "Time Expended'
fields.

Type in the number of time units the task
can be spread over. (The value must be
an integer, so you cannot record part
units. )

The unit of time you adopt 1s by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Time Expended'
fields.

If the task is already in progress, type in
the current percentage completion.

(When the task is eventually 100%
complete, you will type in the number of
time units it actually took. The value
must be an integer, so you cannot record
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part units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Allocated Time'

fields.

Start Date

This field defaults to today's date.

If you want to assign a different start date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Left or Right
Arrow to select the previous or next
month.

3. Click on the appropriate day of the
month as the start date.

The field immediately changes to the

selected date.
End Date

This field defaults to today's date.
If you want to assign a different end date
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for the task:
1. Click on the drop-down arrow.

2. If necessary, click on the Right Arrow
to select the next month.

3. Click on the appropriate day of the
month as the end date.

The field immediately changes to the
selected date.

Notes

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if User Security 1s enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation

. If'you allocate resources to Use Cases, the information
you enter contributes to the Use Case Estimation
calculation for estimating the project size in terms of time,
resources and cost

. To edit existing Resource Allocation items for this
element, display the allocation in the 'Assigned Resources
dialog by either:

- Clicking on the 'Construct > Resource Management
> Resources' ribbon option, right-clicking on the required
item in the Resource

Allocation window and selecting the 'Modify
Selected' option

'
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- Double-clicking on the item in the Resources list in
the 'Details' tab of the Inspector window or

- Clicking on the item in the 'Element View' tab of the
Project Gantt Chart

. You can also edit an existing Resource Allocation using
the Properties window for that selected item; the fields
behave in the same way as those described 1n this topic

. To delete existing Resource Allocation items for an
element, click on the item in the Resource Allocation
window and click on * 1n the window toolbar
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Assign Multiple Resources

When you have a large unit of work associated with an
element - such as a Package element - you might want to
assign several resources to that element to perform that unit
of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of
them together in one operation, using the 'Assigned
Resources' dialog.

This dialog 1s also used to edit Resource Allocations entered
previously through either the same dialog or the Resource
Allocation window.

Assigned Resources =

Detal
Resource: - .. Fole ar Task:
Description | History
BIUM&- == %@
Start Date: 19/07/2027 = Expected Time: ] Allocated Time:
Resolve
EndDate:  19/07/2021 - Completes | D[ Time Expended: 0
Milestone
P Cloze Help

First, select an element, then:
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Ribbon Construct > Resource Management >
Gantt > Element View > right-click on
clement > Assign Resource

Other On the Resource Allocation window,
right-click on a resource assignment and
click on the 'Modify Selected' option

Assign Multiple Resources to an Element

Option Action

Resource (To assign a single resource, simply type
in the name or click on the drop-down
arrow and select the name from the list.
In Project Management, it is simpler to
assign single resources directly through
the Resource Allocation window.)

For multiple resources, on the 'Assigned
Resources' dialog, click on the [ button
on the 'Resource’ field to display the
'Assign Resource' dialog.

1. Select the checkbox against each
resource to assign to the element; to
select all resources listed, click on the
Select All button.

2. Click on the OK button to close the
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Role or Task

Description

History

Start Date
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dialog and to add the selected resources
to the 'Resource' field.

The 'Resource’ field now shows the
selected resources, but grayed out. The
drop-down arrow also is not active. To
change the resources in the field, click on
the [] button again and select/clear the
appropriate checkboxes.

Either:

. Type in the role name or task that is
common to all the selected resources,
or

. Click on the drop-down arrow and
click on the role that 1s common to all
the resources

Type (and, if you prefer, format) a
description of the work being done by the
resources.

As the task progresses, you add text to
this tab to record the activities, progress,
problems and outcomes of the task.

This field defaults to today's date.

If you want to assign a different start date
for the task:
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Expected
Time

Allocated
Time
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1. Click on the drop-down arrow.

2. If necessary, click on the Left or Right
Arrow to select the previous or next
montbh.

3. Click on the appropriate day of the
month as the start date.

The field immediately changes to the
selected date.

Type in the number of time units the task
1s expected to take. (The value must be an
integer, so you cannot record part units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Allocated Time' and 'Time Expended'
fields.

Type in the number of time units the task
can be spread over. (The value must be
an integer, so you cannot record part
units. )

The unit of time you adopt is by
agreement within the project, and
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depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Time Expended'
fields.

End Date This field defaults to today's date.

If you want to assign a different end date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Right Arrow
to select the next month.

3. Click on the appropriate day of the
month as the end date.

The field immediately changes to the
selected date.

Complete % | If the task is already in progress, type in
the current percentage completion.

Time (When the task is eventually 100%

Expended complete, you will type in the number of
time units it actually took. The value
must be an integer, so you cannot record
part units.)

(c) Sparx Systems 2026 Page 135 of 352



Project Build & Deploy

Milestone

Previous
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The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Allocated Time'
fields.

This checkbox and drop-down list allow
linking the end date to the date of a
Milestone element that 1s no more than
seven days old.

(Milestone elements form part of the
structures developed using the Project
Management Technology, which you can
activate by selecting the 'Start > All
Windows > Perspective > Construct >
Project Management' ribbon option.)

Click on the checkbox to activate the
field, then click on the drop-down arrow
and select the Milestone element from the
list.

Click on this button to display the
previous resource record in the sequence.
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Next Click on this button to display the next
resource record in the sequence.

New Click on this button to clear the fields on
the dialog so that you can define a new
resource allocation.

Apply Click on this button to apply the changes
to the currently-displayed element on a
diagram, without closing the dialog.

OK Click on this button to save the data you
have entered, and close the dialog.

Close Click on this button to discard the data
you have entered, and close the dialog.

Help Click on this button to display this Help
topic.

Notes

. When the resource details are displayed on the Project
Gantt Chart or Resource Allocation window, each
resource has their own record containing, initially, the
same data; however, each resource can be monitored and
their progress recorded separately
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. If you assign resources that are already in a multiple
resource assignment to the selected element, a prompt
displays for you to confirm that you are updating the
assignment of that resource, or now omitting that resource
from the existing assignment
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Effort Management

In Enterprise Architect, the Project Manager can allocate
effort (as time) to work on a given model element. To select
the element to which to allocate effort, click on the required
clement in the Browser window or a diagram.

Access
Ribbon Construct > Project Management > Effort
: right-click | Add New
Keyboard Select an Effort item on a diagram or on
Shortcuts the 'Details' tab of the Inspector window,

then press Shift+Enter

Enter effort allocation details for an element

Effort

Type the name or a brief description of
the effort.

Type
Type 1n the effort type or click on the
drop-down arrow and select the type. The
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selection list is drawn from the global

Effort Type list, but any new efforts you

type in this field are not added to the list.
Time

Type 1n the amount of time the effort is

expected to expend.

Notes

Type in any additional notes or
description of this effort.

OK

Click on this icon to save the data you
have entered and to add the entry to the
'Effort' list in the Effort window and the
'Details' tab of the Inspector window, and
close the dialog.

Cancel

Click on this button to discard the data
you have entered, and close the dialog.

Notes

. To edit existing Effort items for this element, display the
record in the Project Tools window by either:

- Clicking on the 'Construct > Project Management >
Effort' ribbon option and on the required item in the
'Effort' tab of the window, or

- Double-clicking on the item in the Project > Effort
list in the 'Details' tab of the Inspector window
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. To delete existing Effort items for an element, right-click
on the item in the 'Effort' tab of the Project Tools window
and click on the 'Delete' option

. Although Enterprise Architect does not currently provide
detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on effort information you enter
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Risk Management

In Enterprise Architect, the Project Manager can allocate the
possible weighting of defined risks that might impact work
on a given model element.

To select the element to which to allocate risk weightings,
click on that element in the Browser window or a diagram.

Access
Ribbon Construct > Project Management > Risks:
right-click | Add New
Keyboard Select a risk item on a diagram or
shortcut Element tab of the browser then use

Shift+Enter

Enter risk details for an element

Risk

Type the name or a brief description of
the risk.

Type

Type in the risk type or click on the
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drop-down arrow and select the type.

The selection list 1s drawn from the
global Risk Type list, but any new risks
you type in this field are not added to the
list. If there are no global risk types
defined, the drop-down arrow is not
displayed.

Weight
Defaults to the weighting for the defined
type. You can change this weighting 1f
necessary.

Notes

Type in any additional notes or
description of this risk. You can use the
Notes Toolbar at the top of the field to
format the text, if you prefer.

OK
Click on this icon to save the data you
have entered and to add the entry to the
Risk list in the Risk window and the
'Details' tab of the Inspector window, and
close the dialog.

Cancel
Click on this button to discard the data
you have entered, and close the dialog.

Notes
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. The risks described here are not the same as those
represented by Risk elements; the risks are properties of a
single element, whilst the Risk element represents
something that can impact a range of other elements

. If'you select a global risk type from the 'Type' drop-down
list and the associated "Weight' field 1s empty, the default
Weight value 1s allocated to the 'Weight' field on the
'Risks' tab

. To edit existing Risk items for this element, display the
record in the 'Risks' dialog by either:

- Clicking on the 'Construct > Project Management >
Risks' ribbon option and on the required item in the 'Risks'
tab of the Project Tools window, or

- Double-clicking on the item 1n the Project > Risk list
in the 'Details' tab of the Inspector window

. To delete existing Risk items for an element, right-click
on the item in the 'Risk’' tab of the Project Tools window
and click on the 'Delete' option

. Although Enterprise Architect does not currently provide
detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on risk information you enter
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Metrics

The Project Manager can allocate the possible weighting of
defined metrics to work on a given model element.

To select the element to which to allocate a metric
weighting, click on the required element in the Browser
window.

Access
Ribbon Construct > Project Management >
Metrics : right-click | Add New
Keyboard Select a metric item on a diagram or the
shortcut 'Details' tab of the Inspector window, and

press Shift+Enter

Enter metric details for an element

Field/Icon Description
Metric

Type the name or a brief description of
the metric.
Type

Type in the metric type or click on the
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drop-down arrow and select the type.

The selection list 1s drawn from the
global Metric Type list, but any new
metrics you type in this field are not
added to the list. If there are no global
metric types defined, the drop-down
arrow 1s not displayed.

Weight
Defaults to the weighting for the defined
type. You can change this weighting 1f
necessary.

Notes

Type in any additional notes or
description of this metric.

You can use the Notes Toolbar at the top
of the field to format the text, if you

prefer.
OK

Click on this button to save the data you
have entered and to add the entry to the
'Metrics' list in the Metrics window and
the 'Details' tab of the Inspector window,
and close the dialog.

Cancel

Click on this button to discard the data
you have entered, and close the dialog.
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Notes

. If'you select a global metric type from the 'Type'
drop-down list and the associated "'Weight' field is empty,
you can allocate the default Weight value in the "Weight'
field in the 'Metrics' dialog

. To edit existing Metric items for this element, display the
record in the 'Metrics' dialog by either:

- Clicking on the 'Construct > Project Management >
Metric' ribbon option and on the required item in the
Project Tools window, or

- Double-clicking on the item in the Project > Metrics
list in the 'Details' tab of the Inspector window

. To delete existing Metric items for an element, right-click
on the item in the Project Tools window or the 'Details'
tab and select the 'Delete' option

. Although Enterprise Architect does not currently provide
detailed reports on metrics within a model, you can use
the Automation Interface or similar tools to create your
own custom reports based on metric information you enter
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Show Project Items in a Diagram

When you have created a Project item (Decision, Event,
Effort, Risk, Metric), it 1s useful to make the record visible
on its parent element. You can do this by displaying the
record within a 'Project' compartment on the element as it
displays in a diagram. Any element that is capable of
displaying a compartment, and that has Project items
assigned to it, can show the items in a diagram.

Note that:

. An Event records the action taken for the current model
element

. A Decision records the choice taken for the current model
element

Show Project Items in Project Compartment

Step Action

1 Open a diagram containing the element
for which Project Items exist.

2 Double-click on the diagram background
to display the diagram properties dialog.
Click on the 'Elements' tab.

3 In the 'Show Compartments' panel, click
on the 'Project' checkbox.
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Click on the OK button.

Each Project Item now appears in the
Project compartment of the element on
the diagram. Items of each type are
grouped together so that, for example, all
Effort items on the element are grouped
under the heading 'Effort', and all Risk
items on the element are grouped under
the heading 'Risk’.

CCBookClientPanel
«SM_Activity»

+ CCBookClientPanel
+  GetBook: CBook

bookpanel(): CCBookPane
test scripts
Unit
Valid Inputs Pass
maintenance
[ssue
Run time MNew
Triggers New
project
Effort
Implement Coding
Test Coding
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Effort Types

When setting up the project management parameters for
monitoring work on elements, you can create types of effort
to add to the global list of effort types that can be assigned
to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays
in the '"Type' drop-down list on the 'Effort' page of the
Project Indicators window.

Access

Open the 'Project Indicators' dialog using one of the
methods outlined here, then select the 'Effort' tab.

Ribbon Settings > Reference Data > Model Types
> Project Indicators : Effort

Keyboard Select an Effort item on a diagram or the

shortcut 'Details' tab of the Inspector window,

then press Shift+Enter

Add a new effort type to the global list

Click the 'New' button to define a new Effort type
Option Action
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Effort

Description

Weight

<note>

Save

New

Delete

Close
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Type the name of the effort type. (Or, to
edit an existing effort type, click on the
effort name in the Defined Effort Types
panel.)

Type a short description of the effort
type.

Type the default weighting to apply to the
effort type.

Type any additional information on the
effort type.

Click on this button to save the changes
that you have made to the dialog.

Click on this button to clear the data
fields ready to define a new effort type.

Click on an entry in the Defined Effort
Types panel, and click on this button to
immediately delete the effort type.

Click on this button to close the 'Project

Indicators' dialog. If you have not saved

your changes, the system prompts you to
save or abort those changes.
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Notes

. Although Enterprise Architect does not currently provide
detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on effort information you enter

. You can transport effort types between models, using the
'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Metric Types

Enterprise Architect enables you to add a metric type to the
global list of metric types that can be assigned to any
element in the model. The global list of metric types
displays in the "Type' field drop-down list on the Metrics
window.

Access

Open the 'Project Indicators' dialog using one of the
methods outlined here, then select the 'Metric' tab.

Ribbon Settings > Reference Data > Model Types
> Project Indicators : Metric

Add a new metric type to the global list

Click the 'New' button to define a new Metric

Option Action

Metric Type @ Type the name of the metric type. (Or, to
edit an existing metric type, click on the
metric name in the Defined Metrics
panel.)

Description Type a short description of the metric
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type.

Type the default weighting to apply to the
metric type.

Type any additional information on the
metric type.

Click on this button to save the changes
that you have made to the dialog.

Click on this button to clear the data
fields ready to define a new metric type.

Click on an entry in the Defined Metrics
panel, and click on this button to
immediately delete the metric type.

Click on this button to close the 'Project

Indicators' dialog. If you have not saved

your changes, the system prompts you to
save or abort those changes.

. Although Enterprise Architect does not currently provide
detailed reports on metrics within a model, you can use
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the Automation Interface or similar tools to create your
own custom reports based on metric information you enter

. You can transport metric types between models, using the
'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Risk Types

Using Enterprise Architect you can add a risk type to the
global list of risk types that can be assigned to any element
in the model. The global list of risk types displays in the
"Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access

Open the Project Indicators window using one of the
methods outlined here, then select the 'Risk' page.

Ribbon Settings > Reference Data > Model Types
> Project Indicators : Risk

Add a new risk type to the global list

Click on the New button to define a new Risk

Option Action
Risk Type Type the name of the risk type. (Or, to
edit an existing risk type, click on the risk

name in the 'Defined Risks' panel.)

Description Type a short description of the risk type.
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Type the default weighting to apply to the
risk type.

Type any additional information on the
risk type.

Click on this button to save the changes
that you have made to the dialog.

Click on this button to clear the data
fields ready to define a new risk type.

Click on an entry in the 'Defined Risks'
panel, and click on this button to
immediately delete the risk type.

Click on this button to close the 'Project

Indicators' dialog. If you have not saved

your changes, the system prompts you to
save or abort those changes.

. Although Enterprise Architect does not currently provide
detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on risk information you enter
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. You can transport risk types between models, using the
'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Project Task Allocation

Using the Project Gantt View, you can review the allocation
of work to elements in the project, focusing on either the
elements that require work, or the resources required to
perform the work. The view primarily shows information
that 1s entered through other windows and dialogs, but once
a record exists in the view you can edit it and, for example,
add to or change the resources on an element.

Access

Ribbon Construct > Resource Management >
Gantt
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The Project Gantt View

In Enterprise Architect, you can visualize elements and
assigned project resources in a Gantt Chart format, to review
the breakdown of work for a specific project and for specific
sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of
assigned resources, so that a Project Manager can quickly
see the current project status using the percent-complete bar
shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can
quickly be highlighted and identified.

You can also access specialized versions of the Project
Gantt View from diagrams, Packages and the Personal
Tasks list.

Access

Ribbon Construct > Resource Management >
Gantt > Project Gantt View

Project Gantt View

This example shows four resources, two of whom are
working in different capacities on one task, and two on
another task. The resource names and roles are listed in the
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left panel of the chart, together with the actual percentage
completion of each person's work on the task. In the right
panel of the chart, completed work 1s indicated by the green
section of the bar, work yet to be completed but not yet due
is indicated in blue, and work not completed and overdue is
indicated in red (as a result of the option to highlight
overdue work being applied).

(D start Page |34 Project Gantt View X

uuuuuuuuuu
eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee

Tabs of the Project Gantt View

The Project Gantt View has three tabs, the first two of which
use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements
having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)

View Detail
Resource When you initially open the Project Gantt
View View, it defaults to the 'Resource View'

tab, 1n which the focus is on the current
commitments of each allocated resource
in the project.
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Element The Element View lists the elements in

View the project that have resources assigned
to them, and the resources assigned to
cach element.

Report View = A Resource report shows how your
resources are deployed in your project,
displaying a list of all elements that have
resources allocated to them.

Project Gantt View Facilities

The facilities of the Project Gantt View are common to the
Resource and Element Views, and in some cases to all three
tabs, as described here.

Option Action

Display tasks = Right-click on the display and select the
for today option:

only, or for . 'Show Only Active Tasks for Today' -
another day to show only tasks that are in progress
only today

. 'Show Only Active Tasks for Other
Day' - to show only tasks that were in
progress on a specific day in the past,
or that are scheduled to be in progress
on a day in the future; a calendar dialog
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displays from which you select the day
to examine

Right-click on the element entry and
select the 'Show Element Properties'
option.

The "Properties’ dialog for the element
displays.

Right-click on the entry and select the
'Show Task Properties' option.

The 'Assigned Resources' dialog displays;
you can edit the details and, if necessary,
change the resource allocated to the
element.

(Also available in the Report View.)
Right-click on the entry and select either
of the context menu options:

. 'Show Element Resource Allocation

window' (if the window is closed or
hidden)

. 'Find Task in Element Resource
Allocation window' (if the window 1s
visible but showing the details of
another element)

The Resource Allocation window
displays, with the details of the selected
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entry shown in the fields and the other
resource allocations for the element listed
in the left-hand panel.

You can edit the details and, if necessary,
change the resource allocated to the
element.

Right-click on an element in the display,
and select the 'Assign Resource' option.

The 'Assigned Resources' dialog displays;
complete this as for the Resource
Allocation window.

By default, the Project Gantt View shows
periods of time in units of days of the
month, each date column being
approximately one centimetre wide.
Weekends have a darker fill color.

You can change the scale of the date
columns by clicking on the column
header, pressing Ctrl and rolling the
mouse wheel. As you do this:

. At one extreme the date columns
expand to approximately 2.5
centimetres, and the date header shows
the full date in dd/mm/yyyy format

. Rolling to the other extreme changes
the scale of the column from date
through week, labeled month,
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numbered month and labeled year to
numbered segments of a decade

This allows you to represent a wide range
of tasks on a single chart and to condense
or expand the view - in conjunction with
filters - to investigate the short term and
longer term work clearly.

Change the Y ou might want to make broad
duration of a = adjustments to the timeline of an event,

task, on the which you can easily do on the Project
Project Gantt = Gantt View itself. For example, the
View resource 1is 111, or another resource has

taken over other tasks that the resource
was allocated to. In neither case has the
task itself changed, but in the first case
the resource needs a longer elapsed time
in which to complete the task, and in the
second they have less other work to do
and can finish the task sooner.

To make these adjustments, you simply
drag the right end of the time bar further
or back along the chart. This changes the
task end date to wherever you drag the
time line to, and adjusts the division into
complete and incomplete/overdue work
to maintain the percentage completion
value. The work time allocated to the task
does not change.
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If you drag the left end of the time line,
this moves the whole line without
changing its length or proportions; you
are just indicating that the task started
earlier or later and will finish earlier or
later by the same amount of time.

A resource 1s likely to be allocated to
several tasks either simultaneously or
consecutively. In the Resource View the
tasks assigned to a resource are grouped
under the resource name, and a narrow
group bar displays in gray on the chart
against the name, spanning the period
from when work is scheduled to begin on
the first task to when work 1s scheduled
to finish on the final task.

Similarly, a body of work, represented by
an element, might involve several
resources starting and finishing at
different points. The resources are
grouped under the element name and the
group bar displays on the chart against
the element name, spanning the period
from when the first resource is scheduled
to start work to when the last resource is
scheduled to complete work on the task.

If any adjustments are made that impact
the initial start point or final completion
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point of the work, the end of the group
bar automatically adjusts. If any task or
resource in the group is overdue, the
group bar turns red to reflect that there is
a potential problem in the allocated work.

(This feature takes effect under your user
ID.)

Right-click on the window and select the
'Apply Element Status Filter' option.

The 'Excluded Status Types' dialog
displays; select the checkbox against one
or more statuses to exclude elements
having those statuses from the list.

You can select every checkbox at once by
clicking on the Select All button, and
clear all selections by clicking on the
Clear All button.

Click on the OK button to immediately
apply the filter, which stays in effect until
you specifically change it.

Right-click on the list and select the
'Show Filter Bar' option.

The Filter Bar displays underneath the
heading bar. Type a text string in the field
above a column to immediately filter the
list for entries that have the text string in
the values in that column.
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To delete a filter string altogether, click
on the blue cross at the right of the field.

If you no longer want to use the filter bar,
right-click on the list and select the 'Hide
Filter Bar' option.

Filter the The display default is to show current
display by tasks for which the end date has not yet
Start or occurred. Right-click on the list and
Completion select one of the options:

date . 'Include Completed Tasks Within the

Last ..." - to display incomplete tasks
and tasks completed only within the
specified period; you can set this period
to 7, 30 or 90 days, or you can include
all completed tasks, or hide all
completed tasks

. 'Include Future Tasks Starting in ..." - to
display current incomplete tasks and
completed tasks (depending on the
setting of the 'Include Completed Tasks
Within the Last ..." option) and future
tasks that have been recorded and are
due to start within the next period; you
can set this period to 7, 30 or 90 days,
or you can show all tasks that have
been recorded but are not yet due to
start
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Identify Right-click on the display and select the
overdue tasks @ 'Display Highlight For Overdue items'
option and one of its sub-options:
. 'Show in Red' - to display the
uncompleted percentage of the task

bars for overdue items on the Gantt
chart in red

. 'Show in Red to Current Date' - to
extend the task bars of the overdue
items to today's date, and display them
1n red

. 'None' - to cancel any overdue item
highlighting that has been set

Display Right-click on the display and select the
ONLY 'Show Overdue Items Only' option.

overdue tasks = The display shows only those items for
which the end date has passed but that are
not 100% complete. These items do not
have red highlighting.

Refresh the Right-click on the entry and select the
report 'Refresh' option.

The content of the display 1s refreshed
and collapsed to element or resource
level.

Reposition Right-click on the display and select the
the Project 'Go to | Auto Sync with Task End Date'
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option.

Whilst this option is selected (with a tick
next to 1t), whenever you click on an
allocation the display adjusts to show the
end date of the task in the center of the
chart.

Right-click on the entry and select the
required option:

. Go To | Task Start Date

. Go To | Task End Date

. Go To | Today's Date

The display shifts to put the required date
in the center of the chart.

(Also available in the Report View.)
Right-click on the element name and
select the 'Find in Project Browser'
option.

The area of the Browser window
containing the element 1s brought into
focus and expanded, and the element is

highlighted.

It 1s possible to send a Model Mail
directly from the Project Gantt View to a
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selected resource if the resource's Author
name matches their:

. Enterprise Architect security user ID
(Security has been enabled) or

. Their workstation login ID (Security
has not been enabled)

Right-click on the resource or one of their
activities and select the 'Post Model
Message' option. This opens a Model
Mail message addressed to the resource,
for you to complete and send.

Right-click on the tab and select the 'Save
Image to File' option.

The 'Save As Image' dialog displays, on
which you specify the file name, location
and graphics file type to save to.

Right-click on the tab and select the
'Copy Image to Clipboard' option.
You can paste the image from the
clipboard into your preferred graphics
application.

. Items 1n the list pane can be filtered; right-click on the
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column headings in the list pane to toggle the Filter Bar
between hidden or shown, or to edit the filter
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Resource View

The 'Resource View' tab shows the current commitments of
cach allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.

The display initially shows the resources and their overall
commitment; click on the 'plus-box' to the left of the name
of the resource to expand the entry to show the elements and
the allocation period for each element.

The display shows both complete allocations and those that
are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete
allocations one month after the end date. Tasks you can
perform include checking the:

. Dates on which specific resources or all resources are
currently allocated

. Elements to which each resource 1s allocated

. Dates on which a resource 1s allocated to work on a
specific element

. General progress of the resource in completing the work

. Specific details of the allocation of a resource to an
element and task or role

Access

Ribbon Construct > Resource Management >
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Gantt : Select the 'Resource View' tab
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Element View

The 'Element View' tab of the Project Gantt View lists the
clements in the project that have resources assigned to them.
It shows the resources assigned to each element as a list of
allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or
task 1s assigned but no specific resource has been identified.

The display initially shows the elements and their overall
resource commitment; click on the 'plus-box' to the left of
the name of the element to expand the entry to show the
resources and the allocation period for each resource. You
can then:

. Check the dates on which specific elements have
resources currently allocated

. Check which resources are currently allocated to an
clement

. Assign further resources to the element

. Check the dates on which a resource 1s allocated to work
on a specific element

. Check the general progress of the resource in completing
the work

. Check the specific details of the allocation of a resource to
an element and task or role

The display shows both complete allocations and those that
are still in progress; an internal filter hides completed
allocations two weeks after the end date.
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The 'Element View' complements the 'Resource View' and
'Personal Tasks View' of work allocation on the project.

Access
Ribbon Construct > Resource Management >
Gantt or
Design > Diagram > Views > Gantt View
Context Browser window | right-click on an open
Menu diagram | Switch View | Switch to Gantt

View
In diagram, right-click on background |
Switch View | Switch to Gantt View

Browser window | Right-click on
Package | Open Package in | Gantt View
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Report View

The Report View shows how your resources are deployed in

your project, displaying:

. A list of all elements that have resources allocated to
them, and the type of each element

. The resource allocated, and the role played by that
resource

. The start and end dates of the allocation

. The time allocated, expected and expended

. The percentage completion of the allocation

You can tailor the displayed information by:

. Hiding columns of information

. Grouping types of information

. Filtering the data by status

. Filtering the data by start date or end date

. Filtering any column to show only a specific value

Having displayed the information you require, you can print
it.

Access

Ribbon Construct > Resource Management >
Gantt : Select the 'Report View' tab
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Report View Options

Option Action

Run the Click on the first icon in the Report View
report toolbar (the rotating arrows).

The report results display.

If you have the report open for a while,
you can update the information; either:

. Run the report again or

. Right-click on the content and select
the 'Refresh' option

Adjust Drag and drop column headings into the
column sequence you require.
headings Right-click on the column headings and

select the 'Field Chooser' option, to add
or remove columns using the 'Field
Chooser' dialog.

Group entries = Right-click on the column headings and

by column select the 'Enable Group Box' option, to

heading cluster the report information according
to your preferred hierarchy of column
headings.
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Either:

. Click on the third toolbar icon from the
right (the spy glass), or

. Right-click on the column headings
and select the "Toggle Filter Bar' option

The filter field displays at the top of
every column.

Type in whatever text string you require
in the appropriate column to filter the
report to show only entries containing
that text string in that column.

In the first field in the toolbar, click on
the drop-down arrow and select one of
these values:

. 'All' - Display all entries regardless of
degree of completion

. 'Completed' - Display only those
entries where the allocation is 100%
completed

. 'Above cut-off' - Display only those
entries that are more than a certain
percentage complete

. 'Below cut-off' - Display only those
entries that are less than a certain
percentage complete

In the second field in the toolbar, either
type a threshold value or increment to the
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value using the up/down arrows, to set
the percentage completion for the
'Above/Below cut-off' options.

Click on the fourth toolbar icon from the
right (the funnel).

The 'Resource Filters' dialog displays.

In the 'Start Date' and/or 'End Date' field,
click on the drop-down arrow and select
the appropriate qualifier:

. 'After’

. 'Before’

. 'Equal To'
. 'Not Equals'

In the date fields, click on the checkbox
to activate the fields and either type in the
day, month and year or click on the
drop-down arrow to select the date from a
calendar.

The fields have an AND relationship; an
entry must satisfy both date criteria
before it 1s displayed.

Either:

. Click on the second toolbar icon from
the right (the printer) or

. Right-click on an entry in the report
and select the 'Print' option
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The 'Print' dialog displays, on which you
specify the printer to use and the
characteristics of the print job.
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Progress Bars

Progress bars are horizontal bands that show the degree of
completion of a task or process. They give a quick
indication of the current status of, for example, projects,
tasks or budgets, which can be useful for checking how
close a task or project is to completion or if a project is
coming close to hitting its total allowed budget.

Progress bars can be especially useful in large projects that
consist of multiple smaller projects, as you can display
within one element separate bars showing the degree of
completion of each sub-project and of the main project,
giving you an overview of progress at a single glance.
Separate elements within the diagram can contain further
progress bars for the metrics of the individual projects,
adding levels of detail that can, again, be assessed in a brief
review.

In Enterprise Architect, progress bars are implemented using
Tagged Values on elements. They are automatically added
to elements on a Kanban diagram or Construction diagram,
where progress or resource consumption are indicated.
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Using Progress Bars

You can add progress bars to any element that can show
compartments and that can display any numerical value
within a range, when displayed on a diagram.

Progress bars can be used to display things such as:
. The current progress of a task or project
. How much of project's budget has been used

By default a progress bar will display a value between 0 and
100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values
required.

This 1llustration shows an example of a default progress bar:

‘ Project Alpha ‘

Progress ‘

Creating a Progress Bar using a new Tagged
Value

Follow the steps below to display a progress bar within an
element, using a simple Tagged Value.

Ste | Action
p

1 | On adiagram, create an element that can display
compartments (such as a Requirement or Feature)
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and add a simple Tagged Value to it.

2 | From the 'Tags' tab of the Properties window open
the tag's notes and add 'Type=ProgressBar;'
(including the semi-colon) and then click on the OK

button.

Type=ProgressBar;

(You can add further options to the Tagged Value, as
described in the Additional Progress Bar Options
table.)

3 | Click on the element and either press Ctrl+Shift+Y
or right-click and select the 'Compartment Visibility'
option. The 'Compartment Visibility' dialog displays.

4 Select the '"Tags' checkbox in the 'Show Element
Compartments' panel, then click on the OK button.

The progress bar will now display on the element on
the diagram, with the Tagged Value name above the
bar.
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5 | Inthe 'Tags' tab of the Properties window, indicate
progress by typing a number between 1 and 100 into
the 'Value' field for the tag. On the diagram, the
appropriate length of the progress bar 1s filled in
green.

Creating a Progress Bar from the 'UML
Types' dialog

You can also define a progress bar Tagged Value from the
'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.

Ste | Action
p

1 | Select the 'Settings > Reference Data > UML Types'
ribbon option to display the 'UML Types' dialog and
click on the 'Tagged Value Types' tab.

2 | In the 'Tag Name' and 'Description' fields, type a
name and description for the Tagged Value. In the
'Detail' field type the option parameters and their
values for the Tagged Value. Click on the Save
button and on the Close button.
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E umL Types
Sterectypes
Tagged Valus Types
- Cardinality Values

Description: Current project completion

Defined Tag Types:

Type Description
Completion Current project completion

(The option parameters are described in the
Additional Progress Bar Options table.)

3 Select the 'Start > Application > Design > Properties'
ribbon option to open the Properties window (if it 1s
not already open) and select the 'Tags' tab.

On a diagram select an element, then on the '"Tags'
tab click on the @ (New Tagged Value) button.

In the 'Tag' field of the Tagged Value dialog, click
on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.

4 On the diagram, right-click on the element and select

the 'Compartment Visibility' option to display the
'Compartment Visibility' dialog.
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button.

5 | Select the 'Tags' checkbox and click on the OK

6 | On the 'Tags' tab, change the number 1n the value
field a few times, clicking off the field each time.
Notice the effect this has on the progress bar.

Creating a Progress Bar using the Custom

Drawn Element

Custom-drawn elements allow the use of the element's fill
color to represent the progress in the progress bar, so the
clement itself becomes the progress bar.

Progress Bar

Ta Progress Bar. Class Diagram

Tagged Value Note

Properties
=-# »

Element Tags

Class (Class1)

Progress

25

Type=ProgressBar;
FilElement=true;
FillClr=Green;
BorderClr=elementtext;

Is | Properties

Bel2l BB X | O &

Cancel

Help
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To display progress using the element's fill color as the
progress bar, setup a Tagged Value for the progress bar as
described in the previous sections, then add the following
line to the Tagged Value's Notes: FillElement =true; You
will also need to set the Diagram property "Appearance >
Custom Style", by placing a check against that property.

You can set the fill color, background color and border
color, by adding further parameters to the Notes of the
Tagged Value.

For example:

. FillClr=val;

. BackClr=val;
. BorderClr=val;

When setting the colours of a progress bar, 'val' can be
supplied in a variety of ways, such as:

. RGB(0,128,0);
. HSL(300, 50,86);
. #0OFF00;

Default web colour names such as AliceBlue, Green or
Khaki can also be used. Additionally, it is possible to use
the current fill, line, or text color of the element for the
properties mentioned above by using ‘elementfill’,
‘elementborder’, or ‘elementtext’.

For example:

. FillClr=elementfill;
. BorderClr=clementtext;
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Examples of Setting Colors When Displaying
Progress Using Element Fill Color

Example Tagged Value Note

Using Hex Type=ProgressBar;

Values FillElement=true;
FillClr=#2F4550;
BorderClr=#629677;
BackClr=#586F7C;

Using HSL,  Type=ProgressBar;

RGB and FillElement=true;
Default FillClr=hs1(210,100,97);
HTML

BorderClr=RGB(23,12,202);
BackClr=LightSeaGreen;

Colors

Using RGB Type=ProgressBar;
and Current  FillElement=true;

Element Fill - p101—rob(230,214,239);

and Border BorderClr=elementline;

colors

BackClr=elementfill;
Using the Type=ProgressBar;
current FillElement=true;

element fill
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FillClr=elementfill:s=-30:1=70:;
BorderClr=elementline;
BackClr=elementfill;

. In this example the current element fill
1s used for both the fill color of the
progress bar as well as the background
color. However, the fill color is
modified from the original element fill
to be less saturated (30% less) and
brighter (70% increased luminosity):

Additional Progress Bar Options

A default progress bar will show the Tagged Value name
and reflect values in the range 0-100. You can change the
range values 1f required, and display text to the right of the
bar if more information has to be provided. The background,
border and fill colors of the progress bar are, by default,
determined by the currently-applied inbuilt diagram theme.
However, you can apply your own colors to one of more of
these properties.

Add these parameters to the Notes field of the Tagged
Value, to enhance the progress bar.

Parameter Description

MinVal Use the MinVal option to set the lowest
allowed value to be represented on the
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progress bar.
. Syntax: MinVal=<number>;

A progress bar with the setting
MinVal=10; will start at 10. Values lower
than 10 will not be shown on it.

If a maximum value (MaxVal) has been
defined, the progress bar will show any
values between MinVal and MaxVal
(inclusive); otherwise, the maximum
value will default to MinVal + 100. So, 1f
MinVal=10, the progress bar can show
values between 10 and 110 (inclusive).

MaxVal Use the MaxVal option to set the highest
allowed value to be represented on the
progress bar.

. Syntax: MaxVal=<number>;

A progress bar with the setting
MaxVal=300; will show values up to and

including 300. Values higher than 300
will not be shown.

If a minimum value (MinVal) has been
set, the progress bar will show any values
between MinVal and MaxVal (inclusive);
otherwise the minimum value will default
to 0. So, 1f MaxVal=300 the progress bar
can show values between 0 and 300
(inclusive).
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Use the Text option to define additional

text to display on the right hand side of

the progress bar. The text might be a

resource name or the current take up of

the total allowed budget of a project.

. Syntax: Text=<text>; - displays the
defined text string, such as 'David
Brown's Tasks'

. Syntax: Text=#HValue#; - displays the
value of the progress bar Tagged
Value, such as '462' (where the Tagged
Value name itself might indicate the
type of value or unit)

. Syntax: Text=<text> #Value# <text>; -
displays the value of the progress bar
Tagged Value with text before and/or
after it, such as '$<value> of $100,000'

This illustration shows a number of
examples of using the Text option.

Project Alpha

[—— ] 150,000 / $300,000

Terry

$250,000 / $300,000

80% Complete

By default, progress bars in an element
display together in a separate
compartment from other types of Tagged

Page 193 of 352



Project Build & Deploy

(c) Sparx Systems 2026

4 May, 2026

Value (provided that the diagram and/or
clement 1s set to display tag
compartments).

When there are several progress bars on
an element, each relating to a different
factor of the project, it can become harder
to distinguish between them. In these
cases 1t 1s possible to set the progress bars
to display in specific compartments in
order to increase clarity. This also
provides an additional level of labeling.
So you might have an element relating to
costs, and two or more compartments that
indicate costs of different departments,
where the department name is reflected in
the compartment name. Or compartments
that each contain two or more progress
bars indicating, say, the costs and
percentage completion of tasks in each
department.

. Syntax: Compartment=<name>;

To add multiple progress bars to the same
compartment simply give the progress
bars the same compartment name.

This example shows the element from the
Text parameter example, but with the use
of compartments to aid in readability.

Page 194 of 352



Project Build & Deploy 4 May, 2026

Project Alpha

I —— ] $150,000 / $300,000

$250,000 / $300,000

Terry

BackClr Use the BackClr option to override the
color used for the unfilled portion of the
progress bar.

. Syntax: BackClr=<color>;

<color> can be one of a variety of values,
such as the RGB value rgh(198,198,198)
for a light gray color.

See the Progress Bar Color Options table
for a full list of available values when
setting colors.

FillClr Use the FillClr option to override the
color used for the filled portion of the
progress bar.

. Syntax: FillClr=<color>;
<color> can be one of a variety of

options, such as the hex value #0000ff for
a bright red.

See the Progress Bar Color Options table
for a full list of available values when
setting colors.
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Use the BorderClr option to override the
color that 1s drawn around the edges of
the progress bar.

. Syntax: BorderClr=<color>;

<color> can be one of a variety of
options, such as the keyword elementtext
to select the same color as the current
element's text color.

See the Progress Bar Color Options table
for a full list of available values when
setting colors.

The Requirement element 'REQO15 - Process Credit Card
Payment' 1s given a Tagged Value named 'Completion', with
a value of '66'.

Properties
d =-M

Element Tags

Completion

LR X Bi@

Requirement (REQ015 - Process Credit Card Payment)

4

In the Tagged Values Notes, we specify
"Type=ProgressBar;' along with display text and color

(c) Sparx Systems 2026
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settings.

Tagged Value Note

Type =ProgressBar; Text=#Value #% Complete;
FillCir=rgb(192,255,132); BackClr=rgh{255,128,128);|

0K Cancel Help

The result is the Progress Bar seen here:

m Al u T
REQO15 - Process Credit Card Payment E
C |eti d
ompletion
L 1 646% Complete Q

E All payments will be via credit card. All major
credit card types will be accepted and approval
time shall be less than 2 minutes except where

fraud checks fail.

Progress Bar Color Options

This table lists the different types of value that can be used
with the options BackClr, FillClr and BorderClr when
setting custom colors for a progress bar.

Value Description
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Using rgb values you can set the red,
green and blue color components to
create the color you require.

Example:

BackClr=rgb(46, 139, 87); //Sets the
unfilled portion of the progress bar to a
sea green color.

. The red, green and blue values each
have a range of 0 to 255

This option can be useful in conjunction
with the color pickers from the 'Layout’
tab as they give an RGB value for the
currently selected color.

Using hsl 1s very similar to using rgb.
Unlike rgb, however, it is easier to create
a lighter or darker version of the same
color by simply adjusting the luminosity,
or to increase or decrease the intensity of
the color by adjusting the saturation.

Example:

FillClr=hs1(197, 71, 73); //Sets the filled
portion of the progress bar to a sky blue
color.

. The hue value has a range of 0 to 360

. The saturation and luminosity values
cach have a range of 0 to 100
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Colors can also be defined using a hex
value.

Example:

BorderClr:#000000; //Sets the border
color of the progress bar to black.

. Hex values range from #000000 to
HETTT

It 1s also possible to use the standard web
color names when defining a color for
progress bars.

Example:

fillclr=aliceblue; //Sets the filled portion
of the progress bar to the standard color
'aliceblue’

. Enterprise Architect supports the 140
standard HTML color names.

Using ElementFill, ElementLine or
ElementText will set the color value to
the fill, line or text color of the
currently-selected element (that is,
ElementFill will apply the element's
current fill color).

Colors set this way can be further refined
by using the modifiers s=<value> and
I=<value> to modify the color's
saturation and luminosity, making the
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color assigned to the progress bar a
slightly altered version of the currently
selected element color.

These settings can be useful if the
element is expected to change color (such
as from the use of a Diagram Legend) to
keep the progress bars themed correctly
with the element.

Example:

backclr=elementfill:s=-10:1=20:; //Sets
the unfilled portion of the progress bar to
be the same as the element's fill color but
with a 10% decrease in the color's
saturation and a 20% increase in the
luminosity.

. s and I can be any value; however, the
results can vary depending on the
currently selected color (for example, a
luminosity increase of 20% might not
be as noticeable on a very light color
compared to a darker color)

none The none keyword 1s used to indicate that

no color should be applied to the selected
field.

Example:

borderClr=none; //Removes the border
from the progress bar.
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Progress Bars with MDG Technologies

Progress bars can also be created within MDG Technologies
to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks

Using the Personal Tasks view, you can record and manage
your personal work within the project. This view displays
information based upon your identity as a defined Author on
the project.

Access
Ribbon Start > Personal > My Gantt
Work Category

Category Detail

Allocated Presents a Gantt chart on which you
Work record the work that you are currently
engaged in.

Project Tasks = Enables you to monitor and maintain the
work tasks that have been assigned to
you, or that you have created yourself.
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Review Allocated Work

The 'Allocated Work' tab lists the elements to which your
model Author ID has been allocated as a resource, where
your Author ID 1s the same as:

. Your Enterprise Architect security user ID, if security has
been enabled, or

. Your workstation login ID if security has not been
enabled

For each element, the tab:

. In the left-hand panel lists the roles or tasks assigned to
you as a resource on that element, for which the
'Complete %' field value is less than "100'

. In the right hand panel displays a Gantt chart showing
your progress in performing each role or task

You can add further work items for an element through the
'Allocated Work' tab; however, you cannot delete any
records. A record 1s no longer listed when the 'Complete %'
field value 1s '100'".

You or your supervisors can also add records through the
Resource Allocation window.

Access

Ribbon Start > Personal > My Gantt > Allocated
Work
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Select Allocated Work options

Option Action

Review Double-click on the element name.
elemen‘F (Alternatively, right-click on the element
properties name and select the 'Show Element

Properties' option.)
The "Properties’ dialog for the element
displays; review the pages as required.

Review Double-click on the task item.
resource task  (Alternatively, either:
details

. Double-click on the progress bar for
the item on the Gantt chart, or

. Right-click on the task or role name
and select the 'Show Task Properties'
option)

The 'Assigned Resources' dialog displays,

which has the same content, format and

functions as the Resource Allocation
window, in 'Item' mode.

Should it be necessary to reassign the
1tem to another resource, click on the
drop-down arrow on the 'Resource’ field
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and select the appropriate 'Author ID';
when you save the changes, the item no
longer appears in the list of tasks
assigned to you.

Right-click on the element name and
select the 'Add Resource' option.

The 'Assigned Resources' dialog displays,
with your Author ID in the grayed-out
'Resource’ field.

Complete the dialog as for the Resource
Allocation window.

Your work item can be edited in a
number of places in Enterprise Architect,
such as the Project Task Allocation
window and the 'Resource Allocation'
tab; the element to which it is assigned
can be edited in these and many other
areas.

To refresh the display with any changes
made elsewhere, right-click on the
display and select the 'Refresh' option.

Right-click on the entry and select either
of the options:

. 'Show Element Resource Allocation

window' (if the window is closed or
hidden)
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. 'Find Task in Element Resource
Allocation window' (if the window is
visible but showing the details of
another element)

The Resource Allocation window
displays, with the details of the selected
entry shown in the fields and the other
resource allocations for the element listed
in the left-hand panel.

You can edit the details and, if necessary,
change the resource allocated to the
element.

Display tasks = Right-click on the display and select the
for today option:

only, or for . 'Show only Active tasks for today' - to
another day show only tasks that are in progress
only today

. 'Show only Active tasks for another
day' - to show only tasks that were in
progress on a specific day in the past,
or that are scheduled to be in progress
on a day in the future; a calendar dialog
displays from which you select the day

to examine
Filter the The display default is to show current
display by tasks for which the end date has not yet
Start or occurred. Right-click on the list and
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select one of the options:

. 'Include Completed Tasks Within the
Last ..." - to display incomplete tasks
and tasks completed only within the
last period; you can set this period to 7,
30 or 90 days, or you can include all
completed tasks, or hide all completed
tasks

. 'Include Future Tasks Starting in ..." - to
display current incomplete tasks and
completed tasks (depending on the
setting of the 'Include Completed Tasks
Within the Last ..." option) and future
tasks that have been recorded and are
due to start within the next period; you
can set this period to 7, 30 or 90 days,
or you can show all tasks that have
been recorded but are not yet due to
start

Right-click on the display and select the
'Display Highlight For Overdue items'
option and one of its sub-options:

. 'Show in Red' - to display the
uncompleted percentage of the task
bars for overdue items on the Gantt
chart in red

. 'Show in Red to Current Date' - to
extend the task bars of the overdue
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items to today's date, and display them
in red

. 'None' - to cancel any overdue item
highlighting that has been set

Right-click on the display and select the
'Show Overdue Items Only' option.

The display shows only those items for
which the end date has passed but that are
not 100% complete. These items do not
have red highlighting.

Right-click on either the element or the
work item and select the 'Find in Project
Browser' option.

The appropriate Package hierarchy
expands in the Browser window, and the
selected element is highlighted.

Right-click on the display and select the
'Go to | Auto Sync with Task End Date'
option.

Whilst this option is selected (with a tick
next to it), whenever you click on an
allocation in the 'Allocated Work' tab the
display adjusts to show the end date of
the task in the center of the chart.

Some items might operate over a long
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hidden period of time, and you might not be able
sections of to display the complete progress line for
the work item | the item in the Gantt chart.

Progress To locate the start point, expected end

point, or today's date on the progress line
for an item, right-click on either the item
or the progress line and select the
appropriate option:

. Go To | Task Start Date

. Go To | Task End Date

. Go To | Today's Date

The Gantt chart shifts left or right to
position the required point in the center of

the display.
Execute If scripts have been defined for analyzing
Scripts the task data, click on the 'Scripts' option

to display the list of script names. Click
on the appropriate name to execute the
script on the selected item or items.

Filter the Y ou can refine the list of work items to
work items show only those containing text that
matches the filter item.

Right-click on the tab and select the
'Show Filter Bar' option.

The filter bar displays at the top of the
panel; type in the filter text.
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As you type, the items listed and the
Gantt chart are filtered to show only
items where the item names match the
text string.

The filter does not operate on the element
names.

If you do not want to use the filter,
right-click on the tab and select the 'Hide
Filter Bar' option.

Right-click on the tab and select the 'Save
Image to File' option.

The 'Save As Image' dialog displays, on
which you specify the file name, location
and graphics file type to save to.

Right-click on the tab and select the
'Copy Image to Clipboard' option.

You can paste the image from the
clipboard into your preferred graphics
application.
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Monitor Your Tasks

The "Project Tasks' tab lists the tasks that you either:
« Own, or
. Are assigned to

You can use the tab to review the status and progress of
tasks that you are responsible for, and to modify and filter
the display of task information. You can create the tasks
through the:

. 'Project Tasks' tab of the My Gantt display itself

. The Project Management Project Tasks view (of all tasks
in the project), or the

. 'Project Tasks view of the Resource Calendar

Access

Ribbon Start > Personal > My Gantt > Project
Tasks

Make selections from the options

Option Action

Add or You add or modify a task through the

(c) Sparx Systems 2026 Page 211 of 352



Project Build & Deploy 4 May, 2026

Modify a task = 'Task Detail' dialog, which displays when
you double-click on an entry (edit) or
blank line (create).

Delete a task = Right-click on the message and select the
'Delete’ option.

You are prompted to confirm the

deletion.
Select Right-click on the column headings and
columns select the 'Field Chooser' option, which

enables you to add or remove specific
columns from the display.

You can also click on the column
headings and drag them across the header
bar to reposition the columns in a
different sequence.

Reorganize Either:
t§ISkS in the . Click on the column heading and click
list on the arrow head to list items 1n order

or reverse order, or

. Right-click on the column headings
and select the 'Enable Group Box'
option to organize the messages into
groups

You can also use the filter bar to filter the

display on an appropriate column value,

such as the value 'New' in the 'Status'
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column; to display or hide the filter bar,
right-click on the column headings and
select the '"Toggle Filter Bar' option.

Set persistent | Right-click on the tab and select the 'Set
Status filter term filter' option.
The 'Filter by Status' dialog displays,
which enables you to select to list tasks of
any status or only of one specific status.

The filter you set persists when you close
the Personal Tasks window or exit from
Enterprise Architect.

Print the task = Right-click on the tab and select the 'Print
list List' option.
The 'Print' dialog displays, on which you
specify the local printer and the print
characteristics.
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Project Tools Window

The Project Tools window shows the records of these
quantities associated with an element contained in the
model:

Decision - a choice made on a requirement of the element

Event - an action taken on a requirement of the element

Issue - a failure of the element to meet a requirement

Task - an item of work on the element assigned to a
resource to meet a requirement

Effort - effort expended in work on the element

Risks - risk associated with the element

Metrics - metrics measured for an element

A separate tab of the Project Tools window or - for Issues
and Tasks - report list displays for each of these quantities.

Access

Ribbon

Construct > Project Management and as

required, one of:
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> Events | Show Events Window
> Decisions | Show Decisions Window
> [ssues-Tasks | Project Tasks

> [ssues-Tasks | Project Issues
> Effort
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. > Risks
. > Metrics

Click on the required Project item on a
diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Context Menu Options

You can add or delete individual items in any of the tabs of
the Project Tools window, using the window context menu

options.

Icon

Add New

Modify
Selected
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Action

Create a new Decision/Event item, using
the '<type> details for <element type>
<element name>' dialog, in the same way
as you create Maintenance items.

Create a new Risk/Metric/Effort item,
using the '<type>' dialog.

Update the selected Decision/Event item,
using the '<type> details for <element
type> <element name>' dialog.

Update the selected Risk/Metric/Effort
item, using the '<type>' dialog.
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Create as Create a new element based on the

New Element | Project Decision/Event item, in the same
way as you generate elements from
Maintenance items.

Print List Print the list of items.
Delete Delete the selected item from the list.
Notes

. Click on an element in the Browser window to switch to
the project management items for that element in the
Project Tools window

. Columns in the item list can be reorganized, added,
removed, grouped, filtered and sorted using the options
provided 1n the List Header facilities

. Right-click on the list to view the context menu, which
you can use to also add and delete items in the window

. You can move Decision and Event items between
elements; see the Move Decisions/Events Between
Elements Help topic
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Move Decisions/Events Between
Elements

A Decision or Event you define for one element might be
usefully moved to another if, for example, you are moving
your model through stages in a lifecycle or, indeed,
modeling a lifecycle. It is possible to simply drag a Decision
or Event from either the appropriate tab of the Project Tools
window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access

From the Browser window, open the diagram containing the
target element, then click on the element from which to
move the Decision or Event. It is convenient to have both
source and target elements on the same diagram, but it is
possible to select the source element in the Browser window
or on a different open diagram.

It 1s also convenient to have compartments enabled on the
target element, with the 'project’ compartment selected, so
that you can observe the addition of the moved item.
(Right-click on the element and select 'Compartment
Visibility', then select the 'Project' checkbox.)

Ribbon Start > Application > Design > Browser >
Element - expand the 'Project' category
or

(c) Sparx Systems 2026 Page 217 of 352



Project Build & Deploy 4 May, 2026

Construct > Project Management >
Decisions > Show Decisions Window

Construct > Project Management >
Events > Show Events Window

Keyboard Alt+2 | Project > Decisions or > Events
Shortcuts

Move the Decision or Event to the Target
Element

Click on the item that you intend to move, and simply drag
it onto the target element. The item name will display in the
'project' compartment of that element. What you would
observe might resemble this illustration.

Stage 1 Stage 2

project
Decision
Change Conveyor Mew
Event
Ering conveyor online Mew

(]

Stage 1 Stage 2

project
Decision
Change Conveyor Mew

Event
Ering conveyor online Mew

[
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Testing & QA

It 1s important in any project to perform quality control of
both the process and the output of the project; Enterprise
Architect provides several facilities for testing and
validating your model structure and content, including
Integration with the unit testing tools JUnit and NUnit.

Facilities
Facility Description
Testing Create and manage test scripts for model
=) clements. Explore the Testing user
= interface, supporting unit, integration,

scenario, system, acceptance and
inspection tests.

Model Check UML elements, diagrams or
Validation = Packages against known UML rules

| (identified in configuring validation) and

| constraints defined within the model,
using the Object Constraint Language
(OCL). Define your own checks against
custom rules and constraints. See the
Model Validation Help topic for more
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information on setting up model
validation rules.

Testpoint Pass or fail application tasks, viewing test
Management | results in real time as the program
- executes and results are saved. See the
. N Help section on Testpoints for more
information on setting up and running
automated tests.
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Test Management

il

> -
oo

Enterprise Architect 1s not only a UML Modeling
environment, it is also a complete Test Management
environment. Using Enterprise Architect you can create and
manage test scripts for model elements, developing unit,
integration, scenario, system, acceptance and inspection
tests; these can include test cases generated from xUnit
testing and Testpoint Management.

You can also import or move tests from other elements,
generate them from scenarios, and generate test
documentation and reports; you can indicate the presence of
tests on an element by displaying test information in a
compartment of the element in a diagram.

It 1s simple to attach even complex tests to any model
element. Keeping the model elements and the testing
documentation in one integrated model significantly
improves the communication between the test-team and the
software developers and architects.

The system's detailed search facilities make it easy to find
failing test cases, test cases not run and test cases that have
been passed; using the testing and search capabilities, it 1s
easy to navigate through the model and quickly locate
problem spots, design flaws and other critical issues.
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Detail

You initially create tests in either the
"Test Details' dialog or the Test Cases
window.

Typically, you create:

Unit tests for things that are being built,
such as Classes and components

Integration tests to test how
components work together

System tests to ensure the system meets
business requirements

Acceptance tests to test user
satisfaction

Scenario tests to test the end-to-end
suitability and functionality of the
application

Inspection tests for peer review of
things that are being built using a well
defined process

These test categories are otherwise
referred to as test Classes.

There 1s also a 'Full Test Suite' tab that
displays a read-only list of all the Test
items on the element, grouped by type. If
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you double-click on an item in this list,
the appropriate tab displays with the item
highlighted.

Tasks that you might perform via the Test
Cases window when working with tests
include:

. Create and edit test records

. Import a scenario from an element or a
Package as a test

. Import an internal requirement or
constraint as a test

. Import a test from another element
. Create a maintenance item from a test
. Move or copy tests between test classes

. Move a test from one element to
another

. Print the list of tests of the current test
class for the element

. Delete the test

. Most of the listed tasks relate to a tests for a single

element

. You can display the Test Cases window for an element on

(c) Sparx Systems 2026
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a diagram, by clicking on the element and pressing the T
key

. You can make a set of tests available to a number of
elements by performing the listed tasks on a Test Case
element and then associating that Test Case with each of
the other elements; the Test Case element also helps to
make tests more visible in diagrams, the Browser window,
windows and searches
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Create Test Records

When you need to create or edit a test record on an element,
for any of the six types of test, you can do so using either:

. The Test Cases window (to quickly set up or change test
records, and perform operations on them)

. The 'Test Details' dialog (To create test records with more
Notes information, which you can also add through the
Notes window)

. The Properties window for Test items (to edit the
properties of existing tests - see the Properties Window
for Test Items Help topic)

Whichever type of test you are recording, you complete
effectively the same fields.

Access
Ribbon Construct > Test Management > Tests >
<test class> : overtype Add new
<testtype> (Test Cases window)
Keyboard Click on the element : Alt+2 > Testing :
Shortcuts <test class> : overtype Add new

<testtype> (Test Cases window)

Click on the element on a diagram | Press
the T key (Test Cases window)
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Other

On the Test Cases window, double-click
on the Test item to display the '"Test
details' dialog

Create a Test Record in the Test details
Dialog

Test details
Test
Test Ignition Use Case
Ao
Description | Input  Acceptance Criteria  Results
B/ UM- iZ= %@
Clean test run
Clazs; I ik = Type: Standard o
Fiun
Run Date: 16072021 A Fiun By Hugh Lod -
Rezult: Pass - Checked By: Jane Ward -
| L || Fr | = | Apply | | k. | | Cloze || Help
Field/Button | Action
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Test Type the name of the test. This can be
any alphanumeric text string you want to
use.

Auto As an alternative to typing in the name,

click on this button to insert predefined
auto-counter text; if you do not have
auto-counter text configured, an
information message displays.

If you already have some text in the "Test'
field, it 1s over-written by the
auto-counter text.

Class This defaults to the class of test you
selected in displaying the dialog. If this 1s
not the class you require, click on the
drop-down arrow and select the
appropriate value.

Type Click on the drop-down arrow and select
the value indicating the type of test
(Load, Regression or Standard). You
cannot type in any alternative types.

Run Date Click on the check box and then on the
drop-down arrow and select the date on
which the test 1s to be run (or when 1t was
last run).

(c) Sparx Systems 2026 Page 228 of 352



Project Build & Deploy 4 May, 2026

Run By Click on the drop-down arrow and select
the name of the person who is to run, or
has run, the test. The list selection
defaults to your name as the current user.

(Possible values are derived from the
Project Author definitions in the 'People’
dialog - select the 'Settings > Reference
Data > Model Types > People > Project
Authors' ribbon option.)

Result Click on the drop-down arrow and select
the value indicating the current status of
the test (Not Run, Pass, Fail, Deferred or
Canceled). You cannot type in any
alternative values.

Checked By  If you have provided a Run date, when
you click on this field it defaults to your
user name as the current user.

If you have not provided a Run Date,
click on the drop-down arrow; the list
selection defaults to your user name as
the current user.

If you are not the person who is to check,
or has checked, the results of the test,
scroll to and select the name of the
relevant person .
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Type a description of the test; you can
format the text using the Notes toolbar at
the top of the field. The text you type
here 1s also shown in the Notes window,
under the 'Description’ heading.

Type in the input data provided to the
test; you can format the text using the
Notes toolbar at the top of the field. The
text you type here is also shown in the
Notes window, under the 'Input' heading.

Type the acceptance or test success
conditions; you can format the text using
the Notes toolbar at the top of the field.
The text you type here is also shown in
the Notes window, under the 'Acceptance
Criteria' heading.

Type the results of the last test; you can
format the text using the Notes toolbar at
the top of the field. The text you type
here 1s also shown in the Notes window,
under the 'Results' heading.

Click on this button to save the data you
have entered and to add the entry to the
Test Cases window and the Browser
window, keeping the 'Test details' dialog
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OK Click on this button to save all new data
and close the 'Test details' dialog.
New Click on this button to clear the data entry

fields ready for defining another test.

left If there are existing tests, click on these
chevron/right = buttons to display the details of the
chevron previous test or next test in the sequence.
Close Click on this button to discard all

unsaved data and close the dialog.

Create a Test Record in the Test Cases
Window

Test Cases

Test Status - Type Run By Checked By Description Run Date
Test Ignition Use Case Pass Standard Hugh Loyd lane Ward Clean test run 16/07/2021

Depending on your screen width and the fields you have
exposed in the Test Cases window using the 'Field Chooser'
dialog, you might need to scroll the window left and right to
see all fields. As it is possible to change the sequence of
fields across the window, the fields might not be in the order

as documented.
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Field/Button | Action

Test

Status

Type

Run By

Checked By

Description
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Overtype the Add new <test type> text
with the name of the new test.

Click on the field and on the drop-down
arrow, and select the appropriate status.

Click on the drop-down arrow and select
the appropriate test type - Load,
Regression or Standard.

Click on the drop-down arrow and select
the name of the person who ran - or will
run - the test.

You can also start typing the name of the
person, until the auto-complete facility
fills in the rest of the name.

Click on the drop-down arrow and select
the name of the person who checked - or
will check - the results of the test.

You can also start typing the name of the
person, until the auto-complete facility
fills 1n the rest of the name.

Type 1n a short description or explanation
of the test.
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Run Date Type in the date on which the test was
last executed, in dd/mm/yyyy format.

Notes

. To delete an item, right-click on it in the Test Cases
window and click on the 'Delete' option in the context
menu; in response to the confirmation prompt, click on
the Yes button

. A further possibility for generating and editing Test items
is to right-click on the Testing category in the 'Details' tab
of the Inspector window - or the required item within the
list - and select menu options to perform the required
operation

. To change the element for which to create or edit Test
items, click on the element in a diagram or the 'Project'
tab of the Browser window

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete Test
records
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Show Test Script Compartments

When you have created a Test record, it is useful to make
the test visible on its parent element. You can do this by
displaying the test within a Test Script compartment on the
element as it displays in a diagram. Any element that 1s
capable of displaying a compartment, and that has a test
assigned to it, can show test scripts in a diagram.

Show the Test Scripts on an Element in a
Diagram

Ste Action
p

1 | Open a diagram containing the element with the
attached test items.

2 Double-click on the diagram background to display
the diagram 'Properties' dialog.
Click on the 'Elements' tab.

3 | Inthe 'Show Compartments' panel, select the
"Testing' checkbox.

4 Click on the OK button to save the setting.

Each test item now appears in the fest scripts
compartment of the diagram element. Items of each
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type are grouped together so that, for example, all
Unit tests on the element are grouped under the

heading 'Unit', and all Integration tests on the

element are grouped under the heading 'Integration’.

If you click on a test item, and the Notes window
and/or Test Cases window are open, the test details

are immediately displayed in them. If you

double-click on the item, the "Test details' dialog

opens, showing the details of that test.

Example

CCBookClientPanel

«5SM_Activity»
+ CCBookClientPanel
+ GetBook: CBook

~  bookpanel(): CCBookPanel

test scripts

Unit

Valid Inputs Pass
Integration

Pass on output Mot Run

maintenance

Issue

Run time New

Triggers New
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Properties Window for Test Items

When the Properties window is open, it displays the
properties of the selected object or assigned item, including
a Test record for an element. You might select the Test in
the Test Cases window, the test scripts compartment of an
element on a diagram, or in the 'Details' tab of the Inspector
window.

The Properties window identifies the test class of the test
just under the toolbar, and shows the current values for the:

. Test name

. Test type

. Run date

. Result

. 'Run by' user, and
. 'Check by' user

You can change the value for each of these fields (except for
the 'Test' field), clicking on the drop-down arrow and
selecting a new value. For the 'Run by' and 'Check by' fields,
you can also start typing in the user name until the
autocomplete facility provides the rest of the name.

For the 'Test' field, you can either overtype the test name or
click on the [/ icon and apply any autonaming convention
you have configured for test items.

The toolbar options operate on the parent element for the
test. Any changes you make are automatically saved and
displayed elsewhere when you click off the field.
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Move or Copy Tests Between Test
Classes

After you define a test within one test class (Unit,
Integration, System, Acceptance, Inspection or Scenario),
you might decide that the test either is better suited to
another test class, or forms a good template for tests in other
classes. If so, you can either move or copy the test to the
other class lists.

Access

Click on the element containing the test records.

Ribbon Construct > Test Management > Tests >
<test class> > Right-click on test to
move/copy
Start > All Windows > Construct >
Testing > <test category> > Right-click

on test
Keyboard Alt+2 > Testing : right-click on test to
Shortcuts move/copy

Move or Copy a Test
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Ste | Action
p

1 | Click on the appropriate option - 'Move to' or 'Copy

'

to.
A list of test classes displays.

2 | Click on the test class to which to move or copy the
test.

A confirmatory prompt displays.

3 Click on the Yes button to confirm the move or
copy.

4 | In the Test Cases window, click on the tab for the
test class you moved/copied the test into, to check
that the Test has been added.

Double-click on the test to open the 'Test details'
dialog, and make any necessary changes to the Test
record.

5 | If'you are copying the test to more than one other
test class, repeat steps 1 to 4 for the next class to
copy to.

Notes
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. If you move or copy a test into the Scenario Tests class,
some unassociated data could be lost
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Create Maintenance Item From Test

If an element fails a test, one likely consequence is that a
Defect (Issue) item has to be raised in model maintenance to
correct the problem. You can generate this Defect item
directly from the test that failed.

Access

Select the element containing the failed test, then use one of
the methods outlined here to display the Test Cases window
or 'Details' tab of the Inspector window

Ribbon

Keyboard
Shortcuts

(c) Sparx Systems 2026

Construct > Test Management > Tests >
<test class> > Right-click on test > Create
a Maintenance Defect from this test

Start > All Windows > Construct >
Testing > <test class> > Right-click on
test > Create a Maintenance Defect from
this test

Design > Element > Properties > General
> Element Browser > Testing > <test
class> > Right-click on test > Create a
Maintenance Defect from this Test

Alt+2 > Testing : <test class> |

Right-click on test | Create a Maintenance
Defect from this Test
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Create a Maintenance Item from a Test

Ste Action

P

1

The system immediately creates the Defect item and
displays a confirmation message box.

Click on the OK button to clear the message.

Open the Defects window (the 'Construct > Change
Management > Defects > Show Defects Window'
ribbon option).

The window shows a Defect item having the same
name as the test.

Double-click on the Defect item to open it in the
'Defect details' dialog, and edit the item as necessary
- you might provide values for the 'Reported By',
'Status' and 'Priority’ fields.
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Move Tests Between Elements

A test you define for one element might be usefully moved
to another if, for example, you are moving your model
through stages in a lifecycle or, indeed, modeling a
lifecycle. It 1s possible to simply drag a test of any class and
type from either the appropriate tab of the Test Cases
window or the 'Details' tab of the Inspector window, onto a
different element on a diagram.

Access

From the Browser window, open the diagram containing the
target element, then click on the element from which to
move the tests. It is convenient to have both source and
target elements on the same diagram, but it 1s possible to
select the source element in the Browser window or on a
different open diagram.

It 1s also convenient to have compartments enabled on the
target element, with the Testing (test scripts) compartment
selected, so that you can observe the addition of the moved
test. (Right-click on the element and select 'Compartment
Visibility', then select the "Testing' checkbox.)

Ribbon Start > Application > Design > Browser >
Element - expand the 'Testing' category
or

Construct > Test Management > Tests |
<Test class>
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Keyboard Alt+2 | Testing > <test class> tab
Shortcuts Click on the source element on a diagram
T

Move the Test to the Target Element

Click on the test that you intend to move, and simply drag it
onto the target element. The test name will display 1n the
'test scripts' compartment of that element. What you would
observe might resemble this illustration.

Stage 1 Stage 2

test scripts
Unit
UTLinkage Mot Run

System
Table integration Pass

[

Stage 1 Stage 2
test scripts test scripts
System Uinit
Table integration Pass UTLinkage Mot Run

I

(c) Sparx Systems 2026 Page 244 of 352



Project Build & Deploy 4 May, 2026

Import Test From Other Elements

If you have created useful tests in one element, you can
import those tests into any other element through the Test
Cases window or 'Details' tab of the Inspector window, and
so avoid having to duplicate the test information manually.
You open the Test Cases window for the empty target
element and then select the source element that contains the
tests to import.

Access

Select target element, then:

Ribbon Construct > Test Management > Tests >
<test class> | Right-click on test list |
Import Test from other Element (s)

Start > All Windows > Construct >
Testing > <test class> > Right-click on
test list | Import Test from other
Element(s)

Keyboard Alt+2 > Testing | Right-click on test list |
Shortcuts Import Test from other Element(s) or

Alt+9 : Testing > <test class> >
Right-click > Import Test from other
Element(s)
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Import a Test

The 'Import Element Tests' dialog displays.

Field/Button | Action
Select Click on the drop-down arrow and locate
element and select the source element.
This list identifies elements that have
tests that can be imported.
Show related = Select this checkbox to restrict the list of
elements selectable elements to those that are
only related to the target element.
Limit If you want to restrict the list of
selection to selectable elements to only those of
these Object | specific types, type in those element
Types only types in a comma-separated list.
Refresh Click on this button after changing any of

Select items
to import

(c) Sparx Systems 2026

the field values, to refresh the list of

available elements in the 'Select element'
field.

Lists the tests defined in the source
clement. Select the test(s) to import.

If you have not used the 'Select element'
field, any tests listed are from the current
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clement to which this test record belongs.
There 1s no purpose in importing these.

Import As Defaults to the test class of the Test you
selected to populate from the other
element. If you need to change this, click
on the drop-down arrow and select a
different test class from the list.

All Click on this button to select all tests
listed in the 'Select items to import' field.

None Click on this button to clear the selection
of tests listed in the 'Select items to
import' field.

Import Click on this button to import the selected
test(s).

Notes

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test
records
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Import Scenario as Test

If you are creating a test for a scenario from either a single
element or many elements in a Package, you do not have to
manually re-type the scenario details into the test record.
You can generate the test into the 'Scenario Tests' class of
one element from one or more scenarios in any element in
the model.

Within the Scenario Test record, the scenario description i1s
copied to the 'Description' tab. If a scenario contains a
specification, its Action steps are also copied to the
'Description’ tab under the heading 'Structured
Specification'.

Access

Click on the element containing the test records, and use one
of the methods identified here to display the 'Import
Scenario' dialog.

Ribbon Construct > Test Management > Tests >
<test class> > right-click on test list >
Import Element Scenario(s) or

Construct > Test Management > Tests >
<test class> > right-click on test list >
Import Package Scenario(s) or

Start > All Windows > Construct >
Testing > <test class> > right-click on
test list > Import Element Scenario(s)
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Start > All Windows > Construct >
Testing > <test class> > right-click on
test list > Import Package Scenario(s)

Keyboard Alt+2 > Testing : right-click on test list |
Shortcuts Import Element Scenario(s) or
Alt+2 > Testing : right-click on test list |
Import Package Scenario(s)

Import a Scenario from a Single Element

Field/Button Action

Select If you are copying scenarios from a

element different element to the target element,
click on the drop-down arrow and select
the source element. The list identifies
clements that have scenarios that can be
imported.

Otherwise, leave this field blank.

Show related @ Select this checkbox to restrict the list of

elements selectable elements to those that are
only related to the target element.

Limit If you want to restrict the list of
selection to selectable elements to only those of

(c) Sparx Systems 2026 Page 249 of 352



Project Build & Deploy

these Object
Types only

Refresh

Select items
to import

Import As

All

None
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specific types, type in those element
types in a comma-separated list.

Click on this button after changing any of
the field values, to refresh the list of
available elements in the 'Select element'
field drop-down.

Lists the scenarios defined in the source
clement. Select the scenario(s) to import.

If you do not use the 'Select element'
field, any scenarios listed are from the
current element to which this test record
belongs.

If you have selected a different element,
the scenarios come from that element.

Defaults to the test class of the Test you
selected to populate from the scenario. If
you need to change this, click on the
drop-down arrow and select a different
test class from the list.

Click on this button to select all scenarios
listed 1n the 'Select items to import' field.

Click on this button to clear the selection
of scenarios listed in the 'Select items to
import' field.
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Import Click on this button to import the selected
scenario(s).

Import Scenarios from the Elements in a
Package

Field/Button | Action

Limit If you want to restrict the selected
selection to clements to only those of specific types,
these Object  enter those element types in a

Types only comma-separated list.

This version of the 'Import Scenario'
dialog lists all scenarios against all
elements in the Package; it does not
enable you to select a specific element,
but does enable you to filter the list of
scenarios to those from specific types of
element.

Refresh Click on this button after changing the
'Limit Selection...' field value, to refresh
the list of available elements in the 'Select
items to import' field.

Select Items Lists the scenarios defined in the selected
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to import elements in the Package. Select the
scenario(s) to import.

All Click on this button to select all scenarios
listed in the 'Select items to import' field.

Import As Defaults to the test class of the Test you
selected to populate from the scenario. If
you need to change this, click on the
drop-down arrow and select a different
test class from the list.

None Click on this button to clear the selection
of scenarios listed in the 'Select items to
import' field.

Import Click on this button to import the
scenarios from each element as Scenario
tests.

Notes

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test
records
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Import Requirement or Constraint as
Test

If you are creating a test against an internal requirement or
internal constraint of an element, you do not have to
manually re-type the details into the test record in the 'Test
details' dialog. You can generate a testing record on the
element from the requirement or constraint.

The test record 1s generated into the Test Cases window
under the currently-selected test class, and the requirement
or constraint description is copied to the 'Description' for the
test record.

Access

Select an element, then use one of the methods outlined here
to display the Test Cases window or 'Details' tab of the
Inspector window.

Ribbon Construct > Test Management > Tests >
<test class> > Right-click on test list >
Import Element Constraint(s) or
Import Element Requirement(s)

Start > All Windows > Construct >
Testing > <test class> > Right-click on
test list > Import Element Constraint(s)
or Import Element Requirement(s)

Design > Element > Properties > General
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> Element Browser > Testing > <test
class> > Right-click on test list > Import
Element Constraint(s) or Import
Element Requirement(s)

Alt+2 > Testing : <test class™> |
Right-click on test list | Import Element
Constraint(s) or Import Element
Requirement(s)

Alt+9 : Testing > <test class> >
Right-click > Import Element
Constraint(s) or Import Element
Requirement(s)

Import a Requirement or Constraint as a

Test

Ste Action
p

1 | On the 'Tmport Constraint' or 'Tmport Requirements'
dialog (the two dialogs are identical) review the list
of internal requirements or constraints in the selected

element.

2 | Click on one of the items to import as a Test, or
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press Ctrl+click on more than one to import several.

The 'Tmport As' field defaults to the test class of the
Test into which you are importing the requirement or
constraint details. If you need to change this, click
on the drop-down arrow and select a different test
class.

3 Click on the OK button.

Each item is added to the list of tests in the Test
Cases window, under the appropriate <test-type>, as
a standard, 'Not Run' test.

Double-click on one item to open the 'Test details'
dialog to edit the test details; thereafter, just click
once on the next test item to edit that in the 'Test
details' dialog.

Notes

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test
records
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Test Documentation

After you have recorded a number of test scripts and results
against elements in the model, you can output the
information as a report in Rich Text Format, using the
'Generate Test Documentation' dialog. You can select the
types of test to include or exclude in the report and whether
to include child Packages, and enter the file location to
which to generate the report.

Click on the Generate button to produce the report.

You can also run a number of searches to show the results -
where generated - of tests:

. Not Run

. Not Checked

. Recently run

. Recently Passed

. Recently Failed

. Recently Deferred

. Run on recently modified elements
. Run in the last week

. Run in the last 30 days

Access

Select a Package, then use the ribbon options:
Ribbon Construct > Testing > Outcomes >
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Report  (to display the 'Generate Test
Documentation' dialog)

Construct > Testing > Not Run
Construct > Testing > Not Checked

Construct > Testing > Outcomes >
<report type>
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Changes, Defects & Issues

p— S P /""N
/ IF .|L|i 4 i & 7

In the course of your team's work on a model, changes and
issues can arise at a number of levels, for problems that
apply system-wide through areas of the model and down to
within a specific element. A Change, very broadly, defines
an addition or alteration to a requirement, whilst an Issue
identifies either a failure to meet a requirement, or a risk in
meeting the requirement.

There are two mechanisms that can be used to identify a
change or issue, and the work required to resolve it:

. Change and Issue (or Defect) elements - structured
comments that identify a problem at system-level,
although they can also be attached to a specific element
from which a problem arises; both types of element can be
linked by relationships such as Association, Dependency
and Realize to one or more other elements that have to be
reviewed, and for complex problems can form hierarchies
or groups

. Maintenance items - properties raised against a specific
element and recorded for that element in the Maintenance
window; these provide a distinction between Defects (a
failure to meet a requirement) and Issues (a risk factor that
might affect satisfying the requirement) and also include
Tasks, which record work items associated with the
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clement

Maintenance items are very specific, but if an item begins
to have a wider impact on other elements or the system in
general, you can translate that item into a Change, Issue,
or any other type of element that best identifies the
problem and its solution

Maintenance items are defects, changes, issues, tasks,
features and documents that apply at the model element
level. They are properties of individual model elements that
can be used to record and capture problems, changes, issues
and tasks as they arise, and document the solution and
associated details.

Maintenance Tasks

Task Area Detail

Maintenance @ You create maintenance items in the
[tems - Maintenance window. Typically you
Element-leve @ create:

1 . A defect to record a failure to meet a
requirement for the current model
element

. A change to record a change in
requirement for the current model
element

. An 1ssue to record a risk factor that
might affect the project being recorded
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for the current model element

. A task to record work in progress and
work outstanding for the current model
clement

. A feature to record a feature in
requirement for the current model
element

. A document to record supporting
documentation such as Help, release
notes and user comments

Tasks that you might perform when
working with maintenance items include:

. Moving or copying maintenance items
between maintenance types

. Generating new items of one type from
an item of a different type

. Creating elements from maintenance
items

. Showing maintenance items on
elements in a diagram

. Adding a maintenance item directly to
an element via in-place editing

. Generating a report on the status of
maintenance items of specific types or
all types

To represent changes, defects and issues
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- that apply to the model you can create
System-level | Change and Issue elements with - if
necessary - subordinate structures.

To represent issues and tasks that apply
to the progress of the project as a whole
and that are not related to model
structures, you create Project Issue and
Project Task records in Project
Management.
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Maintenance Overview

If your work in managing a project identifies issues, defects
or required changes in the model rather than internal to a
single element, you can represent these using Change, Issue
or Defect elements as structured comments with which you
can track and manage the problems.

. A Change element corresponds to a change in
requirements for the current system

. An Issue element corresponds to a failure to match the
requirements for the current system due to newly arisen
organizational or legal factors such as staffing problems,
changes in laws or guidelines, or business unit
restructuring

. A Defect element corresponds to a failure to match the
requirements for the current system due to a flaw in the
model, system or process, such as a missing element or
module, or no inclusion of a necessary actor

You can also define any specific work to be done in
researching or resolving the problem using Task elements,
and assign resources to these or directly to the Change, Issue
or Defect elements internally, in Resource Allocation, or
externally as Actors.

The use of maintenance elements provides a broad scope for
managing changes, defects and issues, providing the facility
to fully define the problem and its resolution with Linked
Documents, both internal and external Notes, and
Composite Structure diagrams including Interaction and
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Activity diagrams.

You can create Change, Defect and Issue elements in
various UML diagrams (especially Maintenance diagrams)
and connect them using Realization, Dependency,
Aggregation and other relationships to show what model
elements each problem affects and how each is resolved.
Within the element 'Properties' dialog for Changes, Defects
and Issues you can i1dentify the problem as the element name
and record relevant management details, such as owner and
dates.

A useful tool 1n managing problems and changes is the
Relationship Matrix, in which you might - for example -
link staff (Actors) through Realization connectors to Issues.
Each highlighted square in the Matrix indicates the
responsibility of a staff member to work on or correct a
named Issue.
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Issues

In your modeling, issues concerning the development of the
system or model might arise; more formally, you encounter
a failure to meet defined requirements for the current
system. You can represent this failure using an Issue
element, which is a structured comment containing
information about the issue and the measures taken to
manage it. The element is rendered as shown.

Issue Element [

You can link Issues to model elements that are responsible
for the issue, using Realize connectors. You can also create
a hierarchy of related Issues using Aggregation connectors.
Each Issue element has a status band at the left end, which is
color coded to visually represent the value of the 'Status'
field in the element properties. The element has an
identifying 'T' in the top right corner, which you can hide if
you prefer not to show it.

You can create Issue elements on most types of diagram,
although the Maintenance diagram 1is specifically designed
for displaying and managing them. You can also create your
own issue-management diagram as a Custom diagram. You
can add the Issue (and other) elements to the diagram from
the Diagram Toolbox, or directly to a Package in the
Browser window.

Add an Issue to the model using the Toolbox
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Ste Action
P
1  Open the Maintenance or Custom (or other) diagram

to define the problem.

From the 'Custom' pages or 'Common' page of the
Diagram Toolbox, drag the Issue icon onto the
diagram.

If the Properties window is not already displayed,
press Ctrl+2 on the element. Record the name and
details of the Issue, in the Properties window.

Add an Issue to the model using the '‘New
Element' dialog

Ste Action
P
1 | Identify the Package in which to record the Issue, in

the Browser window.

Right-click on this Package and select the 'Add
Element' option.

(c) Sparx Systems 2026 Page 265 of 352



Project Build & Deploy 4 May, 2026

2 Complete the fields on the 'New Element' dialog - in
the 'Type' field, click on the drop-down arrow and
select '[ssue’.

3 When you have created the element, record the name
and details of the Issue, in the Properties window.

Notes

. To toggle display of the letter 'T' in the top right corner of
the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog,
'Objects' page
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Defects

In your modeling, problems in the development of the
system or model might arise; more formally, you encounter
an obstacle to meeting defined requirements for the current
system, through a defect of the model, system or process.
You can represent this failure using a Defect element, which
is a structured comment containing information about the
defect and the measures taken to manage it. The element is
rendered as shown.

Defecti D

You can link Defects to model elements that are responsible
for the problem, using Realize connectors. You can also
create a hierarchy of related Defects using Aggregation
connectors. Each Defect element has a status band at the left
end, which 1s color coded to visually represent the value of
the 'Status' field in the element properties. The element has
an 1dentifying 'D' in the top right corner, which you can hide
if you prefer not to show it.

You can create Defect elements on most types of diagram,
although the Maintenance diagram 1is specifically designed
for displaying and managing them. You can also create your
own defect-management diagram as a Custom diagram. You
can add the Defect (and other) elements to the diagram from
the Diagram Toolbox, or directly to a Package in the
Browser window.

Add a Defect to the model using the Toolbox

(c) Sparx Systems 2026 Page 267 of 352



Project Build & Deploy 4 May, 2026

Ste Action
p

1  Open the Maintenance or Custom (or other) diagram
to define the problem.

2 | From the 'Custom' pages of the Diagram Toolbox,
drag the Defect icon onto the diagram.

3 | If the Properties window is not already displayed,
press Ctrl+2. Record the name and details of the
Defect, in the Properties window.

Add a Defect to the model using the '‘New
Element' dialog

Ste Action
p

1 | Identify the Package in which to record the Defect,
in the Browser window.

Right-click on this Package and select the 'Add
Element' option.

2 Complete the fields on the 'New Element' dialog - in
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the 'Type' field, click on the drop-down arrow and
select 'Defect’.

3 When you have created the element, record the name
and details of the Defect, in the Properties window.

Notes

. To toggle display of the letter 'D' in the top right corner of
the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog,
'Objects' page
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Changes

In your modeling it might become necessary to change an
aspect of the system or model; more formally, you need to
request and manage a change in the defined requirements
for the current system. You can represent this change
request using a Change element, which is a structured
comment containing information about the change and the
measures taken to manage it. The element is rendered as
shown.

Change Element L

You can link Changes to model elements that are impacted
by the change, using Realize connectors. You can also
create a hierarchy of related Changes using Aggregation
connectors. Each Change element has a status band at the
left end, which 1s color coded to visually represent the value
of the Status field in the element properties. The element has
an identifying C in the top right corner, which you can hide
if you prefer not to show it.

You can create Change elements on most types of diagram,
although the Maintenance diagram 1is specifically designed
for displaying and managing them. You can also create your
own change-management diagram as a Custom diagram.
You can add the Change (and other) elements to the diagram
from the Diagram Toolbox, or directly to a Package in the
Browser window.
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Add a Change to the model using the
Toolbox

Ste Action
P

1 | Open the Maintenance or Custom (or other) diagram
in which to define the problem.

2 | From the 'Custom' or 'Common' pages of the
Diagram Toolbox, drag the Change icon onto the
diagram.

3  Ifthe Properties window is not already displayed,
press Ctrl+2. Record the name and details of the
Change, in the Properties window.

Add a Change to the model using the 'New
Element' dialog

Ste Action
P

1 | Identify the Package in which to record the change,
in the Browser window.
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Right-click on this Package and select the 'Add
Element' option.

2 | Complete the fields on the 'New Element' dialog - in
the '"Type' field, click on the drop-down arrow and
select 'Change’.

3 | When you have created the element, record the name
and details of the Change, in the Properties window.

Notes

. To toggle display of the letter 'C' in the top right corner of
the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog,
'Objects' page
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Maintenance Diagram

A Maintenance diagram is a type of Custom diagram, an
extension to the UML model. It is a change management
tool, used to record:

. Requests for change to the model structure or project
process, as Change elements

. Issues that impact the development and progress of the
project, as Issue elements, and

. Groups of tests that can be applied to many elements
rather than specific elements, as Test Cases

Each Change, Issue or Test Case element can link to other
model elements in the project, to illustrate how they
contribute to or are impacted by the item, and how they
must be modified, removed, applied or extended to provide
a solution. This includes identifying areas of work,
represented by Task elements, to which resources can be
allocated as either external (Actor) elements or internal
properties (resource allocation).

You generate Maintenance diagram elements and
connectors from the 'Maintenance' pages of the Diagram
Toolbox, although you might also make frequent use of
connectors from other pages.

Example Diagram

Example Maintenance Diagram
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Maintenance Diagram Element Toolbox

Ilcons

Icon

1  Package

tl Issue

if_‘l Change

Task

X Test Case

(c) Sparx Systems 2026

Description

A Package is a namespace as well as an
element that can be contained in other
Packages' namespaces.

Issue elements represent a failure to meet
defined requirements for the current
system.

This element represents a change in the
defined requirements for the current
system and can be used to request and
manage the change process.

A Task element represents a task that
must be performed in relation to an
element.

A Test Case 1s a stereotyped Use Case
clement. You might use it to extend the
facilities of the Test Cases window, by
applying element properties and
capabilities to the tests of a feature
represented by another element or - more
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appropriately - set of elements.

9 el An Entity is a stereotyped Object that
models a store or persistence mechanism
that captures the information or
knowledge in a system.

- A Test element represents a step in the

Basic, Alternate and Exception Paths of a

Scenario created in a Use Case or other

clement.

Pelcs The defect element represents an obstacle
to meeting defined requirements for the
current system.

Revew The Review element acts as a focus for
performing a formal review of one or
more model elements. It defines the
parameters of the review.

Maintenance Diagram Connector Toolbox
Icons

Icon Description

/' Aggregate
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An Aggregation connector is a type of
association that shows that an element
contains or is composed of other
elements.
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Example Maintenance Diagram

Very simply, this example diagram depicts a request for a
change (C) to a process represented by an Activity element
(Transfer WH Receipts to Active Stock). The change
currently involves the Task (T) of reviewing the interface
between two recording systems, one of which could be
affected by an Issue (I) concerning an external stocktaking

system.

Warehouse Receipt/Stocktake Update

C

srefouse rece

1
afraces
|

Review Interface 1|7

WH Receipt [
Log

Transfer WH Receipts to
Active Stock

|

|

|

|

I
TUSED

I

v

Paterial Code
Reference

(c) Sparx Systems 2026

Stock Level
Increment

N

N

Stocktake Counter L
External System
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Working with Maintenance ltems

Creating, viewing and modifying the Maintenance items -
changes, 1ssues, defects, tasks, feature and documents -
associated with a particular model element is quick and
convenient, using the Maintenance window. If the
Maintenance window 1s open, when you select an element in
a diagram or in the Browser window, the appropriate
maintenance items for that element are immediately listed in
the window, and you can select them there to modify. The
Maintenance window provides several facilities for
managing the maintenance items.

You can include the maintenance items in the document and
web reports generated on your model. The 'Document Setup'
dialog has checkboxes to show or hide element maintenance
items.

Access

Click on an element in the Browser window or diagram and
select the appropriate option.

Ribbon Construct > Change Management and:
. > Features > Show Features Window
. > Changes > Show Changes Window

. > Documents > Show Documents
Window

. > Issues > Show Issues Window
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. > Tasks > Show Tasks Window
. > Defects > Show Defects Window

Keyboard Ctrl+8 | <Required tab>

Shortcuts Select any of the items on a diagram or
the 'Details' tab of the Inspector window,
then use Shift+Enter

Facilities
Facility Detail

Maintenance @ The six types of Maintenance Item you
Item Types can create records for are each listed on a
separate tab of the Maintenance window:

. Defects - each recording a failure to
meet a requirement for the current
model element

. Changes - each recording a change in
requirement for the current model
clement

. Issues - each recording a risk factor
that might affect the project, associated
with the current model element

. Tasks - each recording work in
progress and work outstanding for the

(c) Sparx Systems 2026 Page 279 of 352



Project Build & Deploy

Adding New
Items

Applying
Automatic
Naming/Num

bering

(c) Sparx Systems 2026

4 May, 2026

current model element

. Features - each recording a feature in
requirement for the current model
clement

. Documents - each recording the
supporting documentation such as
Help, release notes and user comments

There is also a 'Maintenance Overview'
tab that displays a read-only list of all the
Maintenance items on the element,
grouped by type. If you double-click on
an item 1n this list, the appropriate tab
displays with the item highlighted.

To add new items, right-click on the main
panel of the Maintenance window and
select the 'Add New' option. The
appropriate fields for the item type are
displayed on the '<Maintenance Item
Type> details for <element>' dialog,
where you create the item.

The fields you complete for each type of
maintenance item are very similar.

On the '<Maintenance Item Type> details
for <element>' dialog, you can apply an

automatic naming/numbering convention
that you have previously defined, to each
new item record. To do this, simply click
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on the Auto button next to the 'Detail’
field.

If you already have some text in the
'Detail’ field, it is over-written by the
auto-counter text.

Details tab You can also use the 'Details' tab of the
Inspector window to create, select and
display specific items on the
'<Maintenance Item Type> details for
<element>' dialog. Select the 'Start >
Application > Design > Inspector' ribbon
option to open the Inspector window,
select the 'Details' tab and the
'Maintenance > <maintenance type>' list,
and either:

. Double-click on an existing item to
show and - if necessary - change the
details, or

. Right-click on the appropriate
'<maintenance type>' folder name and
select the 'New <item type>' option to
create a new item

Move items | You might have a maintenance item on

between one element that can be usefully moved

clements on to another element. You can move the
item very simply, by dragging it from the
Maintenance window or 'Details' tab onto
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the target element on a diagram.

Notes

. Columns in the item list can be reorganized, added,
removed, grouped, filtered and sorted using the options
provided in the List Header facilities
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Create Maintenance Items

When you need to create a new maintenance record for an
element, you can do so by selecting the 'Add New' context
menu option in the Maintenance window.

Access

Use one of the access paths outlined here to display first the
Maintenance window at the appropriate tab for the type of
maintenance item to create, then the '<Maintenance Item
Type> details for <element type>' dialog for that item type.

Ribbon Construct > Change Management >
Features > Show Features Window >
right-click | Add New

Construct > Change Management >
Changes > Show Changes Window >
right-click | Add New

Construct > Change Management >
Documents > Show Documents Window
> right-click | Add New

Construct > Change Management >
Issues > Show Issues Window >
right-click | Add New

Construct > Change Management >
Defects > Show Defects Window >
right-click | Add New
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Construct > Change Management >
Tasks > Show Tasks Window >
right-click | Add New

Keyboard Ctrl+8 > <required tab> | Right-click |
Shortcuts Add New

Select any of the Maintenance items on a
diagram or on the 'Details' tab of the
Inspector window, then press Shift+Enter

Create Maintenance items on the
Maintenance dialog

Option Action

Detail Type the name or a short description of
the feature, change, defect, task, issue or
document.

Auto As an alternative to typing in the name,

click on this button to insert predefined
auto-counter text.

If you already have some text in the
'Detail’ field, it 1s over-written by the
auto-counter text.
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Reported by / = Click on the drop-down arrow and select
Requested by | the user name of the person who initiated
/ Raised by the maintenance item.

Alternatively, start typing in the user
name until the auto-complete facility fills
in the rest of the name.

Date Defaults to today's date as the date on
which the maintenance item was raised; if
necessary, change this by clicking on the
drop-down arrow and selecting a different
date.

Status Click on the drop-down arrow and select
the appropriate status of the maintenance
item, such as 'New' or 'Complete’'.

Priority Click on the drop-down arrow and select
the priority for completing the
maintenance item.

Resolved by / | Click on the drop-down arrow and select
Implemented  the user name of the person who

by / completed and closed the maintenance
Completed item.
by Alternatively, start typing in the user

name until the auto-complete facility fills
in the rest of the name.
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Date Select the date on which the maintenance
item was completed; click on the
checkbox to select today's date or, if
necessary, change the field by clicking on
the drop-down arrow and selecting a
different date.

Version/ID  Displays the version number assigned to
this defect, change, task, i1ssue or
document.

If you want to refer to this maintenance
item from another element or document,
click on the Copy button to copy the ID
to the clipboard, from where it can be
pasted into the other text.

Description Type a longer description of the
maintenance item; you can format the
text using the Notes toolbar at the top of
the field. The text you enter here is also
displayed and can be edited in the Notes
window.

History Over time, enter any notes on the actions
concerning this maintenance item; you
can format the text using the Notes
toolbar at the top of the field. The text
you enter here 1s also displayed and can
be edited in the Notes window.
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Apply Click on this button to save the record
data and keep the dialog open.

OK Click on this button to save the record
data and close the dialog.

Close Click on this button to discard the
unsaved record data and close the dialog.

New Click on this button to clear the dialog
fields ready to define a new maintenance
item.

left If there are existing items, click on these

chevron/right = buttons to display the details of the

chevron previous item or next item in the
sequence.

Create Maintenance Items on the
Maintenance Window

An alternative method of creating simple Maintenance items
is to display the Maintenance window as indicated in the
Access section, but complete the fields on the window rather
than go on to display the '"Maintenance' dialog. In this way
you can quickly create a set of basic Maintenance items at
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once and then add more detail to individual items as
necessary at a later time.

To create an item:
1. Display the appropriate tab for the type of item.

2. Double click on the Add new <item type> text and type in
the name of the item.

3. Tab to the 'Status' field; the 'Status', 'Priority' and 'Date
Reported' fields display default values. If these are
acceptable to you, the Maintenance item i1s created and
available for future editing.

4. If you want to change the field values, click once on the
field and once on the drop-down arrow, and select the
appropriate value.

Notes

. To edit an item, double-click on it on the Maintenance
window; the item details display in the '<Maintenance
Item Type> details for <element type>' dialog for editing

. To delete an item, right-click on it on the Maintenance
window and select the 'Delete' option; in response to the
confirmation prompt, click on the Yes button

. A further possibility for editing and deleting items 1s to
right-click on items in the 'Details' tab of the Inspector
window and select menu options there; select the 'Start >
All Windows > Design' ribbon option and then 'Explore >
Inspector > Details > Maintenance > <maintenance type>"'

. To change the element for which to create or edit
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maintenance items, click on the new element on a diagram
or in the 'Project' tab of the Browser window
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Properties Window for Maintenance
Items

When the Properties window 1s open, it displays the
properties of the selected object or assigned item, including
a Maintenance record for an element. These items include
Changes, Issues, Defects, Tasks, Features and Documents.

Y ou might select the item in the appropriate tab of the
Maintenance window, the maintenance compartment of an
element on a diagram, or the 'Details' tab of the Inspector
window.

The Properties window identifies the type of item just under
the toolbar, and shows the current values for the:

. Item name

. User who raised the item

. Date the item was raised

. Status

. User who implemented or resolved the item
. Date that action was completed

. Priority of the item

. Version of the item

You can change the value for each of these fields (except for
the 'Name' and 'Version' fields), by clicking on the
drop-down arrow and selecting a new value. For the user
name fields, you can also start typing in the name until the
auto-complete facility fills in the rest of the name.
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For the 'Name' field, you can either overtype the item name
or click on the [ icon and apply any autonaming
convention you have configured for maintenance items. If
you click on the icon for the 'Version/ID' field, that value 1s
copied to the clipboard to be pasted into a discussion or
document.

The toolbar options operate on the parent element for the
maintenance item. Any changes you make are automatically
saved and displayed elsewhere when you click off the field.
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Move or Copy Maintenance Items
Between Types

After you define a maintenance item of one type (Defect,
Change, Issue, Document, Feature or Task), you might
decide that the item either is better suited to another type or
forms a good template for items of other types. If so, you
can either move or copy the item to the other types.

Access

Display the Maintenance window using one of the methods
outlined here.

In the Maintenance window:

. Right-click on a maintenance item | Move to | <item type>
or

. Right-click on a maintenance item | Copy to | <item type>

Ribbon Construct > Change Management >
Features > Show Features Window

Construct > Change Management >
Changes > Show Changes Window

Construct > Change Management >
Documents > Show Documents Window

Construct > Change Management >
Issues > Show Issues Window

Construct > Change Management >
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Tasks > Show Tasks Window

Construct > Change Management >
Defects > Show Defects Window

Keyboard Ctrl+8 > <required tab>
Shortcuts

Move or copy a maintenance item

Ste Action
p

1 | Click on the appropriate option - 'Move to' or 'Copy

'

to'.
A list of maintenance item types displays.

2 Click on the item type to which to move or copy the
item.

A confirmatory prompt displays.

3 Click on the Yes button to confirm the move or
copy.

4 | Switch to the appropriate tab of the Maintenance
window to ensure that the item has been added.
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5 | If'you are copying the item to more than one other
item type, repeat steps 1 to 4 for the next item type
to copy to.
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Show Maintenance Items in Diagram

When you have created a maintenance item, it is useful to
make the record visible on its parent element. You can do
this by displaying the record within a maintenance
compartment on the element as it displays in a diagram. Any
clement that 1s capable of displaying a compartment, and
that has maintenance items assigned to it, can show the
items in a diagram.

Show maintenance items in a diagram

Ste Action
p

1 | Open a diagram containing the element with the
attached maintenance items.

2 | Double-click on the diagram background to display
the diagram 'Properties' dialog.
Click on the 'Elements' tab.

3 | In the 'Show Compartments' panel, select the
'Maintenance' checkbox.

4 | Click on the OK button to save the setting.

Each maintenance item now appears in the
maintenance compartment of the diagram element.
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Items of each type are grouped together so that, for
example, all Issues on the element are grouped under
the heading 'Issue', and all Tasks on the element are
grouped under the heading 'Task’.

If you double-click on a maintenance item, the
'<maintenance item type> for <element>' dialog
displays and you can edit the details of the item.

Maintenance Compartment - Example

CCBookClientPanel

«SM_Activity»
+ CCBookClientPanel
+ GetBook: CBook

~  bookpanel(): CCBookPanel

test scripts
Unit
Valid Inputs Pass
maintenance
Issue
Run time New
Triggers New
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Move Maintenance Items Between
Elements

A maintenance item you define for one element might be
usefully moved to another if, for example, you are moving
your model through stages in a lifecycle or, indeed,
modeling a lifecycle. It is possible to simply drag a
maintenance item of any type from either the appropriate tab
of the Maintenance window or the 'Details' tab of the
Inspector window, onto a different element on a diagram.

Access

From the Browser window, open the diagram containing the
target element, then click on the element from which to
move the tests. It is convenient to have both source and
target elements on the same diagram, but it is possible to
select the source element in the Browser window or on a
different open diagram.

It 1s also convenient to have compartments enabled on the
target element, with the Maintenance compartment selected,
so that you can observe the addition of the moved item.
(Right-click on the element and select 'Compartment
Visibility', then select the 'Maintenance' checkbox.)

Ribbon Start > Application > Design > Browser >
Element - expand the 'Maintenance'
category or
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Construct > Change Management >
<item type> | Show <item type> Window

Alt+2 | Maintenance > <item type> tab
Click on the source element on a diagram

T

Click on the maintenance item that you intend to move, and
simply drag it onto the target element. The item name will
display in the 'maintenance' compartment of that element.
What you would observe might resemble this illustration.

Stage 1

maintenance
Change
Remove account type

Issue
Mot all banks use Account Type

New

New

I

Stage 2

Stage 1

Stage 2

maintenance
Change
Remove account type

New

I

Issue

Mot all banks use Account Type

maintenance

New
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Create Elements From Maintenance
Item

A maintenance item identifies a defect, change, issue, task,
feature or document concerning an element. The
maintenance item could itself be represented by an element
if 1t has wider implications for the project or identifies - for
example - an actor, activity or action that requires further
definition.

You can create one or more elements from any maintenance
item, using the Maintenance window. The new element is
connected to the maintenance item's parent element by a
Dependency connector. The original maintenance item
remains unchanged as a characteristic of its parent element.

Access

Use one of the methods outlined here to display the
Maintenance window appropriate to the maintenance item
from which to create a model element.

In the Maintenance window: Right-click on the maintenance
item > Create as New Element

The 'New Element' dialog displays.

Ribbon Construct > Change Management >
Features > Show Features Window

Construct > Change Management >
Changes > Show Changes Window
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Construct > Change Management >
Documents > Show Documents Window

Construct > Change Management >
Issues > Show Issues Window

Construct > Change Management >
Tasks > Show Tasks Window

Construct > Change Management >
Defects > Show Defects Window

Ctrl+-8 > <required tab for item type>

Select any of the Maintenance items on a
diagram or in the 'Details' tab of the
Inspector window, then press Shift+Enter

Create an element from a maintenance item

On the 'New Element' dialog, complete the fields.
Field/Option Action

Toolset

Name
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The two '"Toolset' fields default to the
last-set domain and Perspective. If these
are not appropriate to this task, click on
the drop-down arrows and select the
correct domain and Perspective.

The 'Name' field defaults to the name of
the Maintenance item. If necessary you
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Type

Stereotype
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can overtype it with a different name, or
click on the Auto button to apply a name
from your auto naming and numbering
system.

Click on the drop-down arrow and select
the required element type; you might
create:

. An Issue element for an Issue
maintenance item

. A Defect element for a Defect
maintenance item

. A Change element for a Change or
Feature maintenance item, or

. A Task for a Task maintenance item

The types are filtered by the Toolset you
have selected; if the element type you
require 1s not listed, you can change the
Toolset to provide that type. You can,
therefore, create a wide range of other
element types should any of these be
more appropriate.

If you require the element type you have
selected to be refined by a stereotype,
click on the drop-down arrow and select
the stereotype name. The stereotypes are
listed in alphabetical order.
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Add Element = This option is enabled when you have a
to Diagram diagram open. If you want the new
clement to be added to a diagram, have

that diagram open and select this
checkbox.

Save Click on this button to add the new
element to the Browser window and, if
appropriate, the diagram.
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Construct History Window

The Construct History window provides a summary of all
project management transactions over a given period, with
separate tabs for Tests, Resource Allocations and
Maintenance objects (Changes, Features, Issues, Defects,
Tasks and Documents). You can set the period for which the
window lists the transactions, and display details of each
record in the appropriate item Properties dialog (in which
the record is defined).

Access

Ribbon Start > All Windows > Construct >
Resources > Resource - History

Start > All Windows > Construct >
Testing > Tests - History

Start > All Windows > Construct >
Change > Maintenance - History

Context Menu Options

Right-click on an entry or on the window background to
display the options for working on the listed item or on the
display of items 1n the Construct History window.

You can also adjust the number and position of the columns
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displayed, and filter the information shown, using the List
Header facilities, as described in the List Header Help topic.

Option

Properties

Find Parent
1in Browser

Find Parent
in Diagram

Visible
Timeframe -
Resources
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Description

For a selected resource, test or
maintenance item, displays the properties
of that item in the appropriate create/edit
dialog for the item type.

Double-clicking on the item has the same
result.

For a selected resource, test or
maintenance item, locate and highlight -
in the Browser window - the element to
which the item has been assigned.

For a selected resource, test or
maintenance item, locate and highlight -
in the parent diagram - the element to
which the item has been assigned. If the
element is present in more than one
diagram, the 'Element Usage' dialog
displays, from which you select the
diagram to open.

Click anywhere 1n the window and select
this option to display a submenu. Select
one of these options:

. 'Today' to list resources with today as

Page 304 of 352



Project Build & Deploy 4 May, 2026

the task Start Date or End Date

. 'Today +X' to list resources with a task
Start Date or End Date of today or up
to 3, 7 or 30 days after today

. 'Today -X' to list resources with a task
Start Date or End Date of today or up
to 3, 7 or 30 days prior to today

. 'Today +/-X' to list resources with a
task Start Date or End Date of today or
up to 3, 7 or 30 days either side of
today; for example,

"Today +/-30' lists resources with a task
Start Date or End Date within the
61-day period between 30 days prior to
today and 30 days after today

Visible Click anywhere 1n the window and select
Timeframe - | this option to display a submenu. Select
Tests one of these options:
. 'Today' to list tests with today as the
Run Date

. 'Today X Days' to list tests with a Run
Date of today or up to 7, 30 or 90 days

prior to today
Visible Click anywhere in the window and select
Timeframe - | this option to display a submenu. Select

Maintenance | one of these options:
. 'Today' to list maintenance items with
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today as the Reported Date or Resolved
Date

. 'Today X Days' to list maintenance
items with the Reported Date or
Resolved Date of today or up to 7, 30
or 90 days prior to today

Check for Click anywhere in the window and select

Update Every this option to display a submenu, then
select 'Minute', '2 minutes', '5 minutes' or
'10 minutes' to automatically refresh the
list of items at that interval and display
any new items that now match the
selection options.

Refresh Click anywhere in the window and select
this option to manually refresh the
display immediately, to display any new
items that now match the selection
options.

Set This Tab | Select this option to set the Construct

as Default History window at the current tab to
automatically redisplay when you log
back in to the model in a new work
session.

(c) Sparx Systems 2026 Page 306 of 352



Project Build & Deploy 4 May, 2026

The Construct View

The Construct View is an aid to Project Management,
helping you to quickly review the resources and
maintenance items of the elements in any Package
(including a View, but not a Root node) or its diagrams in
the model. You can filter the view to show resources, or a
single category or all categories of Maintenance item; that
is:

. Features

. Changes

. Issues

. Defects

. Tasks and/or
. Documents

You can also manipulate what data to show for each item,
using the 'Field Chooser' dialog and the Filter Bar. (See the
List Header Help topic.)

As you select individual items in the View, they become the
focus of various Enterprise Architect windows such as the
Notes window, 'Details' tab of the Inspector window, and
the Properties window.

Access

Ribbon Select an open diagram in the Browser
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window or right click on the diagram
background, then Design > Diagram >
Views > Construct View

Context In the 'Project' tab of the Browser

Menu window, right-click on the View or
Package | Open Package in | Construct
View

In a diagram, right-click on the diagram
background | Switch View | Switch to
Construct View

Other Right-click on the diagram tab for the
diagram | Switch to Construct View

Context Menu Facilities

To select and display the information in the Construct View,
you select options on the View's context menu. Right-click
anywhere on the View display.

Option Description
Load Select this option to display the status and
Resources activity details of the resources assigned

to each element in the Package or on the
diagram. This option 1s mutually
exclusive with 'Load Maintenance'.
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Load
Maintenance

Refresh

Clear
Window

Collapse All /
Expand All

Display as
flat list
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Select this option to display the details of
either all Maintenance items on the
elements in the Package or diagram, or all
those of a particular type - Features,
Changes, Defects, Issues, Tasks or
Documents. This option 1s mutually
exclusive with 'Load Resources'.

Select this option to update the display
after changes have been made, to ensure
that they are reflected in the data fields
for every view, dialog and window as
well as the Construct View.

Select this option to remove all data from
the window.

The display initially shows the data in an
expanded hierarchy of elements, child
elements and maintenance items or
resources. Select the 'Collapse All' option
to show just the top-level elements with
no data, and select the 'Expand All'
option to reveal the full hierarchy again.

Select this option to display only those
elements that have resources or
maintenance items, with those items. The
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clements are listed in alphabetical order
at the same level, regardless of where
they occur in the model hierarchy.
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The Construction Diagram

A Construction diagram is a graphical version of the
'Details' tab of the Inspector window. It shows the assigned
characteristics and features of the selected element, where
these features have been created. Each type of feature is
shown 1n a separate element compartment.

To access a Construction diagram for an element, either:

. In a diagram, right-click on the element | New Child
Diagram | Construction Diagram, or

. In the 'Project' or 'Context' tab of the Browser window,
right-click on the element | Add | Construction Diagram

To create a new Construction diagram for multiple
elements:

. Select a Package in the Browser

. Select 'New Diagram' from the Browser context menu
. Set the Perspective to '"ALL Perspectives'

. Select 'Extended' in the 'Select From' pane

. Select 'Construction' in the 'Diagram Types' pane.

The Construction diagram for the element displays a 'C' in
the bottom right corner of the element, indicating that 1t 1s
the Construction rendition of the element. The list of
potential properties displayed in compartments on an
element include:

. Tags

. Requirements
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. Constraints
. Testing

. Maintenance
. Discussions
. Reviews

. Resources

. Projects for Decisions, Events, Issues and Tasks

. Notes
. Package Contents

Transaction

[ESL SCripis

Acceptance

Transaction Analysis Mot Run
maintenance

Issue

Requires details on GST tax requirements Mew
Task

Write code for transactions Mew

FESOUrCES

Linus
R App”:a[i:ll'. Analyst
Sam
I ] [++ F'F:IEF.EII"IF'IEF

c

4 May, 2026

The visibility of compartments 1s dependent on there being

detail in the specific features.

The possible compartments shown on the element are
user-selectable from a range of element compartments. To

alter this;

. Click on the diagram (or press F5)

(c) Sparx Systems 2026

Page 312 of 352



Project Build & Deploy 4 May, 2026

. In the Properties window, select 'Elements'
. Tick the options in the 'Show Compartments' group.

An example of a Construction diagram with multiple
elements.

Transaction Account
test scripts tags
Acceptance KeyClass = true
Transaction Analysis Not Run
maintenance
maintenance Issue
Issue Program the detail code VAT & GST sp... New
Requires details on GST tax requirements Mew Task
5
Task Program the detail code New
Write code for transactions New | _history -account

FESOLUFCES

FESOUrCES Leon Major

Linus [— 1 Developer
— 1 Application Ana...
A discussions
Sam
[ — 1 C++ Programmer

* Leon: Construction has been started but there is an

issue on the Transaction requirements cover...

The Transaction is dependent on the Account setting to

ensure the Country of Crigin and used to determine any
need for VAT or G5 _ . .
) Leon: Started however awaiting a finalization on

[ the Transaction requirements for VAT

Note that an Actor element defaults to the Rectangular
Notation on a Construction diagram.
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Project Issues

You can record and review issues - events, occurrences and
situations that impact on project development and delivery -
against the current project using the Project Issues view and
its 'Issue Detail' dialog . For each Issue, you record the
description, date, owner and status. You can also generate a
document report on the issue items.

Access
Ribbon Construct > Project Management >
Issues-Tasks > Project Issues
Operations
Operation

Add, delete and modify Issues using the 'Issue Details'
dialog.

Generate and view a rich text format report of your issue
list
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Notes

. You can transport these 1ssue definitions between models,
using the 'Settings > Model > Transfer > Export
Reference Data' and 'Tmport Reference Data' ribbon
options

. To print out the currently displayed items, select the 'Print
List' context menu option

. You can re-organize the display of the listed tasks using
the List Header facilities for reported information

. In the Corporate, Unified and Ultimate Editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Issues' permission to update and delete Issues
records
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Add, Delete and Modify Issues

You can maintain project issue records using the 'Issue
Detail' dialog from the Project Issues view.

Access

Ribbon Construct > Project Management >
Issues-Tasks > Project Issues

Maintain Project Issues

Ste Action
p

1 | If creating a new issue, double-click in a blank area
to display the 'Issue Detail' dialog and complete the
blank fields.

If editing an existing item, double-click on the item
to display the 'Issue Detail' dialog and edit the fields.

2 | Enter or update these 1ssue details, selecting a value
from the field's drop-down list where appropriate:

. The 1ssue name
. Automatic naming - if you have set up automatic
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naming conventions, click on the Auto button to
insert the predefined element name and counter

text; 1f you already have some text in the 'Name'
field, 1t 1s over-written by the automatic naming
text

. The issue priority

. The date the i1ssue was raised
. The issue status

. The issue owner

. A description of the issue

. The date on which the issue was resolved (select
the checkbox to activate the date)

. The name of the person who resolved the 1ssue
. Any comments on the resolution

3 | Click on the Apply button.

4 | If the issue 1s closed (and all the 'Resolution’ fields
are completed), click on the Close Issue button.

5 | To create another entry click on the New button or,
to close, click on the OK button.

6 | To delete an issue in the Project Issue view,
right-click on the entry and select the 'Delete' option,
then click on the Yes button on the confirmation
prompt.
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Notes

. You can filter the list of issues by status, to show all
issues or just Open, Closed or Under Review issues, using
the 'Set term filter' context menu option
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Report From Project Issues View

You can generate a document report on your project issue
records from the Project Issue view.

Access

Ribbon Construct > Project Management>
Issues-Tasks > Project Issues >
Right-click on Issues list > Create Report

The 'Save As' dialog displays.

Generate your project issues report

Ste Action
p

1 | Browse for and select the appropriate file location.

In the 'File name' field, type the file name for the
report.

2 | Click on the Save button.

A status message displays when the report has been
generated.
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3 Click on the OK button and then on the View RTF
button.

The report displays in your default viewer.
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Report Output Sample

This is an example of the output of an Issues report.
List of Project Issues: 24-Jul-2010 9:47:00 AM

Issue Date/Owner Description Resolution

Test servers will be delayed |24/07/2014 Eloise Norman |The test server builds have been delayed | Closed: 24/07/2014 Geoffrey
because the particular (unusual) memory | Sparks
requirements to match the customer's site
are not available on shore. They are being | The machines will be built and
sourced from Singapore but it will delay the delivered using standard memory

builds and delivery of the machines. and the proprietary memory will
be added later. All performance
tests will be delayed until the
memory is available.
Public Holidays 24/07/2014 Joanna Stoat The schedule includes staff working on Open: 24/07/2014

public holidays. A number of staff have
indicated that contrary to what they stated
earlier they are not available.
Compiler Version disparity  |24/07/2014 Eloise Norman |A mumber of the developers have Under Review: 24/07/2014
downloaded different versions of a number
of the compilers. This has lead to
unpredictable builds impacting on testing.

(c) Sparx Systems 2026 Page 321 of 352



Project Build & Deploy 4 May, 2026

Project Tasks

The Project Tasks view provides a convenient "To Do' list
of major project work items that are not recorded elsewhere.
It can be used to track events such as requests or corrections.

Access
Ribbon Construct > Project Management >
Issues-Tasks > Project Tasks
Notes

. Right-click on the list to view the context menu, and
select to add, modify or delete tasks, or to set a status
filter

. You can re-organize the display of the listed tasks using
the List Header facilities for reported information

. To print out the currently displayed items, select the 'Print
List' context menu option

. You can transport task definitions between models using
the 'Settings > Model > Transfer > Export Reference Data'
and 'Import Reference Data' options

. You can add or work on an item in the Project Tasks view
by right-clicking (context menu) or double-clicking on the
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blank or completed item line

. The Project Tasks view context menu has options for
filtering tasks and i1ssues by status; you can also
re-arrange the sort-order by clicking in the title bar of the
column that the items are to be indexed on
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Add, Modify and Delete Tasks

To add, edit and delete project tasks you can work in either
the Project Tasks view, or the Project Calendar.

Access

Ribbon Construct > Project Management > Issues
- Tasks > Project Tasks

Start > Collaborate > Calendar > Project
Tasks mode

Maintain Tasks

Ste Action
p

1  If creating a new task:

. Double-click in a blank area of the Project Tasks
view, or on a cell of the Calendar

If editing an existing item:

. Double-click on the item on the Project Tasks
view or Calendar

The 'Task Detail' dialog displays.
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2 | Enter or update these details of the task, selecting a
value from the field's drop-down list where
appropriate:

. The task name

. Automatic naming - if you have set up automatic
naming conventions, click on the Auto button to
insert the predefined element name and counter
text; 1f you already have some text in the 'Name'
field, it is over-written by the automatic naming
text

. The task type
. The task owner

. The expected start and end date for the task (select
the checkboxes to activate the dates)

. The current status of the task
. The person this task has been assigned to

. The task priority, such as high, medium, low or
undetermined

. The expected total time for the task and the actual
time expended (in complete units; the type of unit
must be agreed across the project)

. The percentage completion

. The phase associated with this task

. A description of the task

. Any progress history appropriate to the task
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3 | Click on the Apply button.

4 | To create another entry click on the New button or,
to close, click on the OK button.

5 | To delete a task, in the Project Tasks view:
1. Right-click on the task and select the 'Delete’
option
2. Click on the Yes button on the confirmation
prompt

Notes

. 'Owner' and 'Assigned' fields are filled from the Project
Authors, Resources and Project Clients
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Update Package Status

Often a complete Package structure moves from one status
to another (such as for release) in one operation. To help
facilitate this, Enterprise Architect supports a 'bulk' update
of Package and element Status, Phase, and Version, which
also provides the option of defining the scope of the update.

Access

Ribbon Design > Package > Manage > Update
Status

Update Status across a Package

Field Action
New Status Type in or select the new status of the
Package.

New Phase Type the new phase.
New Version | Type the new version.
Modified System set; you cannot change this field.
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Date

Set Date

Recursively
update all
child

packages

Include
Elements

Include
Element
Requirements

Include
Element
Constraints

OK
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Defaults to selected to apply the Modified
Date; if necessary, deselect to ignore the
date stamp on the change.

Select to apply the changes through all
child Packages of the selected Package;
deselect to apply the changes to only the
selected Package.

Defaults to selected; if the changes are to

apply only to Package elements, deselect
the checkbox.

Defaults to selected, to update the
element requirements' 'Status' field;
deselect to ignore this field.

Defaults to selected, to update the
constraints' 'Status' field; deselect to
ignore this field.

Click on this button to update all required
clements to the new status.
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Monitor Change Events

You can automatically monitor work events in your project,
using the Model Views facility.

Guide

Aspect Detail

Model Views @ This facility enables you to:

. Automatically refresh a search in a
View at an interval that you define

. Notify you if the results of the search
change between two consecutive
searches

You can therefore use Model Views to
monitor various events in the
development project, depending on how
you set up the search in a View.

Example You could set up a search to detect:

. Change items, or Issue items, so that
Enterprise Architect would notify you
as new items were created

. Element Status, Type, Phase, Version,
Priority and/or date of last update, so
that Enterprise Architect would notify
you as items were progressed to:
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- Fall in to the level of work
represented by the search categories

- Move out of the categories into
the next level of work

. Tagged Values, so that - again - as
items were changed to satisfy the
criteria of a sequence of searches, the
progression of items through a set of
stages could be checked and managed

People responsible for different stages in
a process could have their own Model
View searches so that:

. As a development, validation or
authorization task falls due the
responsible person is automatically
notified, and

. When the work 1s complete both the
next person in line and the overseeing
manager are notified

. This facility is available in the Enterprise Architect
Corporate, Unified and Ultimate Editions

(c) Sparx Systems 2026

Page 330 of 352



Project Build & Deploy 4 May, 2026

Model Watches

Enterprise Architect provides you with the facility to watch
for a range of activities linked to your user ID, across not
just one project but any or all of those to which you have
access. This helps you to stay up to date with changes,
developments and conversations in the projects in which
you are working or have an interest.

Specifically, you can set up a Watchlist to notify you of:
. New model chats

. New model messages

. Recent element discussions

. Recent team reviews

. Recently flagged watched items
. Recently modified diagrams

. Recently modified elements

. Active tasks

. Tasks ending today, and/or

. Tasks overdue

Y ou can monitor for these events in the project or projects
from a specific date onwards, or over a rolling interval of
time such as the previous seven days.

Access
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Other Start page > Recent drop-down arrow >
Configure Watched Models

Configure a Watchlist

Showing Activity From:  3L/08/2017 =
Relative Time

Connections New Configure Delete

Enabled Connection Name User Name Password

e test

Ste | Description
P

1 | In the 'Showing Activity From' field, click on the
drop-down arrow and select the date from which to
start monitoring events.

If you want to accumulate information over time,
leave the 'Relative Time' checkbox unselected to
collect the data starting from the set date as the
absolute date.

If you want to show information gathered only over
the previous fixed interval, select the checkbox. The
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system then calculates the interval between the set
date and today, displaying the length of that interval
next to the date field. Adjust the selected date to give
you the interval you require. The system will then
provide information gathered only during that
interval, rolling forward.

2 | Click on the New button to add a project to the
Watchlist. A short menu displays, offering options to
access the project through a:

. Local file path - a browser displays through which
you locate and select the project file

. Connection Wizard - the Windows 'Data Link
Connection' dialog displays through which you
can open a model on a DBMS

. Cloud Connection - the 'Cloud Connection' dialog
displays; ensure that all the connection details are
correct

. Connection string that you have copied - the
'Connection String' dialog displays; paste the
copied string into the 'Enter Value' field and click
on the OK button

The name of the project displays in the 'Connections'
panel, with the 'Enabled' checkbox automatically
selected. At any point, if you want to drop the
project out of the watch, you can simply de-select
the 'Enabled' checkbox.

In the 'User Name' and 'Password' fields, type the
login parameters necessary for the system to open
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the watched model under your ID.

Click on the connection name and then on the
Configure button. The 'Model Watchlist' dialog

displays.

Check each item you wish to view.

Display -
Mew model chats

Mew model messages

Recent element discussions
Recent team reviews

Recent watched items

Recently modified diagram
Recently modified elements

Tasks active

05 1 1A IS [S 1A 18] (S

Tasks ending today

Select All | Clear All

Click on each checkbox to select the items to
monitor, or to clear selected items as required. You
can also use the Select All button or Clear All button
to act on all items at once, and then select or clear
individual items. When you have made your
selection, click on the OK button to save the
changes.

On the 'Manage Models' dialog, click on the OK
button to save the model Watch and close the dialog.

To check for any events picked up by your
Watchlist, on the Start page click on the 'Models'
drop-down arrow and select the "Watched' option.

4 May, 2026
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The list of recently-accessed projects is updated to
show just those included in your Watchlist.

The message 'Querying watched models' displays,
followed by a login prompt for each project that has
controlled access. Type in your login parameters.

Under each project name, a summary list of the
watched items and events is displayed.

You can review the flagged items by clicking on the
watched model name and running the appropriate
Model Search or displaying the Discussions window.
This closes the original project in which you checked
the Watchlist.

5 | After you have checked the Watched projects, and if
necessary, you can click on the 'Models' drop-down
arrow and select the 'Configure Watched Models'
option to update the Watchlist configuration, as in
steps 1, 2 and 3.

If 1t 1s necessary to remove a project entirely from
the Watchlist, on the 'Manage Models' dialog click
on the project name and on the Delete button.

If you have finished working with the Watchlist,
click on the 'Models' drop-down arrow and select the
'Recently Used' option to restore the model list to the
full list of recently-accessed models.
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Use Case Estimation

Project estimation is the task of working out how much time
and effort 1s required to build and deploy a solution.

The Use Case metrics facility in Enterprise Architect
provides a starting point for estimating project effort; using
this facility you can get a rough measure of the complexity
of a system and some indication of the effort required to
implement the model. Like all estimation techniques, Use
Case metrics requires some experience with previous
projects to 'calibrate' the process.

There is additional information available on Use Case
metrics on the Sparx Systems website.

Access
Ribbon Settings > Reference Data > Model Types
> Estimation Factors
Processes
Process Description
Calibrating These values must be carefully calibrated

in order to gain the best possible
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estimates:

Technical Complexity Factors, which
are values that attempt to quantify the
difficulty and complexity of the work
in hand

Environment Complexity Factors,
which are values that attempt to
quantify non-technical complexities
such as team experience and
knowledge

Default Hour Rate, which sets the
number of hours per Use Case point

Once you have entered all the calibration
values, you can estimate the project
timescale through the 'Use Case Metrics'
tab of the QA Reports View.

The estimation process also draws on
information on Use Cases recorded on the
'Resource Allocation' tab.
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Technical Complexity Factors

Technical Complexity Factors (TCFs) are used in the Use
Case Metrics estimation technique.

The EABase.qea and EABase.eap model contains a default
set of TCFs, which you can add to or modify using the
'Estimation Factors' dialog. This set of factors should
include all factors that could affect the technical complexity
of the project environment.

Access

Ribbon Settings > Reference Data > Model Types
> Estimation Factors > Technical
Complexity Factors

Maintain Technical Complexity Factors

Ste Action
p

1 | On the 'Technical Complexity Factors' tab, either:
. Click on the New button to add another TCF, or

. Click on the required factor in the 'Defined
Technical Types' list to edit it (go to step 3)
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2

In the 'Factor Number' field, type the appropriate
TCF number.

In the 'Description’' field, type or edit the TCF
description.

In the 'Weight' field, type or edit the technical
complexity weighting.

This indicates how much technical complexity you
assign to a factor; for example, 'the system is to be
developed in ADA' might warrant a higher weight
than 'the system 1s to be a shell script'.

In the 'Value' field, type or edit a value representing
the degree of influence the factor has on the project.

As a suggested gauge:

. 0 indicates no influence

. 3 indicates average influence
. 5 indicates strong influence

Click on the Save button.

Examine the 'Defined Technical Types' list, and
scroll across it to show the 'Ex Value' column
(Weight x Value).

The summed Ex Values yield the 'Unadjusted TCF
value' (at the bottom of the dialog).
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The 'Unadjusted TCF value' is combined with the
Environment Complexity Factors to skew the overall
complexity up or down, depending on the level of
technical complexity and the corresponding level of
environmental support.

Notes

. The TCF Weight evaluates its respective factor, but is
irrelevant to a project; the 'Value' field assesses each
factor's role within a project and, for most purposes, is the
only field requiring adjustment

. The supplied factors and their associated weights are

defined by the Use Case Points Method, although they can
be adjusted to suit a project's specific requirements

. You can transport the Technical Complexity Factors
between models, using the 'Settings > Model > Transfer >
Export Reference Data' and 'Import Reference Data'
ribbon options
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Environment Complexity Factors

Environment Complexity Factors (ECFs) are used in the
Use Case Metrics estimation technique.

The EABase.qea and EABase.eap models contain a default
set of ECFs, which you can add to or modify using the
'Estimation Factors' dialog. This set of factors should
include all factors that could affect the general design and
development environment, including team experience and
knowledge, team size, expertise and other non-functional
environmental factors.

Access

Ribbon Settings > Reference Data > Model Types
> Estimation Factors > Environment
Complexity Factors

Maintain Environment Complexity Factors

Ste Action
p

1 | On the 'Environment Complexity Factors' tab, either:
. Click on the New button to add another ECF, or
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. Click on the required factor in the 'Defined
Environment Types' list to edit it (go to step 3)

2 | In the 'Factor Number' field, type the appropriate
ECF number.

3 | Inthe 'Description' field, type or edit the ECF
description.

4  In the '"Weight' field, type or edit the environment
complexity weighting.
This indicates how much complexity you assign to a
factor.

5 | In the 'Value' field, type or edit a value representing
the degree of influence the factor has on the project.

As a suggested gauge:

. 0 indicates no influence

. 3 indicates average influence
. 5 indicates strong influence

6 | Click on the Save button.

7 | Examine the 'Defined Environment Types' list, and
scroll across it to show the 'Ex Value' column
(Weight x Value).

The summed Ex Values yield the 'Unadjusted ECF'
value (at the bottom of the dialog).
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The Unadjusted ECF value is combined with the
Technical Complexity Factors to skew the overall
complexity up or down, depending on the level of
technical complexity and the corresponding level of
environmental support.

Notes

. The ECF Weight evaluates its respective factor, but is
irrelevant to a project; the 'Value' field assesses each
factor's role within a project and, for most purposes, is the
only field requiring adjustment

. The supplied factors and their associated weights are

defined by the Use Case Points Method, although they can
be adjusted to suit a project's specific requirements

. You can transport the Environment Complexity Factors
between models, using the 'Settings > Model > Transfer >
Export Reference Data' and 'Import Reference Data'
ribbon options
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Default Hours

Setting an hourly rate 1s the most difficult factor in an
accurate estimation. Typical ranges can vary from 10 to 30
hours per Use Case point.

Studying the Use Case Points Method, from which this
variable is defined, can help you to understand its role in the
estimation and facilitate selection of a suitable initial value.

The best way to estimate this value 1s through analysis of
previous completed projects. By calculating the project
estimation on a completed project for which the Use Cases
and environment are configured within Enterprise Architect,
you can adjust the hour rate to render an appropriate value
for your unique work environment.

Access

Ribbon Settings > Reference Data > Model Types
> Estimation Factors > Default Hour Rate

Set the default hour rate per adjusted Use
Case point

Ste Action
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1 | In the 'Duration' field, type the number of hours per
Use Case Point.

2 | In the 'Hourly Rate' field, type the cost per hour.

3 Click on the Close button.

Notes

. The values you enter are stored as local settings on your
computer only

. This option is also active in the 'Lite', read-only version of
Enterprise Architect
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Estimating Project Size

Enterprise Architect uses a simple estimation technique
based on the established:

. Number of Use Cases to be built

. Difficulty level of those Use Cases
. Project environment factors and

. Build parameters

This technique 1s of value only once you have developed a
couple of known projects to use as a baseline. Please DO
NOT use the provided 'guesstimates' as a real world measure
until you have some real world base lines to measure
against.

Access

Ribbon Click on the required Package in the
Browser window, then:

Construct > Project Management > QA >
QA Reports > Use Case Metrics

Complete a Use Case Metrics Estimation

Field Action
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Keyword like

Bookmarked

Use Cases

Include
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Confirm the root Package in the
hierarchy.

All Use Cases under this Package could
potentially be included 1n the report.

Re-run the load from the selected
Package, usually after you change the
filter criteria.

Include Use Cases with a phase that
matches the wildcard value in the field.

Use * to match any characters; for
example, 1.* for 1.1 and 1.2.

Include Use Cases with a keyword that
matches the wildcard value in the field.

Use * to match any characters.

Include all Use Cases, or only those that
are tagged, or those that are not tagged.

Check the total count of Use Cases in the
estimate.

The Use Cases and their parameters are
listed in the panel underneath this field.

Select to include Actors in the estimate.
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Actors

Technical Review the parameters that describe the
Complexity | degree of technical complexity of the
Factor project.

While the 'Unadjusted TCF Value' comes
from the 'Technical Complexity Factors'
tab of the 'Estimation Factors' dialog, the
other values compose the Use Case
Points Method formula.

Modify these fields with caution.

The final project estimate 1s directly
proportional to the TCF.

Environment = Review the parameters that calculate the

Complexity degree of environmental complexity of

Factor the project, from factors such as
programmer motivation or experience.
The listed parameters compose the
formula calculating the ECF, defined by
the Use Case Points Method; the only
parameter affected by the project is the
Unadjusted ECF Value, derived from the
'Environment Complexity Factors' tab of
the 'Estimation Factors' dialog.
The final project estimate is directly
proportional to the ECF.

Unadjusted Check the sum of the Use Case
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Ave Hours
per Use Case

Total
Estimate

Default Rate

Re-Calculate

Report

View Report
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complexity numbers.

Check the average number of hours
assigned to easy, medium and difficult
Use Cases.

You cannot change these figures.

Review the detailed breakdown of the
final figure.

You must tailor the hours per Use Case
Point figure to the level that matches your

type of project and capability based on
known previous project outcomes.

Set the default number of hours to be fed
into the final calculation.

Re-run the estimate, usually after you
change the hours or Use Case point
number.

Produce a rich text formatted report from
the current estimate.

Display the last-generated report.
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